Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to 7.02 on Windows: Oracle
# Introduction

1.1 About this Document ......................................................... 8
1.2 Naming Conventions .......................................................... 8
1.3 Constraints ........................................................................... 9
1.4 Before You Start ................................................................. 9
1.5 SAP Notes for the Installation ............................................ 10
1.6 New Features ........................................................................ 12

# Installation Options Covered by this Guide

2.1 Central System ................................................................. 14
2.2 Distributed System ............................................................ 15
2.3 High Availability System .................................................. 16
2.4 Dialog Instance ................................................................. 16
2.5 SAP Host Agent as a Separate Installation .......................... 18

# Planning

3.1 Planning Checklist ............................................................. 20
3.2 Hardware and Software Requirements ................................. 21
   - Running the Prerequisites Check in Standalone Mode (Optional) . 22
   - Requirements for the SAP System Hosts .............................. 23
3.3 Planning User and Access Management ............................... 30
3.4 Basic Installation Parameters ............................................ 31
   - SAP System Parameters .................................................. 32
   - SAP System Database Parameters ................................... 43
3.5 Domain or Local Installation ............................................. 45
3.6 Distribution of SAP System Components to Disks ............... 46
3.7 SAP System Transport Host .............................................. 48
3.8 Multiple Oracle Homes ..................................................... 49

# Preparation

4.1 Preparation Checklist ....................................................... 50
4.2 Disabling the Windows Server Firewall on Windows Server 2008 (R2) and Higher ........................................ 51
4.3 Performing Basic Windows Preparation Steps .................... 52
4.4 Required User Authorization for Running the Installer .......... 54
4.5 Using Virtual Host Names .................................................. 55
4.6 Preparing the SAP System Transport Host ......................... 56
4.7 Preparing the Installation Media ......................................... 57
   - Downloading and Extracting the Software Provisioning Manager Archive ........................................ 58
# Installation

## 5 Installation

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Physical Media from the Installation Package.</td>
<td>59</td>
</tr>
<tr>
<td>Downloading Installation Media.</td>
<td>61</td>
</tr>
<tr>
<td>5.1 Installation Checklist.</td>
<td>63</td>
</tr>
<tr>
<td>5.2 Installing the Oracle Database Software.</td>
<td>64</td>
</tr>
<tr>
<td>5.3 Setting Up Multiple Oracle Homes.</td>
<td>81</td>
</tr>
<tr>
<td>5.4 Specifying the Initial Data Source of the User Management Engine.</td>
<td>82</td>
</tr>
<tr>
<td>5.5 Prerequisites for Running the Installer.</td>
<td>83</td>
</tr>
<tr>
<td>5.6 Running the Installer.</td>
<td>85</td>
</tr>
<tr>
<td>5.7 Additional Information About the Installer.</td>
<td>89</td>
</tr>
<tr>
<td>5.8 Useful Information About the Installer.</td>
<td>91</td>
</tr>
<tr>
<td>5.9 How to Avoid Automatic Logoff by the Installer.</td>
<td>92</td>
</tr>
<tr>
<td>5.10 Interrupted Processing of the Installer.</td>
<td>95</td>
</tr>
<tr>
<td>5.11 Performing a Remote Installation (Java SDT GUI only).</td>
<td>97</td>
</tr>
<tr>
<td>5.12 Starting the Java SDT GUI Separately.</td>
<td>99</td>
</tr>
<tr>
<td>5.13 Entries in the Services File Created by the Installer.</td>
<td>100</td>
</tr>
<tr>
<td>5.14 Troubleshooting with the Installer.</td>
<td>101</td>
</tr>
</tbody>
</table>

## 6 Post-Installation

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1 Post-Installation Checklist.</td>
<td>102</td>
</tr>
<tr>
<td>6.2 Logging On to the Application Server Java.</td>
<td>103</td>
</tr>
<tr>
<td>6.3 Logging On to SAP NetWeaver Portal.</td>
<td>105</td>
</tr>
<tr>
<td>6.4 Logging On to the SAP NetWeaver Development Infrastructure (NWDI).</td>
<td>106</td>
</tr>
<tr>
<td>6.5 Providing Access to the SAP NetWeaver Administrator.</td>
<td>107</td>
</tr>
<tr>
<td>6.6 Installing the SAP License.</td>
<td>108</td>
</tr>
<tr>
<td>6.7 Configuring Remote Connection to SAP Support.</td>
<td>109</td>
</tr>
<tr>
<td>6.8 Creating Symbolic Links on Windows Server 2008 (R2) and Higher for Application Servers.</td>
<td>109</td>
</tr>
<tr>
<td>6.9 Connecting the System to SAP Solution Manager.</td>
<td>110</td>
</tr>
<tr>
<td>6.10 Applying the Latest Kernel and Support Package Stacks.</td>
<td>112</td>
</tr>
<tr>
<td>6.11 Configuring User Management.</td>
<td>113</td>
</tr>
<tr>
<td>6.12 Ensuring User Security.</td>
<td>113</td>
</tr>
<tr>
<td>6.13 Running the Configuration Wizard.</td>
<td>119</td>
</tr>
<tr>
<td>6.14 Post-Installation Steps for the J2EE Adapter Engine (Optional Standalone Unit).</td>
<td>120</td>
</tr>
<tr>
<td>Configuring the SLD Data Supplier Service in the Visual Administrator.</td>
<td>120</td>
</tr>
<tr>
<td>Configuring the Gateway Service of the Central Integration Server.</td>
<td>121</td>
</tr>
<tr>
<td>Adding Connection Parameters to Central Exchange Profile.</td>
<td>122</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>8.3</td>
<td>Preparation</td>
</tr>
<tr>
<td>8.4</td>
<td>Installation</td>
</tr>
<tr>
<td></td>
<td>Installing the Oracle Fail Safe Software</td>
</tr>
<tr>
<td></td>
<td>Configuring the First Cluster Node</td>
</tr>
<tr>
<td></td>
<td>Creating the Oracle Fail Safe Group</td>
</tr>
<tr>
<td></td>
<td>Installing the Database Instance</td>
</tr>
<tr>
<td></td>
<td>Setting Up a Shared Database Directory in Oracle Home</td>
</tr>
<tr>
<td></td>
<td>Adding the Oracle Database Resource to the Fail Safe Group</td>
</tr>
<tr>
<td></td>
<td>Configuring the Additional Cluster Node</td>
</tr>
<tr>
<td></td>
<td>Additional Steps for the Oracle Fail Safe Configuration</td>
</tr>
<tr>
<td></td>
<td>Installing the Central Instance</td>
</tr>
<tr>
<td></td>
<td>Installing the Dialog Instance</td>
</tr>
<tr>
<td>8.5</td>
<td>Post-Installation</td>
</tr>
<tr>
<td>8.6</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Moving Cluster Groups, or Services and Applications, or Roles</td>
</tr>
<tr>
<td></td>
<td>Starting and Stopping the SAP System in a Microsoft Failover Cluster Configuration</td>
</tr>
</tbody>
</table>
**Document History**

**Note**

Before you start the implementation, make sure you have the latest version of this document, which is available at https://support.sap.com/sltoolset

The following table provides an overview on the most important document changes:

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5</td>
<td>2017-09-11</td>
<td>Updated version for software provisioning manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● New Features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Media Signature Check, documented in: New Features, Running the Installer, Preparing the Installation Media.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Support of Oracle 12.2, documented in: Installing the Oracle 12c Database Software</td>
</tr>
<tr>
<td>2.4</td>
<td>2017-05-22</td>
<td>Updated version for software provisioning manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● New Features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ New SAPUI5-based user graphical interface (GUI) “SL Common GUI”, documented in: Prerequisites for Running the Installer, Running the Installer, Useful Information About the Installer</td>
</tr>
<tr>
<td>2.3</td>
<td>2017-02-07</td>
<td>Updated version for software provisioning manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● New Features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Verification of the integrity of data units in Software Provisioning Manager, documented in: Downloading the Software Provisioning Manager Archive</td>
</tr>
<tr>
<td>2.2</td>
<td>2016-10-07</td>
<td>Updated version for software provisioning manager 1.0 SP18 (SL Toolset 1.0 SP18)</td>
</tr>
<tr>
<td>Version</td>
<td>Date</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2.1</td>
<td>2016-06-06</td>
<td>Updated version for software provisioning manager 1.0 SP17 (SL Toolset 1.0 SP17)</td>
</tr>
<tr>
<td>2.01</td>
<td>2016-03-23</td>
<td>Correction of command in <em>Installing the Oracle Database 12c Server Software</em> [page 73].</td>
</tr>
<tr>
<td>2.0</td>
<td>2016-02-15</td>
<td>Updated version for software provisioning manager 1.0 SP10 (SL Toolset 1.0 SP16)</td>
</tr>
<tr>
<td>1.9</td>
<td>2015-10-12</td>
<td>Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP15)</td>
</tr>
<tr>
<td>1.8</td>
<td>2015-09-14</td>
<td>Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP14)</td>
</tr>
<tr>
<td>1.7</td>
<td>2015-04-27</td>
<td>Updated version for software provisioning manager 1.0 SP08 (SL Toolset 1.0 SP13)</td>
</tr>
<tr>
<td>1.6</td>
<td>2014-11-24</td>
<td>Updated version for software provisioning manager 1.0 SP07 (SL Toolset 1.0 SP12)</td>
</tr>
<tr>
<td>1.5</td>
<td>2014-07-07</td>
<td>Updated version for software provisioning manager 1.0 SP06 (SL Toolset 1.0 SP11)</td>
</tr>
<tr>
<td>1.4</td>
<td>2014-03-17</td>
<td>Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP12)</td>
</tr>
<tr>
<td>1.3</td>
<td>2013-10-28</td>
<td>Updated version</td>
</tr>
<tr>
<td>1.2</td>
<td>2013-07-15</td>
<td>Updated version</td>
</tr>
<tr>
<td>1.1</td>
<td>2013-04-02</td>
<td>Updated version</td>
</tr>
<tr>
<td>1.0</td>
<td>2012-11-26</td>
<td>Initial version</td>
</tr>
</tbody>
</table>
1 Introduction

1.1 About this Document

This installation guide describes how to install an SAP system based on the application server Java of SAP NetWeaver 7.0 to 7.0 EHP2 using the installation tool Software Provisioning Manager 1.0 SP21 (“installer” for short), which is part of SL Toolset 1.0 SP21.

For information about supported operating system and database platforms for the SAP product you want to install, see the Product Availability Matrix at https://support.sap.com/pam.

Note

Note that for some products - such as SAP NetWeaver 7.0 - a complete system installation is only available for the highest support release. As for the lower support releases, only options for system copy and additional application server instances are provided.

Caution

Make sure you have read the Before You Start [page 9] section before you continue with this installation guide.

1.2 Naming Conventions

- Software Provisioning Manager is the successor of the product- and release-specific delivery of provisioning tools, such as SAPinst.
  - Before you perform an installation from scratch or a target system installation in the context of a system copy, we recommend that you always download the latest version of the Software Provisioning Manager which is part of the Software Logistics Toolset 1.0 (SL Toolset for short). For more information, see Preparing the Installation Media [page 57].
  - This way, you automatically get the latest SAPinst version including latest fixes in the tool and supported processes. For more information about Software Provisioning Manager as well as products and releases supported by it, see SAP Note 1680045 and http://scn.sap.com/docs/DOC-30236.
  - As a result, “SAPinst” has been renamed to “Software Provisioning Manager 1.0” (“installer” for short) in this documentation.
  - However, the term “SAPinst” is still used in:
    ○ Texts and screen elements in the Software Provisioning Manager GUI
    ○ Naming of executables, for example sapinst.exe
  - “installer” refers to Software Provisioning Manager 1.0.
  - “SAP system” refers to SAP system based on the application server of SAP NetWeaver 7.0 / 7.0 including Enhancement Package 1 / 7.0 including Enhancement Package 2 / 7.0 including Enhancement Package 3.
“Java system” refers to SAP system based on the application server Java of SAP NetWeaver 7.0 / 7.0 including Enhancement Package 1 / 7.0 including Enhancement Package 2.

“Diagnostics” refers to diagnostics in SAP Solution Manager.

“Diagnostics Agent” refers to the agent of diagnostics in SAP Solution Manager.

Windows Operating System


Profiling for High Availability

Only valid for ‘High Availability’: HA (Windows)

The profile bars with the wording Only valid for: HA (MSCS) – for example, as in this section – refer to content that is only valid if you are installing a high-availability (HA) system with Windows Server Failover Clustering. The Windows cluster feature was previously called Microsoft Cluster Service (MSCS). You might still find the abbreviation MSCS in some sections of this guide.

End of ‘High Availability’: HA (Windows)

1.3 Constraints

You need to consider the following constraints before you start your installation:

- Your operating system platform must be 64-bit.

1.4 Before You Start

Make sure that you have read the Master Guide for your SAP Business Suite application or SAP NetWeaver application and release before you continue with this installation guide.

The Master Guide is the central document leading you through the overall implementation process for your SAP system installation. It contains crucial information about the overall implementation sequence, that is activities you have to perform before and after the installation process described in this installation guide.

You can find a printed version of the Master Guide in your installation package or you can download the latest version from http://help.sap.com.
The following table lists the Master Guides of the SAP system applications for which you can use this installation guide, along with the available quick link or path to the appropriate download location:

Table 2:

<table>
<thead>
<tr>
<th>Title</th>
<th>Internet Address</th>
</tr>
</thead>
</table>

1.5 SAP Notes for the Installation

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation. Make sure that you have the up-to-date version of each SAP Note, which you can find at https://support.sap.com/notes.

Table 3: SAP Notes for the Installation

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1680045</td>
<td>Release Note for Software Provisioning Manager 1.0</td>
<td>Software provisioning manager 1.0 with installation and system copy for SAP NetWeaver-based systems</td>
</tr>
<tr>
<td>1718413</td>
<td>Inst. SAP Systems Based on SAP NetWeaver 7.0 incl. EHPs: Windows</td>
<td>Windows-specific information about the SAP system installation and corrections to this documentation.</td>
</tr>
<tr>
<td>SAP Note Number</td>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>2172935️⃣️</td>
<td>Installation - SAP Systems Based on SAP NetWeaver on Oracle</td>
<td>Oracle-specific information about the SAP system installation and corrections to this documentation.</td>
</tr>
<tr>
<td>2470660️⃣️</td>
<td>Central Technical Note for Oracle Database 12c Release 2 (12.2)</td>
<td>Information about Oracle 12c Release 2 (12.2) with multiple links to notes on Oracle 12c Release 2 (12.2)</td>
</tr>
<tr>
<td>1914631️⃣️</td>
<td>Central Technical Note for Oracle Database 12c Release 1 (12.1)</td>
<td>Information about Oracle 12c Release 1 (12.1) with multiple links to notes on Oracle 12c Release 1 (12.1)</td>
</tr>
<tr>
<td>1431800️⃣️</td>
<td>Oracle 11.2.0: Central Technical Note</td>
<td>Information about Oracle 11g with multiple links to notes on Oracle 11g</td>
</tr>
<tr>
<td>828268️⃣️</td>
<td>Oracle Database 10g: New functions</td>
<td>Information about Oracle 10g features released for the SAP system</td>
</tr>
<tr>
<td>1732161️⃣️</td>
<td>SAP Systems on Windows Server 2012 (R2)</td>
<td>Windows Server 2012 (R2)-specific information for the SAP system installation</td>
</tr>
<tr>
<td>73606️⃣️</td>
<td>Supported Languages and Code Pages</td>
<td>Information on possible languages and language combinations in SAP systems</td>
</tr>
<tr>
<td>737368️⃣️</td>
<td>Hardware requirements of Java Development Infrastructure</td>
<td>Information on the hardware requirements for usage type Development Infrastructure (DI), which depends on the size of your development team.</td>
</tr>
<tr>
<td>1067221️⃣️</td>
<td>Composite SAP Note for heterogeneous installation</td>
<td>This SAP Note and its related SAP Notes describe the released operating system and database combinations for heterogeneous SAP systems landscapes.</td>
</tr>
<tr>
<td>1258912️⃣️ (SAP ERP)</td>
<td>PLM Core 7.00 Release Notes and Information</td>
<td>Information and references to other notes about installing PLM Core 7.00 and importing PLM Core 7.00 Support Packages.</td>
</tr>
<tr>
<td>915367️⃣️ (SAP SCM)</td>
<td>TDL: Automatic activation of the transaction data areas</td>
<td>Information about a TDL function and the settings you have to make during a system setup.</td>
</tr>
<tr>
<td>1178483️⃣️ (SAP SCM)</td>
<td>SNC 7.0 Order Documents: Required Customizing</td>
<td>Information about Supply Network Collaboration order documents.</td>
</tr>
<tr>
<td>2384179️⃣️</td>
<td>Planned support of Windows Server 2016 for SAP products</td>
<td>Support of Windows Server 2016 specific for SAP Products information for the SAP system information.</td>
</tr>
</tbody>
</table>
### 1.6 New Features

The table below provides an overview of the new features in Software Provisioning Manager.


Table 4:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Signature Check</td>
<td>The signature of media is checked automatically by the installer during the Define Parameters phase while processing the Media Browser screens. As of now the installer only accepts media whose signature has been checked. See also the description of this new security feature in SAP Note 2393060. For more information, see Preparing the Installation Media [page 57] and Running the Installer [page 85].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>Support of Oracle Database Vault</td>
<td><strong>Caution</strong> Although Oracle Database Vault is already available in the installer and documented in this guide, it is not yet released to customers until further notice. For more information, see the Current Restrictions section in SAP Note 1680045. Oracle Database Vault 12c has been certified for SAP products that are based on SAP NetWeaver technology. You can now install a new SAP system with Oracle Database 12c and configure Oracle Database Vault in its database. For more information, see Implementing Oracle Database Vault with the Installer [page 148].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>Support of Oracle 12.2</td>
<td>Software Provisioning Manager (the “installer”) now supports SAP system installations with Oracle 12.2. For more information, see Installing the Oracle 12c Database Software [page 72].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>SL Common GUI with SAPINST 7.49</td>
<td>With the new installer framework version SAPINST 7.49, you can now use the new SAPUI5-based graphical user interface (GUI) “SL Common GUI”. For more information, see Useful Information About the Installer [page 89], Running the Installer [page 85], and SAP Note 2336746.</td>
<td>Software Provisioning Manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td>Verification of Integrity of Data Units in Software Provisioning Manager</td>
<td>The integrity of data units extracted from the Software Provisioning Manager archive is verified. For more information, see Downloading and Extracting the Software Provisioning Manager Archive [page 58]. In addition, check SAP Note 1680045 whether additional information is available.</td>
<td>Software Provisioning Manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Diagnostics Agent</td>
<td>The Diagnostics Agent is no longer installed automatically with the SAP system. The Install Diagnostics Agent check box on the Install Diagnostics Agent screen is no longer available. You now have to install the Diagnostics Agent always separately. We recommend that you install it prior to the installation of your SAP system(s). For more information, see the Diagnostics Agent Installation Strategy attached to SAP Note 1365123, to SAP Note 1833501, and to SAP Note 1858920 and the attached Diagnostics Agent Setup Guide.</td>
<td>Software Provisioning Manager 1.0 SP10 (SL Toolset 1.0 SP16)</td>
</tr>
<tr>
<td>Windows Domain Organizational Units</td>
<td>You can now specify an optional organizational unit (OU) within the Windows domain where you want the installer to create the SAP system accounts. For more information, see SAP System Parameters [page 32]</td>
<td>Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP14)</td>
</tr>
<tr>
<td>Support of Oracle 12 database</td>
<td>You can now perform all Software Provisioning Manager 1.0 tasks (installation, system copy, system rename, dual-stack split) for SAP systems with the Oracle 12 database. For more information, see <a href="http://support.sap.com/pam">http://support.sap.com/pam</a>.</td>
<td>Software Provisioning Manager 1.0 SP08 (SL Toolset 1.0 SP13)</td>
</tr>
<tr>
<td>Feedback Evaluation Form available in the Software Provisioning Manager:</td>
<td>SAP SE’s aim is to provide fast and efficient procedures. To evaluate the procedure you just carried out, we need information generated by the tool during process execution and your experience with the tool itself. A new evaluation form contains a simple questionnaire and XML data generated during the procedure. Port 4239 is used for displaying the feedback evaluation form. For more information, see the Prerequisites section in Running the Installer [page 85].</td>
<td>Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12)</td>
</tr>
</tbody>
</table>
2 Installation Options Covered by this Guide

This section shows the installation options covered by this guide. You have to decide what exactly you want to install because the steps you have to perform vary according to the installation option you choose.

Related Information

Central System [page 14]
Distributed System [page 15]
Dialog Instance [page 16]
SAP Host Agent as a Separate Installation [page 18]

2.1 Central System

You can install a central system on a single host.

Note

You can install the following optional standalone units only as a central system, but not as a distributed or high-availability system:

- Application Sharing Server
- J2EE Adapter Engine
- Partner Connectivity Kit

These are the following instances:

- Central services instance (SCS instance)
- Database instance (DB instance)
- Central instance

Additionally, you can install one or more dialog instances. For more information, see Dialog Instance [page 16].

The following figure shows an example of SAP instances in a central system.
2.2 Distributed System

In a distributed system, every instance can run on a separate host.

These are the following instances:

- Central services instance (SCS instance)
- Database instance (DB instance)
- Central instance

Optionally, you can install one or more dialog instances. For more information, see Installation of a Dialog Instance [page 16].

**Note**

You can install the following optional standalone units only as a central system [page 14], but not as a distributed or high-availability system:

- Application Sharing Server
- J2EE Adapter Engine
- Partner Connectivity Kit

The following figure assumes the following:

- The central instance runs on a separate host.

**Note**

You can also install the central instance on the SAP global host.

- The SCS instance runs on the SAP global host.
- The transport directory resides on a separate SAP transport host.
2.3 High Availability System

This topic is only valid for ‘High Availability’: HA (Windows)

For more information about the system components you have to install and how to distribute them on the specific hosts, see System Configuration in Microsoft Failover Clustering [page 182].

Note

You can install the following optional standalone units only as a central system [page 14], but not as a distributed or high-availability system:

- Application Sharing Server
- J2EE Adapter Engine
- Partner Connectivity Kit

End of ‘High Availability’: HA (Windows)

2.4 Dialog Instance

You can install one or more dialog instances for an existing SAP system. Dialog instances are optional and can be installed on separate hosts.
A dialog instance can run on:

- The host of any instance of the existing SAP system
- On a dedicated host

**Note**

We do not recommend installing dialog instances on the SAP global host.

If you want to install a dialog instance on an existing SAP system, you must perform a domain installation. You must also make sure that your existing SAP system was installed as a domain installation. For more information, see Domain or Local Installation [page 45].

**Note**

If you install a dialog instance in an existing non-Unicode system (that has been upgraded to the current release), the dialog instance is automatically installed as a non-Unicode instance. The installer determines if a non-Unicode system exists and chooses the correct executables for the system type.

**Dialog Instance for a Central System**

The following figure shows dialog instances that are running on dedicated hosts.

![Figure 3: Dialog Instance for a Central Java System](image)

For more information, see Central System [page 14].

**Dialog Instance for a Distributed System**

The following figure shows dialog instances that are running on dedicated hosts.
Dialog Instance for a High-Availability System

In a high-availability system, you require at least one dialog instance apart from the central instance. For more information about how to install and distribute the application servers in an HA configuration, see System Configuration in Microsoft Failover Clustering [page 182].

End of ‘High Availability’: HA (Windows)

2.5 SAP Host Agent as a Separate Installation

Under certain circumstances you need to install SAP Host Agent separately.

SAP Host Agent is an agent that can accomplish several life-cycle management tasks, such as operating system monitoring, database monitoring, system instance control and provisioning. When you install a new SAP system or instance, the SAP Host Agent is in most cases installed automatically on the SAP system or instance host.

It is only required to install the SAP Host Agent separately if one of the following is true:

- There is no SAP system or instance on the host.
• The SAP system or instance running on the host has a kernel release lower than SAP kernel 7.20 and the host does not yet have an SAP Host Agent. During the installation of new SAP instances with SAP kernel 7.20 or higher, the SAP Host Agent is installed automatically (integrated installation).

• You have upgraded your SAP system to a release with a kernel release lower than SAP kernel 7.20 and the host of the upgraded system or instance does not yet have an SAP Host Agent.

The section Installing the SAP Host Agent Separately [page 150] describes how to perform the installation.
3 Planning

3.1 Planning Checklist

This section includes the planning steps that you have to complete for the following installation options.

- Central, distributed, or high-availability system
- Dialog instance

Detailed information about the steps is available in the relevant chapter.

Prerequisites

1. You have planned your SAP system landscape according to the Master Guide available at the appropriate download location as described in Before You Start [page 9].
2. You have decided on your installation option (see Installation Options Covered by this Guide [page 14]).

Central, Distributed, or High-Availability System

Note

In a central system, all mandatory instances are installed on one host. Therefore, if you are installing a central system, you can ignore references to other hosts.

You can install the optional standalone units J2EE Adapter Engine, Partner Connectivity Kit, Application Sharing Server only as a central system.

1. You check the hardware and software requirements [page 21] for each installation host.
2. You plan how to set up user and access management [page 30].
3. You identify Basic SAP System Installation Parameters [page 31].
4. You decide whether you want to perform a domain or local installation [page 45].
5. For the database installation, you decide how to distribute your database components to disk [page 46].
6. You decide on the transport host to use [page 48].
7. You decide if you want to use Multiple Oracle Homes [page 49].
8. Only valid for ‘High Availability’: HA (Windows)
   To install a high-availability system with Microsoft Failover Clustering, you perform the HA-specific planning steps [page 180].
9. If you want to implement Oracle Database Vault, make sure that you have read section Implementing Oracle Database Vault with the Installer [page 148].
10. Continue with Preparation [page 50].

**Dialog Instance**

1. You check the hardware and software requirements [page 21] for the installation host on which you want to install one or more dialog instances.
2. You identify Basic SAP System Installation Parameters [page 31].
3. Continue with Preparation [page 50].

### 3.2 Hardware and Software Requirements

Ensure that your hosts meet the hardware and software requirements for your operating system and the SAP instances. Otherwise, you might experience problems when working with the SAP system.

**Prerequisites**

- Make sure that the host name meets the requirements listed in SAP Note 611361.
- Contact your OS vendor for the latest OS patches.

**Procedure**

1. Check the *Product Availability Matrix* at http://support.sap.com/pam for supported operating system releases.
2. Check the hardware and software requirements using:
   - The *Prerequisite Checker* in one of two modes:
     - Standalone mode (optional) before the installation process
       For more information, see Running the Prerequisite Checker Standalone [page 22].
     - Integrated in the installer (mandatory) during the installation process
       For more information, see Running the Installer [page 85].
     - The hardware and software requirements tables in Requirements for the SAP System Hosts [page 23]
3. If you want to install a production system, the values provided by the Prerequisite Checker and the hardware and software requirements checklists are not sufficient. In addition, do the following:
3.2.1 Running the Prerequisites Check in Standalone Mode (Optional)

When you install an SAP system, the installer automatically starts the prerequisites check, which checks the hardware and software requirements in the background. As an optional step during planning, you can also run the prerequisites check in standalone mode to check the hardware and software requirements for your operating system (OS) and the SAP instances before the actual installation.

Context

Recommendation

We recommend that you use both the Prerequisites Check and the requirements tables for reference.

Procedure

1. Download and unpack the Software Provisioning Manager 1.0 archive to a local directory and make the SAP kernel media available as described in Preparing the Installation Media [page 57].
2. Start the installer as described in Running the Installer [page 85].
3. On the Welcome screen, choose <Product> > Software Life-Cycle Options > Additional Preparation Options > Prerequisites Check.
4. Follow the instructions in the installer dialogs and enter the required parameters.

Note

For more information about each parameter, position the cursor on the parameter field and choose F1 in the installer.
After you have finished, the **Parameter Summary** screen appears. This screen summarizes all parameters that you have entered and that you want to have checked. If you want to make a change, select the relevant parameters and choose **Revise**.

5. To start the prerequisites check, choose **Next**.

### Results

The **Prerequisite Checker Results** screen displays the results found. If required, you can also check the results in file **prerequisite_checker_results.html**, which you can find in the installation directory.

### 3.2.2 Requirements for the SAP System Hosts

This section provides information about the hardware and software requirements for the:

- ABAP central services instance (ASCS)
- Enqueue Replication Server instance (ERS)
- Central services instance (SCS)
- Database instance
- Central instance
- Dialog instance

**Note**

The dialog instance is optional in a non-HA system, but mandatory in an HA system.

- SAP Host Agent

  Only valid for ‘High Availability’: HA (Windows)

### General Requirements for a High-Availability System

- Windows Server 2012 (R2) and higher:
  1. Check that your cluster hardware is certified for Windows Server 2012 (R2) or Windows Server 2016 and has the Windows Server 2012 (R2) or Windows Server 2016 logo.
  2. You must validate your failover cluster configuration by running the command `test-cluster` in a PowerShell.
     The **Failover Cluster Validation Report** must not show any errors.

- Windows Server 2008 (R2):
  1. Check that your cluster hardware is certified for Windows Server 2008 (R2) and has the Windows Server 2008 (R2) logo.
  2. You must validate your failover cluster configuration by running the **Validate a Configuration Wizard**, which is included in the **Failover Cluster Management** snap-in. This must not show any errors.
• The cluster nodes of the cluster must be connected by a private and public network:
  ○ The public network enables communication from the cluster nodes of the cluster to other resources in the local area network (LAN).
  ○ The private network enables internal communication between the cluster nodes. In particular, it enables the Cluster Service running on all cluster nodes to regularly exchange messages on the state of the cluster nodes so that the failure of resources is quickly detected.

• Each of the cluster nodes in the cluster must have its own local disks and have access to shared disks that can be reached by the cluster nodes via a shared bus.
  All software – except the Windows operating system, the Oracle home directory, and the failover cluster software – is stored on the shared disks.
  One of the shared disks must be used exclusively by the quorum (if a single quorum device cluster is used) that stores the cluster registry and records information about the state of the cluster.
  You require at least four shared disks.
  For more information about the distribution of components to local and shared disk, see Distribution of SAP System Components to Disks for Failover Clustering [page 189].

• All disk controllers must be able to support hardware-based RAID.

⚠️ Caution

You cannot use a host with a domain controller as a cluster node.

End of 'High Availability': HA (Windows)

Hardware and Software Requirements

The following tables show the hardware and software requirements. Most of the requirements are valid for every installation host whereas some requirements are instance-specific and are marked accordingly.

Note

• The listed values are sufficient for development systems or quality assurance systems but not for production systems.

• If you install several SAP instances on one host, you need to add up the requirements.

• Only valid for 'High Availability': HA (Windows)

  If you install multiple SAP systems in one Microsoft failover cluster, make sure that together with your hardware partner you have set up the correct sizing for your system configuration.

End of 'High Availability': HA (Windows)

• For up-to-date information on the released and supported operating system and database versions for your SAP product, see the Product Availability Matrix (PAM) at:
Table 5: Hardware Requirements

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Minimum disk space   | ● Database software: 2 to 5 GB  
● Central services instance (SCS) (not including paging file): 5 GB (x64) 8 GB (IA64)  
● Database instance (not including paging file): 2 GB  

**Only valid for ‘High Availability’ HA (Windows)**  
**High Availability only:** Enqueue replication server instance (ERS) (not including paging file): 5 GB (x64) 8 GB (IA64)  
End of ‘High Availability’ HA (Windows)  
● Central instance (not including paging file): 5 GB (x64) 8 GB (IA64)  
  ○ In addition, you require 4 GB (x64), or 8 GB (IA64) per additional platform.  
  ○ Up to 2 GB for each usage type or software unit you want to install.  
● Dialog instance (not including paging file): 2.5 GB (x64) 5 GB (IA64)  
● SAP Host Agent: 256 MB  
● Temporary disk space for every required installation medium that you have to copy to a local hard disk: Up to 6 GB  
To check disk space:  
● Windows Server 2012 (R2) and higher:  
  1. Open PowerShell in elevated mode, and enter the following command: `get-volume`  
  2. Check the value `SizeRemaining` of the disk you want to install on.  
● Windows Server 2008 (R2):  
  1. Choose `Start > All Programs > Administrative Tools > Storage > Computer Management > Disk Management`  
  2. Right-click the drive and choose `Properties`. |  |
<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Minimum RAM           | ● All instances, except SAP Host Agent: 4 GB  
                       ● SAP Host Agent: 0.5 GB | To check RAM:  
                       ● Windows Server 2012 (R2) and higher:  
                       Open PowerShell in elevated mode, and enter the following command:  
                       ```
                       Get-WmiObject Win32_ComputerSystem
                       ```  
                       ● Windows Server 2008 (R2):  
                       Choose `Start > Control Panel > System`  
                       Note: If `System` is not visible, change `View by:` from `Category` into `Large icons`.  
                       If you want to install usage type BI Java, see SAP Note 927530 for current information on hardware sizing. |
<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paging file size</td>
<td>For more information, see SAP Note 1518419.</td>
<td>If you want to install usage type BI Java, see SAP Note 927530 for current information on hardware sizing.</td>
</tr>
</tbody>
</table>

To check paging file size:

- **Windows Server 2012 (R2) and higher:**
  - For more information, see [Checking and Changing the Paging File Settings on Windows Server 2012 (R2)](page 139)
- **Windows Server 2008 (R2):**
  2. Choose `Advanced system settings`.
  3. In section `Performance`, select `
  4. If required, in section `Virtual memory`, choose `Change`.

  **Note**
  If `System` is not visible, change `View by` from `Category` into `Large icons`.

  **Note**
  Do not select `Automatically managed paging file size for all drives`.

Only valid for ‘High Availability’: HA (Windows)

**Note**

**High Availability only:** You must adjust the size of the paging file on all cluster nodes.

End of ‘High Availability’: HA (Windows)
<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processing units</td>
<td>For application server instances and database instances:</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>The number of physical or virtual processing units usable by the operating system image must be equal to or greater than 2.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For an SCS instance running on a separate host:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>One physical or virtual processing unit usable by the operating system image might be sufficient.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Examples of processing units are processor cores or hardware threads (multithreading).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In a virtualized environment, ensure that adequate processor resources are available to support the workloads of the running SAP systems.</td>
<td></td>
</tr>
<tr>
<td>Suitable backup system</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>
Table 6: Software Requirements

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system</td>
<td><strong>64-bit version</strong> of one of the following Windows Server Editions of a supported Windows operating system:</td>
<td>To check your Windows version:</td>
</tr>
<tr>
<td></td>
<td>○ Windows Server 2012 (R2) and higher:</td>
<td>• Windows Server 2012 (R2) and higher:</td>
</tr>
<tr>
<td></td>
<td>○ Windows Server Standard Edition</td>
<td>Open PowerShell in elevated mode, and enter the following command:</td>
</tr>
<tr>
<td></td>
<td>○ Windows Server Datacenter Edition</td>
<td><strong>Get-WmiObject</strong></td>
</tr>
<tr>
<td></td>
<td>○ Windows Server 2008 (R2):</td>
<td>**Win32_OperatingSystem</td>
</tr>
<tr>
<td></td>
<td>○ Windows Server 2008 (R2) for Itanium-Based Systems Edition</td>
<td><strong>Windows Server 2008 (R2) for Itanium-Based Systems Edition</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>Make sure that you install the English language pack so that your support requests can be handled quickly.</td>
<td>High Availability only:</td>
</tr>
<tr>
<td></td>
<td>For any version of Windows Server, you need the latest supported service pack</td>
<td>Windows Server 2008 (R2) and higher: You must add the operating system feature <strong>Failover Clustering</strong> on all cluster nodes.</td>
</tr>
<tr>
<td></td>
<td><strong>Database software</strong></td>
<td><strong>End of 'High Availability': HA (Windows)</strong></td>
</tr>
<tr>
<td></td>
<td>• Database instance:</td>
<td><strong>End of 'High Availability': HA (Windows)</strong></td>
</tr>
<tr>
<td></td>
<td>○ Database server software for Oracle 10g, 11g, or 12c</td>
<td><strong>Oracle Fail Safe software</strong></td>
</tr>
<tr>
<td></td>
<td>○ Current Oracle patches, if available.</td>
<td><strong>Windows regional settings</strong></td>
</tr>
<tr>
<td></td>
<td>○ Only valid for ‘High Availability’: non-HA</td>
<td><strong>English (United States)</strong> must be set by default. For more information about localized Windows versions, see SAP Note 362379.</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008 (R2) and higher:</td>
<td>You can install additional languages but the default setting for new users must always be <strong>English (United States)</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>End of ‘High Availability’: HA (Windows)</strong></td>
<td><strong>Choose</strong></td>
</tr>
<tr>
<td></td>
<td><strong>End of ‘High Availability’: HA (Windows)</strong></td>
<td><strong>Start</strong></td>
</tr>
</tbody>
</table>

**Note**

Windows Server 2008 (R2) and higher: You must add the operating system feature **Failover Clustering** on all cluster nodes.
3.3 Planning User and Access Management

You have to plan how you want to configure user and access management for your SAP system to be installed.

Context

Before you add a newly installed SAP system to your system landscape, you must decide which kind of user management you want to use:

- The database of AS Java
- An external ABAP system as the data source for user data

**Note**

If you want to install the J2EE Adapter Engine as an optional standalone unit, you have to configure the User Management Engine (UME) for the ABAP UME of the SAP NetWeaver Process Integration (PI) system.

- Use an LDAP directory as the data source for user data.
  You cannot configure the AS Java to access an LDAP directory and an AS ABAP as the data source simultaneously. The AS Java can also use its own database as the data source.

For more information about configuring the user management of your SAP system to be installed, see the SAP Library at

Procedure

To specify the initial data source of the User Management Engine (UME), proceed as described in Specifying the Initial Data Source of the User Management Engine [page 82]

3.4 Basic Installation Parameters

The installer prompts for input parameters during the Define Parameters phase of the installation.

You can install your SAP system either in Typical or Custom mode:

- **Typical**
  - If you choose Typical, you perform the installation with default settings. This means that the installer prompts you only for a small selection of input parameters. These parameters include at least the following:
    - SAP System ID and Database Connectivity Parameters
    - SAP system profile directory – only for systems with instances on separate hosts
    - Master password
    - System Landscape Directory (SLD) destination
  - For more information about the parameters, see the corresponding tables below in this document. If you want to change any of the default settings, you can do so on the Parameter Summary screen.

- **Custom**
  - If you choose Custom, you are prompted for all parameters. At the end, you can still change any of these parameters on the Parameter Summary screen.

➤ Recommendation

If you want to configure the user management of your SAP system for an external ABAP system, as described in Preparing an External ABAP System as Source for User Data [page 143], we recommend that you select the Custom parameter mode. When you do this, you are prompted to select the appropriate option and to enter the required parameters.

If you do not choose the Custom parameter mode, you have to change the required parameters on the Parameter Summary screen.

ℹ️ Note

You cannot change from Custom to Typical mode or from Typical to Custom mode on the Parameter Summary screen.

The tables in the sections below list the basic system parameters that you need to specify before installing your SAP system. For all other installation parameters, use the tool help on the installer screens.
Related Information

SAP System Parameters [page 32]
SAP System Database Parameters [page 43]

3.4.1 SAP System Parameters

The tables in this section list the basic SAP system installation parameters that you need to specify before installing your SAP system. For all other installation parameters, use the tool help on the installer screens.

Table 7: General Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unicode System</td>
<td>A Java standalone system is always a Unicode system.</td>
</tr>
<tr>
<td>SAP System ID &lt;SAPSID&gt;</td>
<td>The SAP System ID &lt;SAPSID&gt; identifies the whole SAP system.</td>
</tr>
</tbody>
</table>

**Caution**

Choose your SAP system ID carefully since renaming requires considerable effort.

Make sure that your SAP system ID:

- Is unique throughout your organization. Do not use an existing <SAPSID> when installing a new SAP system.

**Example**

If you have already installed an ABAP system and you want to install a new Java system on the same host, make sure that you enter a <SAPSID> that is different from the <SAPSID> of the existing ABAP system. The <SAPSID> of a Java stack can only be equal to the <SAPSID> of an ABAP stack if they form a dual-stack system.

- Consists of exactly three alphanumeric characters
- Contains only uppercase letters
- Has a letter for the first character
- Does not include any of the reserved IDs listed in SAP Note 1979280.
- If you want to install a dialog instance, make sure that no Gateway instance with the same SAP system ID (SAPSID) exists in your SAP system landscape.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System Instance Numbers</td>
<td>Technical identifier for internal processes. It consists of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers. If you do not enter a specific value, the instance number is set automatically to the next free and valid instance number that has not yet been assigned to the SAP system to be installed or to SAP systems that already exist on the installation host. Only valid for 'High Availability': HA (Windows)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>If you install the central instance and the dialog instances on the cluster nodes of a Microsoft failover cluster, SAPInst by default assigns the same instance number.</td>
</tr>
<tr>
<td></td>
<td>If you install the central instance and the dialog instances on hosts that are not part of a Microsoft failover cluster, we recommend that you use the same instance number for them. If the instance number is already used on other hosts, you have to assign a different instance number for the central instance and the dialog instances. End of 'High Availability': HA (Windows)</td>
</tr>
<tr>
<td></td>
<td>To find out the instance numbers of SAP systems that already exist on the installation host, look for subdirectories ending with <code>&lt;Instance_Number&gt;</code> of local <code>&lt;usr\sap\&lt;SAPSID&gt;</code> directories.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <a href="#">SAP Directories</a> [page 128].</td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong></td>
</tr>
<tr>
<td></td>
<td>Do not use 43, and 89 for the instance number because:</td>
</tr>
<tr>
<td></td>
<td>● 43 is part of the port number for high availability</td>
</tr>
<tr>
<td></td>
<td>● 89 is part of the port number for Windows Terminal Server</td>
</tr>
<tr>
<td>SAP System Profile Directory</td>
<td><code>\&lt;SAPGLOBALHOST&gt;\sapmnt\&lt;SAPSID&gt;\SYS\profile</code></td>
</tr>
<tr>
<td></td>
<td>The installer retrieves parameters from the SAP system profile directory of an existing SAP system.</td>
</tr>
<tr>
<td></td>
<td>SAP profiles are operating system files that contain instance configuration information.</td>
</tr>
<tr>
<td></td>
<td>The installer prompts you to enter the location of the profile directory when the installation option that you execute is not the first one belonging to your SAP system installation, for example if you are installing a distributed system or a dialog instance to an existing SAP system. See also the description of the parameters SAP System ID and Database ID.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Master Password | Common password for all users created during the installation:  
  - Operating system users (for example `<sapsid>adm.SAPService<SAPSID>`)  
  
  **Caution**  
  If you did not create the operating system users manually before the installation, the installer creates them with the common master password. In this case, make sure that the master password meets the requirements of your operating system.  
  - Java users  
    (for example Administrator)  
  - Secure Store key phrase  
    For more information, see line Key Phrase for Secure Store Settings in this table.  
  
  **Note**  
  If a user already exists, you are prompted to confirm the password for this user.  
  
  **Basic Password policy**  
  The master password must meet the following requirements:  
  - It must be 8 to 14 characters long  
  - It must contain at least one letter (a-z, A-Z)  
  - It must contain at least one digit (0-9)  
  - It must not contain \ (backslash) or " (double quote).  
  
  **Additional restrictions depending on Windows:**  
  - If a user already exists, you are prompted to confirm the password for this user.  
  - Depending on the configuration of the password policy, additional restrictions might apply.  
  
  **Additional restrictions depending on the Oracle database:**  
  - It must not begin with a digit or an underscore  
  - It can contain the following characters: _ # $. a-z A-Z 0-9  
  
  Depending on the installation option, additional restrictions may apply.  
  
  **Example**  
  The master password must not contain the name of a Java user created during the installation).
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Phrase for Secure Store Settings</td>
<td>This is a random word or phrase that is used to encrypt the secure store. The J2EE engine uses this phrase to generate the key that is used to encrypt the data. The uniqueness of the phrase you use contributes to the uniqueness of the resulting key.</td>
</tr>
<tr>
<td><strong>Recommendation</strong></td>
<td>Use a long key phrase that cannot be guessed easily. Use both uppercase and lowercase letters in the phrase and include special characters.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If you choose Typical mode, the installer sets the master password for the key phrase. In this case, make sure that you replace the master password with the required unique key phrase either on the Parameter Summary screen or after the installation has finished.</td>
</tr>
<tr>
<td>DNS Domain Name for SAP System</td>
<td>If you want to use HTTP-based URL frameworks such as Web Dynpro applications, you have to specify the DNS domain name for the SAP system. The DNS Domain Name is used to calculate the Fully Qualified Domain Name (FQDN), which is configured in profile parameter SAPLOCALHOSTFULL. FQDN is the fully qualified domain name for an IP address. It consists of the host name and the domain name: (&lt;\text{Host_Name}&gt;,\text{&lt;Domain_Name&gt;}) The DNS Domain Name is needed to define the URLs for the Java application servers. It is appended to the server name to calculate the FQDN. For more information, see SAP Note 654982.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>If your application server host is called Kirk.wdf.sap.com, the DNS Domain Name is wdf.sap.com.</td>
</tr>
</tbody>
</table>
The SAP Cryptographic Library is required to enable Secure Sockets Layer (SSL) encryption of HTTP connections. In most cases it is installed automatically from the kernel medium. In case it is not installed automatically and you are prompted for it during the installation, you can download it as described in SAP Note 455033.

This software product is subject to export control regulations in Germany as the country of origin and import regulations of your own country. SAP may not yet have a corresponding export license for your user or company. Contact the contract department in your local SAP company. To download the SAP Cryptographic Software from the SAP Service Marketplace, you need a customer user ID. Before any transfer of these software products to persons, companies or other organizations outside your company, in particular in the case of any re-export of the software products, authorization is required from the German export control authorities. This might also be required from your responsible national export control authorities. This also applies to transfers to affiliated companies. Corresponding laws and regulations in the recipient country may also exist which restrict the import or the use of these software products.

### Table 8: Ports

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path to SAPCRYPTO.SAR</td>
<td>The SAP Cryptographic Library is required to enable Secure Sockets Layer (SSL) encryption of HTTP connections. In most cases it is installed automatically from the kernel medium. In case it is not installed automatically and you are prompted for it during the installation, you can download it as described in SAP Note 455033. This software product is subject to export control regulations in Germany as the country of origin and import regulations of your own country. SAP may not yet have a corresponding export license for your user or company. Contact the contract department in your local SAP company. To download the SAP Cryptographic Software from the SAP Service Marketplace, you need a customer user ID. Before any transfer of these software products to persons, companies or other organizations outside your company, in particular in the case of any re-export of the software products, authorization is required from the German export control authorities. This might also be required from your responsible national export control authorities. This also applies to transfers to affiliated companies. Corresponding laws and regulations in the recipient country may also exist which restrict the import or the use of these software products.</td>
</tr>
<tr>
<td>Java Message Server Port</td>
<td><strong>Caution</strong>&lt;br&gt;The message server port number must be unique on the host where the message server for the SAP system is running. If there are several message servers running on one host, the message server ports must all be unique. The SCS instance profile contains the configuration for the Java message server. The Java message server port uses the parameter rdisp/maserv_internal with default value \texttt{39&lt;Instance_Number_Of_SCS_Message_Server_Instance&gt;}. For more information about the parameters used for message server ports, see SAP Note 821875.</td>
</tr>
</tbody>
</table>
Table 9: Operating System Users

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of Operating System Users</td>
<td>The passwords of the operating system users must comply with the Windows password policy. The installer processes the passwords of operating system users as follows:</td>
</tr>
<tr>
<td></td>
<td>● If the operating system users do not exist, the installer creates the following users:</td>
</tr>
<tr>
<td></td>
<td>○ &lt;sapsid&gt;adm                                                                  This user is the SAP system administrator user and is a member of the local Administrators group.</td>
</tr>
<tr>
<td></td>
<td>○ SAPService&lt;\SAPSID&gt;                                                       This user is the Windows account to run the SAP system and is not a member of the local Administrators group.</td>
</tr>
<tr>
<td></td>
<td>○ sapadm                                                                      The SAP Host Agent user sapadm is used for central monitoring services. The installer creates this user by default as a local user without being a member of the local Administrators group.</td>
</tr>
<tr>
<td></td>
<td>If required, you can change this user to become a domain user on the Parameter Summary screen. For more information, see Performing a Domain Installation Without Being a Domain Administrator [page 135]. For security reasons, however, SAP strongly recommends to create this user as a local user.</td>
</tr>
<tr>
<td></td>
<td>The installer sets the master password for these users by default. You can overwrite and change the passwords either by using the parameter mode Custom or by changing them on the Parameter Summary screen.</td>
</tr>
<tr>
<td></td>
<td>● If the operating system users already exist, the installer prompts you for the existing password, except if the password of these users is the same as the master password.</td>
</tr>
</tbody>
</table>

**Note**

This does not apply if the <dasid>adm user already exists. The installer prompts you for the password even if the password of this user is the same as the master password.

**Caution**

Make sure that you have the required user authorization [page 54] for these accounts before you start the installation with the installer.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Domain Organizational Units</td>
<td>You can choose the organizational units (OUs) within the Windows domain where you want to create the SAP system accounts. By default, the installer creates the domain users SAPService&lt;SAPSID&gt;, &lt;SAPSID&gt;adm, and the domain group SAP_&lt;SAPSID&gt;_Globaladmin in the domain Users container. Here you can specify an optional organizational unit where the installer creates these domain users and group. The user who performs the installation needs read and write permissions to this organizational unit. The OU feature is only available when you select Custom mode in SWPM and choose Use Domain of current user. For more information, see SAP Note 2247673.</td>
</tr>
</tbody>
</table>
Table 10: User Management Engine Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>UME Configuration</td>
<td>You are prompted for how to configure the UME during the input phase of the installation. You can choose between the following options:</td>
</tr>
<tr>
<td></td>
<td>• Use Java database (default)</td>
</tr>
<tr>
<td></td>
<td>○ If you choose this option, administrators can manage users and groups with the UME Web admin tool and SAP NetWeaver Administrator only.</td>
</tr>
<tr>
<td></td>
<td>○ For LDAP, use this configuration for the installation and change the configuration to LDAP after the installation (see Configuring User Management to Use an LDAP Directory [page 113]).</td>
</tr>
<tr>
<td></td>
<td>• Use ABAP</td>
</tr>
<tr>
<td></td>
<td>○ If you choose this option, administrators can manage users with the transaction SU01 on the external ABAP system, and, depending on the permissions of the communication user, also with the UME Web admin tool and SAP NetWeaver Administrator.</td>
</tr>
<tr>
<td></td>
<td>○ Make sure that you have created the required users manually on the external ABAP system before you choose this option (see Preparing an External ABAP System as Source for User Data [page 143]).</td>
</tr>
</tbody>
</table>

**Recommendation**

Select the Custom parameter mode. When you do this, you are prompted to select the appropriate option and to enter the required parameters.

If you do not choose the Custom parameter mode, you have to change the required parameters on the Parameter Summary screen.

**Note**

If you want to install the J2EE Adapter Engine as an optional standalone unit, we recommend that you configure the User Management Engine (UME) for the ABAP UME of the SAP NetWeaver Process Integration (PI) system.

For more information about supported UME data sources and change options, see SAP Note 718383.  

Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to 7.02 on Windows: Oracle

Planning

CUSTOMER 39
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Using the Java Database:</strong></td>
<td></td>
</tr>
<tr>
<td>Java Administrator User and Password</td>
<td>The installer sets the user name <code>Administrator</code> and the master password by default. This user has administrative permissions for user management.</td>
</tr>
<tr>
<td>Java Guest User and Password</td>
<td>The installer sets the user name <code>Guest</code> and the master password by default. This user is used for anonymous access.</td>
</tr>
<tr>
<td><strong>Using an External ABAP System – Parameters for the ABAP Connection:</strong></td>
<td></td>
</tr>
<tr>
<td>Application Server Number</td>
<td>This is the instance number on the application server of the central ABAP system to which you want to connect the Application Server Java. To find out the number on the host of the central instance, look under the SAP directory <code>usr/sap/&lt;SAPSID&gt;/DVERMGS&lt;Instance_Number&gt;</code>. The value <code>&lt;Instance_Number&gt;</code> is the number assigned to the SAP system.</td>
</tr>
<tr>
<td>Application Server Host</td>
<td>This is the host name of the relevant application server instance. To find out the host name, enter <code>hostname</code> at the command prompt of the host running the central instance.</td>
</tr>
<tr>
<td>Communication User and Password</td>
<td>This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system.</td>
</tr>
<tr>
<td>SDM Password</td>
<td>This user is used for the Software Deployment Manager (SDM). The installer sets the master password by default.</td>
</tr>
<tr>
<td><strong>Using an External ABAP System – Parameters for the Application Server Java Connection:</strong></td>
<td></td>
</tr>
<tr>
<td>Administrator User and Password</td>
<td>This is the name and password of the administrator user that you must have created on the external ABAP system. This user has administrative permissions for user management.</td>
</tr>
<tr>
<td>Administrator Role</td>
<td>The role <code>SAP_J2EE_ADMIN</code> must exist on the external ABAP system.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Guest User and Password</td>
<td>This is the name and password of the guest user that you must have created on the external ABAP system. This user is used for anonymous access.</td>
</tr>
<tr>
<td>Guest Role</td>
<td>The role SAP_J2EE_GUEST must exist on the external ABAP system.</td>
</tr>
<tr>
<td>Communication User and Password</td>
<td>This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system.</td>
</tr>
<tr>
<td>SDM Password</td>
<td>This user is used for the Software Deployment Manager (SDM). The installer sets the master password by default.</td>
</tr>
</tbody>
</table>

Table 11: System Landscape Directory

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLD Destination</td>
<td>The System Landscape Directory (SLD) is designed for registering the systems (along with the installed software) of your whole system landscape. The usual case is to configure one SLD for your complete system landscape. You can choose between the following options:</td>
</tr>
<tr>
<td></td>
<td>• Register in existing central SLD Choose this option to register the SAP system you are installing in an existing SAP System Landscape Directory (SLD) by specifying the SLD connection parameters listed below in this table.</td>
</tr>
<tr>
<td></td>
<td>• No SLD destination Choose this option if you do not want to register the SAP system you are installing in an existing SAP System Landscape Directory (SLD). You then have to configure the SLD destination manually after the installation has finished.</td>
</tr>
<tr>
<td></td>
<td>• Configure a local SLD Choose this option if you want to have a local SLD on the SAP Java system that you are installing. Then the SAP system you are installing is the SLD server.</td>
</tr>
</tbody>
</table>

**Note**

The usual case is to configure one central SLD for your whole system landscape outside the SAP Solution Manager. However, we strongly recommend that you check the Master Guide for recommendations about which option to choose.

Register in existing central SLD

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLD HTTP Host</td>
<td>The host name of the existing central SLD.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SLD HTTP Port</td>
<td>HTTP port of the SAP system based on AS Java on which the System Landscape Directory (SLD) resides. The following naming convention applies: 5&lt;Central_Instance_Number&gt;00.</td>
</tr>
<tr>
<td></td>
<td><strong>Example</strong></td>
</tr>
<tr>
<td></td>
<td>If the central instance number of the AS Java on which the System Landscape Directory (SLD) resides is 01, the SLD HTTP Port is 50100.</td>
</tr>
<tr>
<td>SLD Data Supplier User and password</td>
<td>The existing SLD Data Supplier user and password of the existing central SLD</td>
</tr>
<tr>
<td>SLD ABAP API User and password</td>
<td>The existing SLD ABAP API user and password of the existing central SLD</td>
</tr>
<tr>
<td><strong>Configure a local SLD</strong></td>
<td></td>
</tr>
<tr>
<td>SLD Data Supplier User and password</td>
<td>Specify the name of the SLD Data Supplier user to be created. This user is used to send the self-registration data of your system to the SLD.</td>
</tr>
<tr>
<td></td>
<td><strong>Recommendation</strong></td>
</tr>
<tr>
<td></td>
<td>We recommend that you name this user SLDDSUSER.</td>
</tr>
<tr>
<td>Object Server Name</td>
<td>The Object Server Name together with the CIM namespace identifies the absolute location of your System Landscape Directory. If you do not have a prefix reserved on SAP Market Place for Object Server Name, or if you just want to install a test or development system, enter the central instance host of your system. For more information about the Object Server Name parameter, see SAP Note 935245.</td>
</tr>
</tbody>
</table>
### 3.4.2 SAP System Database Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database ID &lt;DBSID&gt;</td>
<td>The <code>&lt;DBSID&gt;</code> identifies the database instance. The installer prompts you for the <code>&lt;DBSID&gt;</code> when you are installing the database instance. The <code>&lt;DBSID&gt;</code> can be the same as the <code>&lt;SAPSID&gt;</code></td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong></td>
</tr>
<tr>
<td></td>
<td>Choose your database ID carefully. Renaming is difficult and requires that you reinstall the SAP system.</td>
</tr>
<tr>
<td></td>
<td>• If you want to install a new database, make sure that your database ID:</td>
</tr>
<tr>
<td></td>
<td>○ Is unique throughout your organization</td>
</tr>
<tr>
<td></td>
<td>○ Consists of exactly three alphanumeric characters</td>
</tr>
<tr>
<td></td>
<td>○ Contains only uppercase letters</td>
</tr>
<tr>
<td></td>
<td>○ Has a letter for the first character</td>
</tr>
<tr>
<td></td>
<td>○ Does not include any of the reserved IDs listed in SAP Note 1979280.</td>
</tr>
<tr>
<td>Database schema, Passwords</td>
<td>The Java database schema is named <code>SAP&lt;SCHEMA_ID&gt;DB</code>. Default name is <code>SAPSR3DB</code>.</td>
</tr>
<tr>
<td></td>
<td><strong>Recommendation</strong></td>
</tr>
<tr>
<td></td>
<td>Choose a <code>&lt;SCHEMA_ID&gt;</code> that is different from your <code>&lt;SAPSID&gt;</code>.</td>
</tr>
<tr>
<td></td>
<td>It might cause problems when you copy a system where <code>&lt;SCHEMA_ID&gt;</code> is the same as <code>&lt;SAPSID&gt;</code>, and the database-specific method used for the copy does not allow you to rename the database schemas. In certain situations, you might create a system copy with a new <code>&lt;SAPSID&gt;</code>, but where the database schema has the old <code>&lt;SAPSID&gt;</code>. This is not a technical problem, but might confuse the system administrator.</td>
</tr>
<tr>
<td>Oracle parameters</td>
<td>• ORACLE_HOME</td>
</tr>
<tr>
<td></td>
<td>• SAPDATA drives</td>
</tr>
<tr>
<td></td>
<td>• Drives for redolog, archives (oraarch), and saptraces</td>
</tr>
<tr>
<td>Database Instance RAM</td>
<td>The RAM that is required for the database instance installation. The default value used by the installer is 50 percent of the entire RAM.</td>
</tr>
</tbody>
</table>
### Parameters

<table>
<thead>
<tr>
<th>Oracle Listener Name, Oracle Listener Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you install the database instance on a host where no other Oracle database is installed, you normally do not have to change the default values for Listener Name and Listener Port.</td>
</tr>
<tr>
<td>If you install the database instance on a host where already another Oracle database is installed you have the following options:</td>
</tr>
<tr>
<td>○ If you install it in the same Oracle home, you use the default values for Listener Name and Listener Port.</td>
</tr>
<tr>
<td>○ If you install it in a different Oracle home, you specify an unused Listener Name and Listener Port for the new Oracle Listener.</td>
</tr>
<tr>
<td>● All dialog instances of an SAP system must use the same Listener Port than the database instance.</td>
</tr>
</tbody>
</table>

### Tablespaces, Datafiles

| An Oracle database consists of one or more logical storage units called tablespaces, which collectively store all of the database’s data. |
| Each tablespace in an Oracle database consists of one or more files called datafiles, which are physical structures that conform to the operating system in which Oracle is running. |
| MaxDatafileSize is the initial size of the tablespace datafile and its mapping to the new tablespace layout while importing the external file DBSIZE.XML. |
| The installer prompts you to enter MaxDatafileSize in MB: |
| ○ 0: Datafile size defined in DBSIZE.XML is not changed. |
| ○ 2000: Default datafile size. |
| ○ 10000: Maximum datafile size. |

### Install Oracle Database Vault

| If you want to implement Oracle Database Vault, make sure that you specify this when entering the Oracle Database parameters. For more information, see Implementing Oracle Database Vault with the Installer [page 148] |

### User Accounts for Oracle Database Vault

| If you want to implement Oracle Database Vault, make sure that you specify the passwords for the Oracle Database Vault user accounts secadmin and secacctmgr to be created. For more information, see Implementing Oracle Database Vault with the Installer [page 148] |
3.5 Domain or Local Installation

Use

Before you install the SAP system, you have to decide whether you want to perform a domain or local installation, since this affects how the user account information is stored and accessed.

For more information about the differences between a local and domain installation, go to Start Help and Support and search for What is the difference between a domain and a workgroup?.

Domain Installation

In a domain installation, the user account information is stored centrally in one database on the domain controller and is accessible by all hosts in the system.

You have to perform a domain installation if one of the following applies:

- You install a system distributed over several hosts.
- You install a high-availability system with Microsoft Failover Clustering.
- You use a common transport host for several SAP systems running on different computers.

Local Installation

In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine (central system), you can perform a local installation.

Note

If your SAP system was installed as a local installation and you want to later change to a domain installation, you can use the system rename option. For more information, see the System Rename Guide for your SAP system at:

http://support.sap.com/sitoolset Software Logistics Toolset 1.0 Documentation System Provisioning

More Information

Required User Authorization for the Installation [page 54]
3.6 Distribution of SAP System Components to Disks

When you install the SAP system, the main directories required for the system are automatically created. However, during the installation procedure, the installer prompts you to enter drive letters for the main components of the system. This gives you the opportunity to distribute components to disks in the system as you wish.

How you do this significantly affects system throughput and data security, and must therefore be carefully planned. The best distribution depends on your specific environment and must take into consideration factors such as the size of the components involved, security requirements, and the expected workload.

When you work out the assignment of components to disks, you first need to obtain an overview of the main components and their corresponding directories. Then, on the basis of sample configurations and the recommendations provided in this documentation, you can decide which assignment is best for your particular system.

SAP systems are normally installed on RAID arrays that ensure data redundancy. This documentation therefore focuses on RAID subsystems and drives.

Minimal Configuration

The following figure illustrates an example for a disk configuration for a small test or demo system. Since security and performance play a less crucial role in this type of system, many different configurations are feasible.

⚠️ Caution

Use the illustrated configuration exclusively for test or demo systems. It is unsuitable for production systems because it only minimally satisfies security and performance requirements.
### Distribution of Directories to Disks

Table 13:

<table>
<thead>
<tr>
<th>Disk</th>
<th>Directories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk 1</td>
<td>\ORACLE&lt;DBSID&gt;\102 (Oracle 10g)</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\1120\x&gt; (Oracle 11g)</td>
</tr>
<tr>
<td></td>
<td>&lt;Oracle 12g path&gt; (Oracle 12g, user-defined directory)</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\origlogA</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\origlogB</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\sapdata1</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\sapdata2</td>
</tr>
</tbody>
</table>
Note

- The configuration ensures that no data can be lost, but the process for recovering a damaged database is complicated and time-consuming.
- The redo logs and database files are located on the same disks. This means that a single disk failure can result in the loss of both the redo logs and database data.
- The I/O-intensive redo logs are on the same disk volumes as the data files. This can impede performance.
- An equally good alternative would be to simply place all components on a single RAID 5 array.

### 3.7 SAP System Transport Host

The transport host contains the transport directory used by the SAP transport system to store transport data and change SAP system information, such as software programs, write dictionary data, or customizing data. If you have several SAP systems it depends on your security requirements whether you want them to share a transport directory or whether you use separate directories.

When you install an SAP system, you have to decide which transport host and directory you want to use for your SAP system:

- Use the transport directory that the installer creates during the installation of the SAP system by default on the global host in <Drive>:\usr\sap\trans.
- Use a transport directory located on a host other than the global host (default host):
  - You can use an existing transport directory and host in your SAP system landscape.
  - You can set up a new transport directory on a different host.

In either case, you must prepare this host for use by the new SAP system [page 56].
### 3.8 Multiple Oracle Homes

The Oracle database software is installed in a directory structure which is referenced as Oracle Home. Before you install your Oracle database software, you need to decide whether you want to set up a single or multiple Oracle Homes as this influences the installation procedure.

If you install more than one database instance on the same host you have the following options:

- **You use a single Oracle Home**
  - You can use a single Oracle Home, if you use the same Oracle database version on one host for different database instances.
  - With a single Oracle Home, you have to install the database software only once.
  - With a single Oracle Home, you cannot administer your databases independently.

- **You use multiple Oracle Homes**
  - If you use multiple Oracle Homes, you must set up one Oracle Listener for each Oracle Home. Each listener must have a different TCP/IP port number.
  - With multiple Oracle Homes, you can administer your databases independently.
  - Multiple Oracle Homes are necessary, if you need to install different Oracle databases versions on the same host.

<table>
<thead>
<tr>
<th>Only valid for 'High Availability': HA (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2008 (R2) and higher:</td>
</tr>
<tr>
<td>Multiple Oracle Homes are not supported in a Microsoft failover cluster.</td>
</tr>
</tbody>
</table>

---

### Related Information

- Setting Up Multiple Oracle Homes [page 81]
4  Preparation

4.1  Preparation Checklist

This section includes the preparation steps that you have to perform for the following installation options:

- Central, distributed, or high-availability system
- Dialog instance

Detailed information about the steps is available in the relevant chapter.

Central, Distributed, or High-Availability System

In a central system, all mandatory instances are installed on one host. Therefore, if you are installing a central system, you can ignore references to other hosts.

You can install optional standalone units J2EE Adapter Engine, Partner Connectivity Kit, Application Sharing Server only as a central system.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Windows Server 2008 (R2) or higher: you disable the Windows Server firewall [page 51] on each host.</td>
</tr>
<tr>
<td>2.</td>
<td>You perform basic preparations on Windows [page 52].</td>
</tr>
<tr>
<td>3.</td>
<td>You check that you have the required user authorization for running the installer [page 54].</td>
</tr>
<tr>
<td>4.</td>
<td>If required, you set up virtual host names [page 55].</td>
</tr>
<tr>
<td>5.</td>
<td>If required, you prepare the SAP system transport host [page 56] for your SAP system.</td>
</tr>
<tr>
<td>6.</td>
<td>You check that the required installation media [page 57] are available on each host.</td>
</tr>
<tr>
<td>7.</td>
<td>Only valid for 'High Availability': HA (Windows). To install a high-availability system with Microsoft Failover Clustering, you also perform the HA-specific preparation tasks [page 180].</td>
</tr>
<tr>
<td>8.</td>
<td>If you want to implement Oracle Database Vault, make sure that you have completed the required preparation steps. For more information, see Implementing Oracle Database Vault with the Installer [page 148].</td>
</tr>
<tr>
<td>9.</td>
<td>Continue with Installation [page 63].</td>
</tr>
</tbody>
</table>

The following preparation is optional:

Preparing an External ABAP System as Source for User Data [page 143]
Dialog Instance

You have to perform the following preparations on the host where you install the dialog instance:

1. Windows Server 2008 (R2) or higher: You disable the Windows Server firewall [page 51] on each host.
2. You perform basic preparations on Windows [page 52].
3. You check that you have the required user authorization for running the installer [page 54].
4. If required, you prepare the SAP system transport host [page 56] for your SAP system.
5. You check that the required installation media [page 57] are available on the dialog instance host.
6. If you upgraded the SAP system to which you want to install a new dialog instance, you might have to update instance profiles of the existing system [page 146].
7. Continue with Installation [page 63].

4.2 Disabling the Windows Server Firewall on Windows Server 2008 (R2) and Higher

Use

The Windows firewall – which is turned on by default as of Windows Server 2008 (R2) – is configured to allow only a small set of Windows-specific inbound IP connections. By default, outbound connections are not limited to rules and are therefore not restricted by the firewall.

The default firewall settings are valid for the out-of-the-box installation of Windows Server 2008 (R2) and higher. These settings apply to local policies. For domain policies that override local policies, other rules might apply.

To avoid any problems with non-configured TCP/IP ports that are used by the SAP system, you need to disable the firewall on all Windows hosts before you install the SAP system with the installer. We recommend that you secure network access to the SAP application servers with a real physical firewall or use a router Access Control List (ACL).

Procedure

Only valid for ‘High Availability’: HA (Windows)

Note

In a high-availability system, you have to disable the firewall on all failover cluster nodes.

End of ‘High Availability’: HA (Windows)

- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  ```powershell
  Set-NetFirewallProfile -enabled false
  ```
4.3 Performing Basic Windows Preparation Steps

Use

This section informs you about basic preparation steps that you have to perform before you install the SAP system, including the following:

- Checking the Windows file system
- Checking the Windows domain structure (domain installation only)
- Deciding whether you want to use organizational units (OUs) in the Windows domain (domain installation only)

Procedure

Checking the Windows File System

You need to check which Windows file system you are using on hosts where you want to install the SAP system.

As of Windows Server 2012 R2, you should use the Windows file system ReFs or NTFS. Older Windows Server versions must use NTFS.

**Note**

Do not install the SAP system on a FAT partition.

Perform the check as follows:

- Windows Server 2012 R2 and higher:
  1. Open PowerShell in elevated mode, and enter the following command: `get-volume`
  2. Check that the value `FileSystem` is ReFs or NTFS.
- Windows Server 2008 (R2) and Windows Server 2012:
  1. Open the Windows Explorer.
  2. Select the relevant disk.
  3. Choose `Properties` `General`
     - The system displays the type of file system in use.
  4. Check that the file system is NTFS.

Checking the Windows Domain Structure
For a domain installation, we recommend that you check that all SAP system hosts are members of a single Windows domain. We recommend this for all SAP system setups.

We assume that you are familiar with checking Windows domain structures. For more information, see the Windows documentation.

In Windows, you can implement either of the following domain models for the SAP system:

- **Extra domain**
  - In this model, the SAP system is embedded in its own domain, which is specially defined for SAP. A second domain exists for the user accounts.
  - In Windows, the SAP domain and user domain must be incorporated in a domain tree. In this tree, the user accounts must form the root domain and the SAP domain must be a child domain of this.

- **Single domain**
  - In this model, the SAP system, and the user accounts are included in a single domain.

**Caution**

You cannot create local users and groups on the host that is used as domain controller. Therefore, we do **not** support running an SAP instance (including the database instance) on the host where the domain controller is installed.

### Deciding Whether to Use Organizational Units (OUs) in the Windows Domain

**Note**

You do **not** need this step for a local installation.

For a domain installation, the installer needs to create certain OS users for SAP and database operations in the Windows domain, also called the “Active Directory” (AD). These users are created by default in the AD container “Users”.

Depending on a customer’s AD landscape and security policy, there are certain restrictions on where to store users and groups in AD. Contact the administrator of your AD infrastructure to understand where to store all SAP and database-related domain users and domain groups.

The SAP installer offers to define an existing OU in AD to create all needed SAP and database users in this OU.

There are many different scenarios and prerequisites concerning how to use OUs. For more information, see SAP Note [2247673](https://support.sap.com), which explains these issues in detail and shows some examples of how to use them.

**Caution**

The installer does **not** create OUs. The installer does **not** move existing domain users or groups. The installer does **not** delete existing users, groups, OUs, nor any other object in a Windows domain.

The only exception to this rule is the Uninstall option in SWPM.
4.4 Required User Authorization for Running the Installer

Use

Although the installer automatically grants the required rights to the user account used for the installation, you have to check whether this account has the required authorization to perform the installation. The authorization required depends on whether you intend to perform a domain or local installation. If necessary, you have to ask the system administrator to grant the account the necessary authorization before you start the installation. If you attempt the installation with an account that has not the required authorization, the installation aborts.

This section informs you about the authorization required for a domain and a local installation.

Procedure

⚠️ Caution

Do not use the user <sapsid>adm for the installation of the SAP system.

Domain Installation

For a domain installation the account used for the installation needs to be a member of the local Administrators and the domain Admins group of the domain involved. All machines in the system must belong to the same domain. In a domain installation, the user information is stored centrally on the domain controller and can be accessed by all hosts in the system.

If the SAP system is to be distributed across more than one machine, SAP strongly recommends you to perform a domain installation to avoid authorization problems.

⚠️ Caution

- If you install a system distributed over several hosts as a local installation, this can lead to authorization problems for the operating system users <sapsid>adm and SAPService<SPSID>. It can also lead to problems with the transport directory, which is usually shared by several SAP systems. SAP does not support distributed SAP systems running with a local user account.

- Only valid for 'High Availability': HA (Windows)
  In a Microsoft failover cluster configuration, you always have to perform a domain installation.

- For performance and security reasons, SAP does not support an SAP system installation on a domain controller.

- If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. However, the domain administrator has to prepare the system appropriately for you.
For more information, see Performing a Domain Installation without being a Domain Administrator [page 135].
For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain Admins group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the domain Admins group.

**Local Installation**

For a local installation the account used for the installation needs to be a member of the local Administrators group of the machine involved. In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine, you can perform a local installation.

**Caution**

Do not use the Windows built-in account Administrator or the renamed built-in account to install your SAP system with the installer. The built-in account only has restricted network access rights that are required by the installer. If you renamed the built-in account Administrator, do not create a new account named Administrator.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the local Administrators group.

**Related Information**

Performing a Domain Installation Without Being a Domain Administrator [page 135]

**4.5 Using Virtual Host Names**

You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to hide their physical network identities from each other. This can be useful when quickly moving SAP servers or complete server landscapes to alternative hardware without having to reinstall or reconfigure.

**Caution**

- Only use virtual host names if this is explicitly stated in the parts of this installation guide specific to high availability. Otherwise, use the physical host name.
Do not start the installer with the command line parameter SAPINST_USE_HOSTNAME=<virtual hostname> on failover cluster nodes.

Prerequisites

- Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.
- Make sure that you configured the Windows operating system properly to use virtual host names. For more information, see SAP Note 1564275.

Procedure

To install a non-high-availability system using virtual host names, proceed as described in SAP Note 1564275.

4.6 Preparing the SAP System Transport Host

Use

The transport host has a directory structure that is used by the SAP transport system to store transport data and metadata.

When you install an SAP system, the installer by default creates the transport directory on the global host in \usr\sap\trans.

If you do not intend to use the directory structure of the system you are going to install, but want to use another new transport directory on another host, or an existing transport directory in your system landscape, you need to prepare that transport host:

- If the directory structure already exists, you must set up its security to allow the new system to write to it.
- If it does not yet exist, you must create the core directory structure and a share to export it for other computers as well as set the security on it.

Procedure

1. If the transport directory does not yet exist, do the following:
   1. Create the directory \usr\sap\trans on the host to be used as the transport host.
   2. Share the usr\sap directory on the transport host as SAPMNT and set the permission for Everyone to Full Control for this share.
This enables the installer to address the transport directory in the standard way as \SAPTRANSHOT\SAPMNT\trans.

2. Grant Everyone the permission Full Control for the transport directory.

### Caution

Remove the Full Control to Everyone permission after you have finished the installation with the installer and only grant Full Control on this directory to the SAP_<SAPSID>_GlobalAdmin groups of all the systems that are part of your transport infrastructure. The installer assigns the appropriate rights with the help of an additional SAP_LocalAdmin group.

For more information, see Automatic Creation of Accounts and Groups [page 166].

## 4.7 Preparing the Installation Media

This section describes how to prepare the installation media.

Installation media are available as follows:

- The Software Provisioning Manager 1.0 archive containing the installer. You always have to download the latest version of the Software Provisioning Manager 1.0 archive.
- The media containing the software to be installed, which are available as follows:
  - You normally obtain the physical installation media as part of the installation package.
  - You can also download the installation media apart from the Software Provisioning Manager 1.0 archive from SAP Service Marketplace, as described at the end of this section.

### Note

The signature of media is checked automatically by the installer during the Define Parameters phase while processing the Media Browser screens. As of now the installer only accepts media whose signature has been checked. See also the description of this new security feature in SAP Note 2393060.

### Related Information

- Downloading and Extracting the Software Provisioning Manager Archive [page 58]
- Using the Physical Media from the Installation Package [page 59]
- Downloading Installation Media [page 61]
4.7.1 Downloading and Extracting the Software Provisioning Manager Archive

You must always download and extract the Software Provisioning Manager 1.0 archive from the SAP Software Download Center because you must use the latest version.

Context

You require the SAPCAR tool to be able to unpack and verify software component archives (*.SAR files). *.SAR is the format of software lifecycle media and tools that you can download from the SAP Software Download Center. For more information about how to get this tool, see the Procedure section below.

Procedure

1. Download the latest version of the Software Provisioning Manager 1.0 archive 70SWPM10SP<Support_Package_Number>_<Version_Number>.SAR from:
   
   https://launchpad.support.sap.com/#/softwarecenter
   SUPPORT PACKAGES & PATCHES By
   Alphabetical Index (A-Z) S SOFTWARE PROVISIONING MANAGER

2. Get the latest version of the SAPCAR tool on the host where you want to run the installer:

   a. Go to https://launchpad.support.sap.com/#/softwarecenter
   SUPPORT PACKAGES & PATCHES and search for “sapcar”.
   b. Select the archive file for your operating system and download it to an empty directory.
   c. To check the validity of the downloaded executable, right-click the executable and choose Properties. On the Digital Signatures tab you can find information about the SAP signature with which the executable was signed.
   d. Rename the executable to sapcar.exe.

   For more information about SAPCAR, see SAP Note 212876.

3. Using the latest version of SAPCAR, you can verify the signature of the downloaded SWPM10SP<Support_Package_Number>_<Version_Number>.SAR archive as follows:

   a. Get the latest version of the SAPCRYPTOLIB archive to your installation host as follows:
      
      1. Go to https://launchpad.support.sap.com/#/softwarecenter
      SUPPORT PACKAGES & PATCHES and search for “sapcryptolib”.
      2. Select the archive file for your operating system and download it to the same directory where you have put the SAPCAR executable.
      3. Use the following command to extract the SAPCRYPTOLIB archive to the same directory where you have put the SAPCAR executable:
         sapcar -xvf sapcryptolib84_sar -R <target directory>
      4. Download the Certificate Revocation List from https://tcs.mysap.com/crl/crlbag.p7s and move it into the same directory.
b. Verify the signature of the downloaded SWPM10SP_<Support_Package_Number>_ <Version_Number>.SAR archive by executing the following command:

```
<Path to SAPCAR>\sapcar.exe -tvVf<Path to Download Directory>\SWPM10SP_<Support_Package_Number>_ <Version_Number>.SAR -crl<file name of revocation list>
```

4. Unpack the Software Provisioning Manager archive to a local directory using the following command:

```
<Path to SAPCAR>\sapcar.exe -xvf <Path to Download Directory>\70SWPM10SP_<Support_Package_Number>_ <Version_Number>.SAR <Path to Unpack Directory>
```

**Note**

Make sure that all users have read permissions for the directory where you want to unpack the installer.

**Caution**

Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not unpack it to the same folder as other installation media.

---

### 4.7.2 Using the Physical Media from the Installation Package

This section describes how you use the physical installation media as part of the installation package.

**Procedure**

1. Identify the required media for your installation as listed below.

   The following table shows the required media for the installation of an SAP system based on SAP NetWeaver application server Java:

   **Note**

   For a central system, where all mandatory instances reside on one host, you need the installation media that are required for the central instance, central services instance, and database instance.
For more information about which kernel version to use, see SAP Note [1680045](http://support.sap.com/pam). In addition, check the Product Availability Matrix at [http://support.sap.com/pam](http://support.sap.com/pam).

Table 14:

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required Media</th>
</tr>
</thead>
</table>
| Central services instance (SCS instance) | ○ Software Provisioning Manager 1.0 archive  
○ UC Kernel (folder K_<Version>_U_<OS>) where U means Unicode and N means non-Unicode. |
| Central instance                   | ○ Software Provisioning Manager 1.0 archive  
○ UC Kernel (folder K_<Version>_U_<OS>) where U means Unicode.  
○ Java Components  
○ RDBMS Client |
| Database instance                  | ○ Software Provisioning Manager 1.0 archive  
○ UC or NUC Kernel (folder K_<Version>_N or U_<OS>) where U means Unicode and N means non-Unicode.  
○ Java Components  
○ RDBMS  
(Oracle database software installation only)  
○ RDBMS Patch (if available)  
(Oracle database software installation only) |
| Dialog instance                    | ○ Software Provisioning Manager 1.0 archive  
○ UC Kernel (folder K_<Version>_U_<OS>) where U means Unicode.  
○ Java Components |

**Note**

*Every new* installation of an SAP system is Unicode. You can only use the non-Unicode kernel if you perform the system copy for a non-Unicode SAP system that has been upgraded to the current release.

○ Java Components  
○ RDBMS  
(Oracle database software installation only)  
○ RDBMS Patch (if available)  
(Oracle database software installation only)

**Note**

For an MCOD system you require the RDBMS Client medium instead of the RDBMS medium and the RDBMS Patch medium (if available).

2. Make the installation media available on each installation host as follows:
   a. Download and unpack the latest version of Software Provisioning Manager as described in [Downloading and Extracting the Software Provisioning Manager Archive](#) [page 58].
   b. Make the installation media containing the software to be installed available.

You can do this in one of the following ways:

○ Copy the required media folders directly to the installation hosts.

○ Mount the media on a central media server that can be accessed from the installation hosts.
Note

Depending on your installation type, one or more instances can reside on the same host. You need to keep this in mind when you make the required installation media available on each installation host.

For a central system, you need to make all required installation media available on the single installation host.

Caution

○ If you copy the media to disk, make sure that the paths to the destination location of the copied media do not contain any blanks and commas.

○ If you perform a domain installation and do not want to copy the media but use network drives for mapping the installation media, make sure that the <sapsid>adm user has access to the UNC paths of the network drives.

Related Information

Downloading and Extracting the Software Provisioning Manager Archive [page 58]

4.7.3 Downloading Installation Media

This section describes how you download installation media from the SAP Software Download Center.

Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager Archive [page 58].
2. Create a download directory on the host on which you want to run the installer.
3. Identify all download objects that belong to one installation medium according to the following criteria:

   i Note

   Installation media might be split into several files. In this case, you have to reassemble the required files after the download.

   ○ Download path or location:
     You can download installation media from the SAP Software Download Center using one of the following paths:
     - To download the kernel media, go to https://support.sap.com/sltoolset ➔ System Provisioning ➔ Software Provisioning Manager 1.0 SP<Current Version> ➔ Download Kernel
To download all media required for your SAP product, you can use one of the following navigation paths:

- [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter) > INSTALLATIONS & UPGRADES > By Category > SAP NETWEAVER AND COMPLEMENTARY PRODUCTS > <Product> > <Product Release>


- Material number
  All download objects that are part of an installation medium have the same material number and an individual sequence number:
  `<Material_Number>_<Sequence_Number>`

  **Example**
  
  51031387_1  
  51031387_2  
  ...

- Title
  All objects that are part of a medium have the same title, such as `<Solution><Media_Name><OS>` or `<Database>RDBMS<OS>` for RDBMS media.

4. Download the objects to the download directory.

5. To correctly recombine the media that are split into small parts, unpack all parts into the same directory.

   In the unpacking directory, the system creates a subdirectory with a short text describing the medium and copies the data into it. The data is now all in the correct directory, the same as on the medium that was physically produced. For more information, see SAP Note [1258173](https://support.sap.com/).

**Caution**

Make sure that you unpack each installation media to a separate folder. Do not unpack installation media to the same folder were you unpack the Software Provisioning Manager archive.

**Related Information**

Downloading Installation Media [page 61]
5 Installation

5.1 Installation Checklist

This section includes the installation steps for the following:

- Central system
- Distributed system
- High-availability system
- Dialog instance

Detailed information about the steps is available in the relevant chapter.

Central System

1. You install the Oracle database software [page 64].
2. If required, you set up multiple Oracle Homes [page 81].
3. You check the prerequisites [page 83] and run the installer [page 85] on the central system host with option Central System to install the SAP system.
4. You continue with Post-Installation [page 102].

Distributed System

1. On the database instance host, you install the Oracle database software [page 64].
2. If required, you set up multiple Oracle Homes [page 81] on the database instance host.
3. On the SCS instance host, you check the prerequisites [page 83] and run the installer [page 85] to install the central services instance and to prepare this host as the SAP global host.
4. On the database instance host, you check the prerequisites [page 83] and run the installer [page 85] to install the database instance.
5. On the central instance host, you check the prerequisites [page 83] and run the installer [page 85] to install the central instance.
6. If required, you install one or more dialog instances on the chosen hosts as described in subsection Dialog Instance of this section.
7. You continue with Post-Installation [page 102].
High-Availability System

1. To install a high-availability system with Microsoft Failover Clustering, you perform the **HA-specific installation tasks** [page 180].
2. You continue with **Post-Installation** [page 102].

Dialog Instance

You perform the following steps on the host where you install the dialog instance.

1. You **check the prerequisites** [page 83] and **run the installer** [page 85] to install the dialog instance.
2. You continue with **Post-Installation** [page 102].

5.2 Installing the Oracle Database Software

Continue with the section relevant for the release of the Oracle database that you want to install.

- **Installing the Oracle 10g Database Software** [page 64]
  Proceed as follows to install the Oracle 10g database software.

- **Installing the Oracle 11g Database Software** [page 69]
  This section describes the installation of the Oracle 11g server software and patches.

- **Installing the Oracle 12c Database Software** [page 72]
  This section describes the installation of the Oracle 12c server software and patches.

- **Using PowerShell** [page 78]
  SAP uses Windows PowerShell to run and describe Windows commands.

5.2.1 Installing the Oracle 10g Database Software

Proceed as follows to install the Oracle 10g database software.

Procedure

1. You **install the Oracle 10g database server software** [page 65].
2. You **install the current patch set** [page 67].
3. You **install the current patch collection** [page 68].
5.2.1.1 Installing the Oracle 10g Database Software

This section describes how to install the database server software for Oracle 10g on the database host.

Context

- For more information about Oracle 10g, see the documentation provided by Oracle on the RDBMS media under <Media_DRIVE>:\NT\<platform>\database\doc\index.htm or at http://docs.oracle.com.
- If you have already installed an Oracle database instance or the Oracle software, and you want to install an additional database instance, you have to decide whether you want to use single or multiple Oracle Homes [page 49].

Caution

- You have to install the Oracle server software on all cluster nodes.
- Windows Server 2003: If you use multiple Oracle Homes, you must have one ORACLE_HOME per database instance on every cluster node on local disks.
- All ORACLE_HOMES must use the same disks and directories and ORACLE_HOME names on all database cluster nodes.

Information about the Oracle Client Software

- As of Oracle 10g, you no longer need to manually install the Oracle client software on the application server, as SAPinst asks you for the Oracle Client media and automatically installs the client software in the DIR_CT_RUN directory.
- Make sure that you use the most up-to-date version of the Oracle client media from SAP Service Marketplace.
- You require the current Oracle Instant Client version.

Procedure

1. On the database server, place the Oracle RDBMS media in the media drive and change to the platform-specific directory: <Media_DRIVE>:\NT\<platform>.
2. Start the Oracle Universal Installer by double-clicking the file sapserver.cmd.
3. In the command prompt box, specify the drive letter of the local disk where you want to install the Oracle software, and the <DBSID>.

   Note

   The command prompt box only appears, if you perform a new installation (or under a different user), or if <Oracle_Home> and <DBSID> are not set.
4. In the **Oracle Universal Installer**, enter the information as shown in the following table:

<table>
<thead>
<tr>
<th>Window</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Specify File Locations</strong></td>
<td>If this screen appears, do the following:</td>
</tr>
<tr>
<td></td>
<td>○ Under <strong>Source</strong>:</td>
</tr>
<tr>
<td></td>
<td>For <strong>Path</strong>:</td>
</tr>
<tr>
<td></td>
<td>Shows the path to the Oracle source software. Do <strong>not</strong> change the path.</td>
</tr>
<tr>
<td></td>
<td>○ Under <strong>Destination</strong>:</td>
</tr>
<tr>
<td></td>
<td>○ For <strong>Name</strong>:</td>
</tr>
<tr>
<td></td>
<td>Enter the name of the new <code>&lt;Oracle_Home&gt;</code> directory. We recommend that you use the name <code>&lt;SAPSID&gt;</code>&lt;ORACLE_VERSION&gt;; for example, C12102</td>
</tr>
<tr>
<td></td>
<td>○ For <strong>Path</strong>:</td>
</tr>
<tr>
<td></td>
<td>Enter the path of a new <code>&lt;Oracle_Home&gt;</code> directory. We recommend that you use the path:</td>
</tr>
<tr>
<td></td>
<td><code>&lt;DRIVE&gt;</code>: <code>\ORACLE</code>&lt;DBSID&gt;`&lt;ORACLE_VERSION&gt;; for example, C:\ORACLE\C12102</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Do <strong>not</strong> specify an already existing <code>&lt;Oracle_Home&gt;</code> directory. You must specify a new directory.</td>
</tr>
<tr>
<td></td>
<td>Choose <strong>Next</strong>.</td>
</tr>
<tr>
<td><strong>Summary</strong></td>
<td>Choose <strong>Install</strong>.</td>
</tr>
<tr>
<td><strong>Oracle Net Configuration Assistant: Welcome</strong></td>
<td>If this dialog appears, select <strong>Perform typical configuration</strong>.</td>
</tr>
<tr>
<td><strong>Configuration Assistants</strong></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>If you get an error message, choose <strong>OK</strong>. Ignore the following <strong>Warning</strong> screen and choose <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>Choose <strong>Next</strong>.</td>
</tr>
<tr>
<td><strong>End of Installation</strong></td>
<td>Choose <strong>Exit</strong> to close the Oracle Universal Installer.</td>
</tr>
</tbody>
</table>

5. Install the current patch set and patch collection (if available).

For more information, see SAP Note [839187](https://support.sap.com/839187).
5.2.1.2 Installing the Current Patch Set

After the Oracle database software installation, you need to install the current patch set for Oracle Database 10g Release 2 (10.2).

Prerequisites

- For more information on the latest patch set available for Oracle 10.2, see SAP Note 839187.
- For more information about how to install the patch set, see the patch set `README` file.

Caution

Do not perform any of the post-installation steps mentioned in the patch set `README` file. Only perform the post-installation steps on an existing Oracle 10.2 database.

At this stage, you have only installed the Oracle 10.2 software. The database itself is still not Oracle 10.2. Therefore, make sure that you do not perform the post-installation steps mentioned in the `README` file.

- You only have to install the latest (that is, the current) patch set.

Procedure

1. Log on as administrator.
2. Install the patch set as described in the patch set `README` file.

For more information, see SAP Note 839187.

Only valid for ‘High Availability’: HA (Windows)

Note

You have to install the current Oracle patch set on all cluster nodes.

End of ‘High Availability’: HA (Windows)
5.2.1.3 Installing the Current Patch Collection

On Windows, you can install one patch collection and additional generic patches at the same time if required.

Prerequisites

Make sure you have already installed the current patch set [page 67].

Context

Windows patch collections are cumulative and contain the most current CPU. For information about the current patch collection and the generic patches, see SAP Note 839187. You use OPatch to install the patch collection and the generic patches. For more information, see SAP Note 839182.

Procedure

1. Log on as administrator.
2. Install the patch collection, following the instructions in the README document of the patch collection. Make sure that you complete the post-installation steps described in the README document.

Note

- The README file uses the term “bundle patch” instead of “patch collection”.
- High-Availability only: You have to install the current Oracle patch collection (if available) on all cluster nodes.

End of ‘High Availability’: HA (Windows)
5.2.2 Installing the Oracle 11g Database Software

This section describes the installation of the Oracle 11g server software and patches.

Procedure

1. You install the Oracle 11g database server software [page 69].
2. You install the required patches [page 71].

5.2.2.1 Installing the Oracle 11g Server Software

Proceed as follows to install the Oracle 11g database software.

Prerequisites

⚠️ Caution

If you copy the files from the RDBMS medium to a local disk, do not use directory names containing blanks.

ℹ️ Note

Only valid for ‘High Availability’: HA (Windows)

High Availability only: You have to install the Oracle database server software on all failover cluster nodes.

End of ‘High Availability’: HA (Windows)

Context

As of Oracle 11.2.0.2, Oracle database patch sets are full installations of the Oracle database software. Patch sets now replace existing installations. For more information about identifying and installing the correct Oracle database software version, see SAP Note 1431799.

Procedure

1. On the database server, make the Oracle RDBMS medium available, and change to the directory:

   `<media_DRIVE>:\database\SAP\`
2. Start the **Oracle Universal Installer** (OUI) with the PowerShell or by double-clicking the file `sapserver.cmd`.

**Note**

- You cannot directly invoke `sapserver.cmd` if you use UNC paths (`\<Host_Name>\<Share>\sapserver.cmd`). Instead, you must map a drive letter to the shared directory and start `sapserver.cmd` via the drive letter.

- You can also use the PowerShell script `sapserver.ps1`, which you can also use with UNC paths to start the OUI. To run the script, do not double-click on it, since this by default in the Windows explorer opens the **edit mode**. Instead, open PowerShell in elevated mode and run:
  ```bash
  <Path_To_Media_DRIVE>\database\SAP\sapserver.ps1.
  ```
  For more information about PowerShell, see Using PowerShell [page 78].

- For support reasons, do **not** use the `setup.exe` file in the directory `<media_DRIVE>:\database \`. Using `sapserver.cmd` or `sapserver.ps1` guarantees a unique setup of the ORACLE_HOME that is common to SAP systems.

- Windows Server 2008 (R2) and Windows Server 2012 (R2) with activated UAC: If you have drive letters that were created in unelevated mode, you cannot access them in elevated mode. Therefore, if you want to double-click `sapserver.cmd`, you have to copy the Oracle RDBMS medium to a local disk. If you want to invoke `sapserver.cmd` from within a command prompt or PowerShell window, you have to elevate (run as administrator) the command prompt or PowerShell window before you create the network drive.
  
  Note that there is no UAC in Server Core for Windows Server 2012 (R2).

If a command prompt window appears, specify the drive letter of the local disk where you want to install the Oracle software, and the `<DBSID>`. The command prompt window only appears if you perform a new installation (under a different user), or if the ORACLE_HOME and `<DBSID>` are not set.

3. In the **Oracle Universal Installer**, enter the information as shown in the following table:

<table>
<thead>
<tr>
<th>Window</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure Security Updates</strong></td>
<td>Do not select the check box.</td>
</tr>
<tr>
<td></td>
<td>Choose <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>The installer issues a warning.</td>
</tr>
<tr>
<td></td>
<td>Choose <strong>Yes</strong> and then <strong>Next</strong>.</td>
</tr>
<tr>
<td><strong>Select Installation Option</strong></td>
<td>Confirm the default selection <strong>Install database software only</strong> and then choose <strong>Next</strong>.</td>
</tr>
<tr>
<td><strong>Grid Installation Options</strong></td>
<td>Confirm the default selection <strong>Single instance database installation</strong> and then choose <strong>Next</strong>.</td>
</tr>
<tr>
<td><strong>Select Product Languages</strong></td>
<td>Confirm the default option <strong>English</strong> and then choose <strong>Next</strong>.</td>
</tr>
<tr>
<td><strong>Select Database Edition</strong></td>
<td>Confirm the default option <strong>Enterprise Edition</strong> and then choose <strong>Next</strong>.</td>
</tr>
</tbody>
</table>
Window | Task
--- | ---
**Specify Installation Location** | This window displays the value for `ORACLE_BASE`, which must be set in the environment to `<drive_containing_oracle_home>:\oracle`.

It also displays the value for `ORACLE_HOME`, which is `\oracle\<DBSID>\1120<x>` (where `1120<x>` is the Oracle version number, for example, `11203` for Oracle 11.2.0.3, `11204` for Oracle 11.2.0.4, and so on). Select this option and then Next.

**Perform Prerequisite Checks** | This window checks if all the required system prerequisites for the installation of the database software have been met. If some of the checks are displayed as Failed, you can fix these problems and run the check again by choosing Check Again.

Recommendation

We strongly recommend you to make sure that there are no failed checks before starting the software installation.

**Summary** | Review the information displayed in this window and choose Finish.

**Install Product** | This window shows the progress of the installation.

**Finish** | After the installation has finished successfully, choose Finish and close the Oracle Universal Installer.

4. Install the required Oracle patches [page 71] (if available). For more information, refer to SAP Note 1503709.

Only valid for 'High Availability': HA (Windows)

**Note**

**High Availability only:** You have to install the Oracle patches (if available) on all failover cluster nodes.

End of 'High Availability': HA (Windows)

5.2.2.2 Installing Required Patches

After the database software installation, you need to install all required Oracle database patches, which on Windows include one patch collections and one or more additional (generic) patches.

Prerequisites

Use an up-to-date version of OPatch to install the patches. Check SAP Note 839182 for instructions on how to use OPatch.
Context

Check SAP Note [1631931](http://support.sap.com/software/databases.html) for Oracle 11.2.0.3 and SAP Note [1949250](http://support.sap.com/software/databases.html) for Oracle 11.2.0.4 for the patches to be installed.

You can download the patches from:

http://support.sap.com/software/databases.html

Procedure

1. Log on as administrator.
2. Install the patches, following the instructions in the relevant README file.

**Note**
- The patch collection README file uses the term “bundle patch” instead of “patch collection”.
- Only valid for “High Availability”: HA (Windows)

High Availability only: You have to install the patches on all cluster nodes.

End of “High Availability”: HA (Windows)

5.2.3 Installing the Oracle 12c Database Software

This section describes the installation of the Oracle 12c server software and patches.

Procedure

1. You install the Oracle 12c database server software [page 73].
2. You install required patches [page 77].
5.2.3.1 Installing the Oracle Database 12c Server Software

Proceed as follows to install the Oracle 12c database software.

Prerequisites

- **Caution**
  If you copy the files from the RDBMS medium to a local disk, do **not** use directory names containing blanks.

- You need 5-10 GB disk space for the Oracle server software.
- Make sure that you have enough space for the Oracle inventory and that you have full access to the directories (inventory, installation location, temp directory). Otherwise, the Oracle Universal Installer cannot perform installation prerequisite checks.

- Only valid for ‘High Availability’: HA (Windows)
  **High Availability only:** You have to install the Oracle database server software on **all** failover cluster nodes.

- Create an Oracle installation user using a dedicated Windows administrator account. On Windows, the user installing the Oracle software must have a Windows administrator account. This user is similar to the Oracle software owner in UNIX environments.

  **Recommendation**
  We recommend that you do **not** use the SAP administrator `<DOMAIN>\<sapsid>adm` as the Oracle installation user.

  For MSCS or domains, create this user as a domain user that is a member of the local administrator group. For more information, see SAP Note 1915302.

  **Example**
  To create a local Oracle installation user called Oracle, you enter the following commands:
  ```
  net user /add Oracle Welcome1 /fullname:"Oracle Installation User" /comment: "Administrator for Oracle Software Installation and Patching"
  net localgroup administrators Oracle /add
  ```

Context

For more information about identifying and installing the correct Oracle database software version, see SAP Note 2470660.

For information about the installation of Oracle Database 12c software on Windows, see SAP note 1915302.
Procedure

1. Log on as Administrator or Oracle installation user, such as oracle.
   For more information on the Oracle users, see SAP Note 1915302.

   Oracle Database 12c supports the use of an Oracle home user such as oraclehome01, which must be
   specified at installation time. A Windows local user as Oracle home user can be created during the Oracle
   software installation. A Windows domain user as Oracle home user must exist before starting the Oracle
   software installation.

   **MSCS or domain installation only**: The Oracle home user must be a domain user that you have to create
   before starting the software installation.

2. On the database server, make the Oracle RDBMS medium available, and change to the directory:
   `<media_DRIVE>:\database\SAP`

3. Start the Oracle Universal Installer (OUI) with the PowerShell script `sapserver.ps1`.

   **Note**
   - It is recommended to use the PowerShell script `sapserver.ps1`, which you can also use with UNC
     paths to start the OUI. To run the script, right-click and select *Run with PowerShell*. When running
     the script the first time, confirm that you want to change the execution policy.
     For more information about PowerShell, see Using PowerShell [page 78].
   - For support reasons, do **not** use the `setup.exe` file in the directory `<media_DRIVE>:\database`
     \. Using `sapserver.ps1` guarantees a unique setup of the ORACLE_HOME that is common to SAP
     systems.
   - Windows Server 2008 (R2) and Windows Server 2012 (R2) with activated UAC:
     If you have drive letters that were created in unelevated mode, you cannot access them in elevated
     mode. Therefore, if you want to double-click `sapserver.cmd`, you have to copy the Oracle RDBMS
     medium to a local disk. If you want to invoke `sapserver.cmd` from within a command prompt or
     PowerShell window, you have to elevate (run as administrator) the command prompt or PowerShell
     window before you create the network drive.
     Note that there is no UAC in Server Core for Windows Server 2012 (R2).

   When the Powershell command window appears, respond to the prompts of the script. For a Windows
   domain user, enter `<domain>\<Oracle_home_user>`. For a Windows local user, you only need to enter
   the name of the local `<Oracle_home_user>`. For more information, see SAP Note 1915302.

4. In the Oracle Universal Installer, enter the information as shown in the following table:

   Table 18: Installing the Oracle Database Software

<table>
<thead>
<tr>
<th>Window</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure Security Updates</strong></td>
<td>Do <strong>not</strong> select the check box <em>I wish to receive security updates via My Oracle Support</em>.</td>
</tr>
<tr>
<td></td>
<td>Choose Next.</td>
</tr>
<tr>
<td></td>
<td>The installer issues a warning.</td>
</tr>
<tr>
<td></td>
<td>Choose Yes.</td>
</tr>
<tr>
<td>Window</td>
<td>Task</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Installation Option</strong></td>
<td>Confirm the default selection <em>Install database software only</em> and then choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Grid Installation Options</strong></td>
<td>Confirm the default selection <em>Single instance database installation</em> and then choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Product Languages</strong></td>
<td>Confirm the default option <em>English</em> and then choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Database Edition</strong></td>
<td>Confirm the default option <em>Enterprise Edition</em> and then choose <em>Next</em>.</td>
</tr>
<tr>
<td><strong>Oracle Home User Selection</strong></td>
<td>Select <em>Create New Windows User</em> and enter the <em>User Name</em> and <em>Password</em>, or if you want to use an existing user, choose <em>Use existing Windows User</em>. Then choose <em>Next</em>.</td>
</tr>
</tbody>
</table>

**Note**

As of 12c, you can specify an Oracle home user when you install a new Oracle home. For enhanced security, Oracle recommends that you use a **standard Windows user account** (instead of a Windows built-in account) as the Oracle home user, such as oraclehome01.

**MSCS or domain installation only:** select *Use existing Windows User* and enter the Oracle home user `<domain>`\<Oracle_home_user> that you created before starting the software installation.

For more information, see SAP Note [1915302](http://support.sap.com/1915302).
### Window | Task
---|---
*Installation Location* | Set these fields as follows, depending on whether you have a standard Windows account (recommended) or a Windows built-in account, and then choose Next:
- **Standard Windows account (recommended)**
  - *Software location* (that is, Oracle home): `<drive>:\oracle\<Oracle_home_user>\<DBSID>\<Release>`
  - *Oracle base*: `<drive>:\oracle\<Oracle_home_user>`
  - **Example**
    - *Software location* (that is, Oracle home): D:\oracle\oraclehome01\OQ1\12201
    - *Oracle base*: D:\oracle\oraclehome01
    - **Windows built-in account**
      - *Oracle home*: `<drive>:\oracle\<DBSID>\<Release>`
      - *Oracle base*: `<drive>:\oracle`
      - **Example**
        - *Oracle home*: D:\oracle\OQ1\12201
        - *Oracle base*: D:\oracle

  For more information, see SAP Note [1915302](#).

### Prerequisite Checks | This window checks if all the required system prerequisites for the installation of the database software have been met. If some of the checks are displayed as *Failed*, you can fix these problems and run the check again by choosing *Check Again*.

#### Recommendation
We strongly recommend you to make sure that there are no failed checks before starting the software installation.

### Summary | Review the information displayed in this window and choose *Finish* or *Install*.

### Install Product | This window shows the progress of the installation.
You can monitor the installation progress details in an additional window.

### Close | After the installation has finished successfully, choose *Close* to close the Oracle Universal Installer.

5. Install the **required Oracle patches** [page 77](#) (if available). For more information, see SAP Note [1915316](#).
### 5.2.3.2 Installing Required Patches

After the database software installation, you need to install all required Oracle database patches, which on Windows include one patch collection and one or more additional (generic) patch.

**Prerequisites**

Use an up-to-date version of OPatch to install the patches. Check SAP Note 839182 for instructions on how to use OPatch.

**Context**

Check SAP Note 2470660 for the corresponding Oracle database patches to be installed.

You can download the patches from:

http://support.sap.com/software/databases.html

**Procedure**

1. Log on as administrator or the Oracle installation user.
2. Install the generic patch containing the upgrade scripts to the `<new_Oracle_home>` following the description in SAP Note 2477382.
3. Install the patches, following the instructions in the relevant README file.

**Note**

- The patch collection README file uses the term “bundle patch” instead of “patch collection”.
- Only valid for “High Availability”: HA (Windows)

**High Availability only:** You have to install the patches on all cluster nodes.

**End of ‘High Availability’: HA (Windows)**
5.2.4 Using PowerShell

SAP uses Windows PowerShell to run and describe Windows commands.

For Windows Server 2012 (R2) and higher, SAP only uses Windows PowerShell to run and describe Windows commands.

Windows PowerShell is a powerful tool integrated in the Windows operating system. It uses object-oriented methodology, which allows fast and stable script development.

For more information about the Windows PowerShell, see:


There you can find links to the online help, online documentation, scripting repository, downloads, and blogs.

If you want to use the PowerShell feature, note the following:

- **Windows Server 2016**
  Windows Server 2016 contains PowerShell 5.0
  You can update to PowerShell 5.0 (search the internet for Windows Management Framework 5.0).

- **Windows Server 2012 R2**
  Windows Server 2012 R2 contains PowerShell 4.0.

- **Windows Server 2012**
  You can update to PowerShell 4.0 (search the internet for Windows Management Framework 4.0).

- **Windows Server 2008 R2**
  Windows Server 2008 R2 contains PowerShell 2.0.
  For more information about PowerShell 2.0, see http://support.microsoft.com/kb/968929.
  You can update to PowerShell 3.0 or 4.0 (search the internet for Windows Management Framework 3.0 or Windows Management Framework 4.0).

- **Windows Server 2008**
  Windows Server 2008 contains PowerShell 1.0.
  You have to activate the PowerShell feature with Start ➤ Administrative Tools ➤ Server Manager ➤ Features ➤

**How to Start PowerShell**

⚠️ Caution

Make sure that you start the PowerShell in administrator mode.

- **Windows Server 2012 (R2) and higher**
  Open the command prompt and enter the command: powershell.exe
To start PowerShell on Windows Server 2008 (R2), you have the following options:

- From the command prompt, by entering the command: `powershell.exe`
- From the Start Menu:
  - PowerShell 1.0:
    - Choose `Start > All Programs > Windows PowerShell 1.0 > Windows PowerShell`
  - PowerShell 2.0:
    - Choose `Start > All Programs > Windows PowerShell > Windows PowerShell`

### How to Work with PowerShell

Most commands that are used in `cmd.exe` are also available in the PowerShell (defined as aliases).

You can use well-known commands, such as `cd`, `type`, `copy`, `move`, `mkdir`, `delete`, `rmdir`. There is also online help available, which you can access by typing the command: `help` (or `help <command>`).

This is a list of differences between PowerShell and `cmd.exe`:

- Before you can run PowerShell scripts (text files with the file extension `.ps1` that contain PowerShell statements), you might have to change the default security setting to allow the execution of non-signed scripts as follows:
  ```
  set-executionpolicy "unrestricted"
  ```
- By default, when double-clicking PowerShell scripts (.PS1 files) in the Windows explorer, this does not execute the script as is the default for `.cmd` files, but opens the script in an editor. If you want to activate automatic script execution after a double-click, you have to change the value `HKEY_CLASSES_ROOT\Microsoft.PowerShellScript.1\Shell\Open\Command` from `notepad.exe` to the full path of the PowerShell executable.
- The output of PIPE commands is not just a stream of characters (strings) but a stream of objects. You can easily access the properties and methods for these objects (see the process list DLL example below).
- The current working directory is not part of the directory search path that the PowerShell looks at for scripts and programs. The PowerShell only searches directories listed in the environment variable path. Therefore, you might have to run a local program with `./sapcontrol.exe` or specify its full path.
- You can use the UNIX-like directory delimiters, such as `cd /usr/sap/C11`.
- You can have your current working directory in a UNC path (`cd \sapglobalhost\sapmnt`).
- The shell distinguishes between environment variables and shell variables:
  - Use of shell variables:
    ```
    Definition: $x="hello"
    Reference: write-host $x
    ```
  - Use of an environment variable:
    ```
    Definition: $env:x="hello"
    Reference: write-host $env:x
    ```
- The PowerShell has an interesting container concept called `ps-drives`. Within `ps-drives` you can navigate in other objects, such as the registry or shell internal lists in the same way as you typically navigate in a file system (cd, dir, del, and so on).
  ```
  dir env: to get a list of environment variables
dir variable: to get the list of shell variables
  ```
dir HKLM to get a list of registry keys in HKEY_LOCAL_MACHINE
get-psdrive to get a list of available ps-drives

- Windows PowerShell has full access to the .NET runtime. You can directly access missing functions in the PowerShell via .NET.
- With Windows PowerShell, you can create GUI-class user interfaces using Windows forms.

PowerShell Commands

The following table lists some PowerShell commands that are available on Windows Server 2012 (R2) and higher:

Table 19:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>stop-service sap*</td>
<td>Stops all Windows services with service name starting with “SAP”</td>
</tr>
<tr>
<td>stop-service oracle*</td>
<td>Stops all Windows services with service name starting with “Oracle”</td>
</tr>
<tr>
<td>get-process</td>
<td>Lists currently started processes on your system</td>
</tr>
<tr>
<td>get-process</td>
<td>Lists the last started process on your computer</td>
</tr>
<tr>
<td>get-process</td>
<td>Lists all properties of the last started process</td>
</tr>
<tr>
<td>get-process</td>
<td>Lists all process class members (properties and methods) of the last started process</td>
</tr>
<tr>
<td>get-process</td>
<td>Lists all processes, and the executables and DLLs the processes loaded</td>
</tr>
<tr>
<td>$processes = (get-process</td>
<td>sort starttime)</td>
</tr>
<tr>
<td>$processes.length</td>
<td>The number of processes in the array (is equivalent to the number of processes on your computer)</td>
</tr>
<tr>
<td>$processes[$processes.length-1].kill()</td>
<td>Invokes the kill method (terminate process) of the last started process</td>
</tr>
<tr>
<td>(dir a.txt).set_attributes(&quot;readonly&quot;)</td>
<td>Sets the file a.txt to “read-only”</td>
</tr>
</tbody>
</table>
5.3 Setting Up Multiple Oracle Homes

This section only applies if you want to use multiple Oracle Homes. For more information, see Multiple Oracle Homes [page 49].

Note

Windows Server 2008 (R2) and higher
Multiple Oracle Homes are not supported in a Microsoft failover cluster.

End of ‘High Availability’ HA (Windows)

Procedure

1. Remove all parts referring to `<Oracle_Home>\bin` from the system environment variable PATH:
   a. Start the Oracle Universal Installer as follows:
      ○ Windows Server 2012 (R2):
         Start a PowerShell in elevated mode, and enter the following command:
         `<ORACLE_HOME>\oui\bin\setup.exe`
      ○ Windows Server 2008 (R2):
         Choose `Start All Programs Oracle - <Home_Name> Oracle Installation Products Universal Installer`.
   b. On the Welcome screen, choose Installed Products.
   c. On the Inventory screen, choose the Environment tab.
   d. Deselect all components and choose Apply.

2. Update or create, if not available, the user environment variable PATH of the user that performs the installation of the SAP system (at least the `sap<sapsid>adm` user).

   Note

   You also have to modify the user environment variable PATH for all other users using the Oracle software. You can only change the environment variable if the user already exists. Otherwise, you have to do this after you have installed at least one instance of the SAP system with the installer.

Perform the following steps:

   ○ Windows Server 2012 (R2):
     1. Retrieve the current environment variable in PowerShell with the following command:
        `[environment]::GetEnvironmentVariable("PATH","user")`

   Example

   You get, for example, the following result:
   `c:\tools`
2. Append this path to the current Oracle path in PowerShell by entering the following command in a single line:

```
[environment]::SetEnvironmentVariable("PATH","<old_environment_variable_value>;<oracle_home>\bin","user")
```

**Caution**

Make sure that there is no space before or after the `;` (semicolon).

**Example**

If the environment variable is `c:\tools` and the `<Oracle_home>` is `c:\oracle\X11\112`, you have to enter the following command in PowerShell:

```
[environment]::SetEnvironmentVariable("PATH","c:\tools;c:\oracle\X11\112\bin","user")
```

○ Windows Server 2008 (R2):
  1. Choose **Start** ➤ **Control Panel** ➤ **System** ➤ **Advanced system settings** ➤ **Environment Variables**.
  2. Under **User variable for <user>**, modify or create, if not available, the value `PATH` to include the `<Oracle_home>\bin`, which you want to use for the installation.

### 5.4 Specifying the Initial Data Source of the User Management Engine

During the installation of your SAP system, you have to specify the initial data source of the User Management Engine (UME).

**Prerequisites**

You have planned how you want to configure user and access management for your SAP system to be installed as described in *Planning User and Access Management* [page 30].

**Procedure**

**Using the Database of AS Java**

You install your SAP system as described in this installation guide. During the installation, you specify the Java database as data source for the User Management Engine (UME) (see *SAP System Parameters* [page 32]).

During the installation, the SAP system is automatically configured to use the Java database as data source for the UME.
After the installation has finished, you can still change the user management configuration. For more information, see Configuring User Management [page 113].

Using an External SAP ABAP System as Source for User Data

1. You prepare the external SAP ABAP system as described in Preparing an External ABAP System as Source for User Data [page 143].
2. You install your SAP system as described in this installation guide. During the installation, you specify an external ABAP system as data source for the User Management Engine (UME) (see SAP System Parameters [page 32]).
3. After the installation has finished, you can no longer change this configuration of the UME. For more information, see Configuring User Management [page 113].

Using an LDAP directory as Source for User Data

1. You install your SAP system as described in this installation guide.
2. Configure the user management of the newly installed SAP system to use an LDAP directory. For more information, see Configuring User Management [page 113].

5.5 Prerequisites for Running the Installer

Make sure you fulfil the following prerequisites before running the installer.

- If you want to use the SL Common GUI, make sure that the following web browser requirements are met:
  - You have one of the following supported browsers on the device where you want to run the SL Common GUI: Google Chrome, Mozilla Firefox, Microsoft Edge, or Microsoft Internet Explorer 11. Always use the latest version of these web browsers.
  - Recommendation: We recommend using Google Chrome.
  - If you copy the SL Common GUI URL manually in the browser window, make sure that you open a new Web browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or private browsing mode (Firefox). This is to prevent Web browser plugins and settings from interfering with the SL Common GUI.
For more information about the SL Common GUI, see Useful Information About the Installer [page 89].

- Make sure that you use an account with the required user authorization to run the installer [page 54].
- Make sure that you have specified the most important SAP system parameters as described in Basic SAP System Installation Parameters [page 31] before you start the installation.
- Check that your installation hosts meet the requirements for the installation options that you want to install. For more information, see Running the Prerequisite Checker [page 22].
- If you are installing a second or subsequent SAP system into an existing database (MCOD), make sure that the database is up and running before starting the installation.
  - Check that the SYSTEM tablespace contains at least 400 MB of free space. If there is not enough space left, increase the size of this tablespace with BRSPACE or BRTOOLS.
For more information, see Installation of Multiple Components in One Database [page 141].
• If you want to install a dialog instance to an existing SAP system, make sure that:
  ○ The service definitions for the SAP start services are configured correctly and refer to the correct profile files.
  ○ There are no profile backup files with an underscore “_” in their profile name. If so, replace the “_” with a “.”.

Example

Rename `<Drive>`: \usr\sap\S14\SYS\profile\S14_JC20_wsi6408_12 to `<Drive>`: \usr \sap\S14\SYS\profile\S14_JC20_wsi6408.12.

• Make sure that the following ports are not used by other processes:
  ○ When using the SL Common GUI:
    ○ Port 4237 is used by default as HTTPS port for communication between the installer and the SL Common GUI.
      If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      `SAPINST_HTTPS_PORT=<Free Port Number>`
    ○ Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer processing.
      The filled-out evaluation form is then sent to SAP using HTTPS.
      If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      `SAPINST_HTTP_PORT=<Free Port Number>`
  ○ When using the Java SDT GUI:
    ○ Port 21212 is used by default for communication between the installer GUI server and the installer GUI client.
      If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      `SAPINST_DIALOG_PORT=<Free Port Number>`
    ○ Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer processing.
      The filled-out evaluation form is then sent to SAP using HTTPS.
      If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      `SAPINST_HTTP_PORT=<Free Port Number>`
5.6 Running the Installer

This section describes how to run the installation tool Software Provisioning Manager 1.0 (the “installer” for short).

Prerequisites

For more information, see Prerequisites for Running the Installer [page 83].

Context

Software Provisioning Manager (the “installer” for short) offers two GUIs:

- The new web browser-based “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short
- The “classic” Java-based GUI with a CUI client and server - “Java SDT GUI” for short

Note

If the SL Common GUI does not meet your requirements you can still use the “classic” Java SDT GUI. You then have to start the sapinst executable with the command line option SAPINST_SLP_MODE=false.

In cases where both GUIs behave the same way, we address them as “installer GUI”.

For more information, see Useful Information About the Installer [page 89].

This procedure describes an installation where you use one of the following GUI scenarios:

- You run the installer and use the SL Common GUI. Then you can control the processing of the installer in the browser running on any device.
- You run the installer and use the Java SDT GUI. Both are running on the same host.

Procedure

1. Log on to the installation host using an account with the required user authorization to run the Installer [page 54].

Caution

Do not use an existing <sapsid>adm user.

SL Common GUI only: If your security policy requires that the person running the installer is not allowed to know administrator credentials on the installation host, you can specify another operating system user.
for authentication purposes. You do this using the `SAPINST_REMOTE_ACCESS_USER` parameter when starting `sapinst.exe` from the command line. You have to confirm that the user is a trusted one. For more information, see SAP Note 1745524.

2. Make the installation media available.
   For more information, see Preparing the Installation Media [page 57].

3. Start the installer by double-clicking `sapinst.exe` from the directory to which you unpacked the Software Provisioning Manager archive.
   By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the `sapinst` executable with command line option `SAPINST_BROWSER=<Path to Browser Executable>`, for example `SAPINST_BROWSER=firefox.exe`.

   **Note**
   If you want to use a virtual host name, open a command prompt or PowerShell window in elevated mode and change to the directory to which you unpacked the Software Provisioning Manager archive.

   Start the installer with the following command:

   ```
   \sapinst.exe SAPINST_USE_HOSTNAME=<Virtual_Host_Name>
   ```

   For more information, see Using Virtual Host Names [page 55].

4. The installer is starting up.
   Depending on the type of the installer GUI you want to use, do one of the following:

   - If you use the SL Common GUI, the installer now starts and waits for the connection with the SL Common GUI. If you have a supported web browser (see Prerequisites for Running the Installer [page 83]) installed on the host where you run the installer, the SL Common GUI starts automatically by displaying the **Welcome** screen.
     If the SL Common GUI does not open automatically, you can find the URL you require to access the SL Common GUI at the bottom of the **Program Starter** window of the installer. You find the icon of the **Program Starter** window in the taskbar of your Windows host. Open a supported web browser and run the URL from there.

   ```
   ```

   The SL Common GUI opens in the browser by displaying the **Welcome** screen.
Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst process on this computer could not be verified. Accept this warning to inform your browser that it can trust this site, even if the certificate could not be verified.

- If you use the Java SDT GUI - that is you started the sapinst executable with command line option SAPINST_SLP_MODE=false, the Java SDT GUI starts automatically by displaying the Welcome screen.

5. On the Welcome screen, choose the required option:
   - Install an SAP system
     Install an SAP system or an optional standalone unit:
     - To install an SAP system based on SAP NetWeaver Application Server for Java, choose <Product> SAP Application Server Java <Database> <System Variant>.
     - To install an optional standalone unit – that is an Application Sharing Server, J2EE Adapter Engine, or an SAP Partner Connectivity Kit – choose one of the following:
       - Application Sharing Server
         <Product> SAP NetWeaver 7.0 <Support Release or Enhancement Package> Optional Standalone Units Application Sharing Server <Database> Application Sharing Server Installation
       - J2EE Adapter Engine
         <Product> SAP NetWeaver 7.0 <Support Release or Enhancement Package> Optional Standalone Units J2EE Adapter Engine <Database> J2EE Adapter Engine Installation
       - SAP Partner Connectivity Kit
         <Product> SAP NetWeaver 7.0 <Support Release or Enhancement Package> Optional Standalone Units Partner Connectivity Kit <Database> Partner Connectivity Kit Installation
     - Perform other tasks or install additional components
       Go to <Product> Software Life-Cycle Options and choose the required task.

6. Choose Next.
7. If the installer prompts you to log off from your system, log off and log on again.
   The installer restarts automatically.
8. Follow the instructions on the installer input screens and enter the required parameters.

To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field:
- If you use the SL Common GUI, choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.
- If you use the Java SDT GUI, choose F1. Then a dialog opens with the available help text.
Only valid for 'Software Component': SAP NetWeaver

**Note**

**J2EE Adapter Engine only**
- Make sure you use the *Custom* parameter mode.
- On the *UME Configuration* screen, we recommend that you choose *Use ABAP*.

End of 'Software Component': SAP NetWeaver

**Caution**

The signature of media is checked **automatically** during the *Define Parameters* phase while processing the *Media Browser* screens.

Keep in mind that this automatic check is only committed once and **not** repeated if you modify artefacts such as SAR archives or files on the media **after** the initial check has been done - that is if you modify artefacts later on either during the remaining *Define Parameters* phase or later on during the *Execute Service* phase the signature is not checked again.

See also the description of this new security feature in SAP Note 2393060.

9. After you have entered all requested input parameters, the installer displays the *Parameter Summary* screen. This screen shows both the parameters that you entered and those that the installer set by default. If required, you can revise the parameters before starting the installation.

10. To start the installation, choose *Next*.

The installer starts the installation and displays the progress of the installation.

When the installation option has finished successfully, the installer displays the message *Execution of <Option Name>* has completed.

**Caution**

**Multiple Oracle Homes only:** The installer uses default values for the Oracle Home and Listener configuration. Therefore, if you use multiple Oracle Homes, you must specify the new Oracle home, as well as the listener port number. You can change these values on the installer *Summary* screen during the database instance installation. On the *Summary* screen, check both *Oracle > Database System* and *Oracle > Listener Configuration* and use the *Revise* button. On the upcoming screen, change the Oracle Home and the Listener port number. Make sure that you use a free port number, and do **not** use the numbers 1521 or 1527 as these might already be in use by default.

**Note**

**Enterprise Portal only:** During the last restart of Application Server Java performed by the installer, the portal starts the processing and upload of the new portal archives. It takes approximately 15 to 90 minutes before the deployment is completed and the portal is launched.

Do **not** stop the installer or Application Server Java during this phase.

11. If required, install a dialog instance for a central system or distributed system.

12. **Java GUI only:** For security reasons, we recommend that you delete the `.adtgui` directory within the home directory of the user with which you ran the installer:
13. If you copied installation media to your hard disk, you can delete these files when the installation has successfully completed.

5.7 Additional Information About the Installer

The following sections provide additional information about the installer.

Related Information

Useful Information About the Installer [page 89]
How to Avoid Automatic Logoff by the Installer [page 91]
Interrupted Processing of the Installer [page 92]
Performing a Remote Installation (Java SDT GUI only) [page 95]
Starting the Java SDT GUI Separately [page 97]
Running the Installer in Accessibility Mode [page 99]
Entries in the Services File Created by the Installer [page 100]
Troubleshooting with the Installer [page 101]

5.7.1 Useful Information About the Installer

This section contains some useful technical background information about the installer and the installer GUI.

- Software Provisioning Manager (the installer) offers two GUIs:
  - The new web browser-based “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short
  - The “classic” Java-based GUI with a CUI client and server - “Java SDT GUI” for short
  The SL Common GUI of the Software Provisioning Manager (or “SL Common GUI” for short) uses the SAP UI Development Toolkit for HTML5 - also known as SAPUI5 - a client-side HTML5 rendering library based on JavaScript. The benefits of this new user interface technology for the user are:
  - Zero footprint, since only a web browser is required on the client
  - New controls and functionality, for example, view logs in web browser.
  The SL Common GUI connects the web browser on a client with the sapinst executable - which is part of Software Provisioning Manager - running on the installation host using the standard protocol HTTPS.
  For the SL Common GUI, the installer provides a pre-generated URL in the Program Starter window. If you have a supported web browser installed on the host where you run the installer, the SL Common GUI starts automatically.
  By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the sapinst executable with command line option
SAPINST_BROWSER=<Path to Browser Executable>, for example SAPINST_BROWSER=firefox.exe.
Alternatively you can open a supported web browser on any device and run the URL from there.
For more information about supported web browsers see Prerequisites for Running the Installer [page 83].
If the SL Common GUI does not meet your requirements, you can still use the “classic” Java SDT GUI. To do so, you must start the sapinst executable with the command line option SAPINST_SLP_MODE=false.
You can switch back to the default installer GUI at any time with the following steps:
1. Stop the installer.
2. Restart the installer with command line option SAPINST_SLP_MODE=false.
3. On the What do you want to do? screen choose Continue with the existing run.

- The installer creates the installation directory sapinst_instdir, which is located directly in the %ProgramFiles% directory. If the installer is not able to create sapinst_instdir there, it tries to create sapinst_instdir in the directory defined by the environment variable TEMP.

**Recommendation**
We recommend that you keep all installation directories until the system is completely and correctly installed.

- For each installation option, the installer creates a subdirectory located in the sapinst_instdir directory.
- The installer extracts itself to a temporary directory called sapinst.exe.xxxxxx.xxxx, which is located in %TEMP%, %TMP%, %TMPDIR%, or %SystemRoot%. These files are deleted after the installer has stopped running.
  - The temporary directory sapinst.exe.xxxxxx.xxxx sometimes remains undeleted. You can safely delete it.
  - The temporary directory also contains the log file dev_selfex.out from the extraction process, which might be useful if an error occurs.

**Caution**
If the installer cannot find a temporary directory, the installation terminates with the error FCO-00058.

- To see a list of all available installer properties, open a command prompt and start the installer with command line parameter -p: sapinst.exe -p
- If you need to run the installer in accessibility mode, make sure that you have activated and adjusted accessibility settings as described in Running the Installer in Accessibility Mode [page 99].
- If you want to install an SAP system in unattended mode, see SAP Note 2230669 which describes an improved procedure using inifile.params.
- If required, stop the installer by choosing one of the following, depending on the installer GUI you use:
  - In the SL Common GUI, choose the Cancel button.
  - In the Java SDT GUI, choose SAPinst Exit Process in the Java SDT GUI menu.

**Note**
If you need to terminate the installer, choose File Exit in the menu of the Program Starter window.
5.7.2 How to Avoid Automatic Logoff by the Installer

When you install the SAP system, the installation tool checks whether the user account used for the installation has the required privileges and authorization.

For a domain installation, the account needs to be both a member of the local Administrators group and the domain Admins group. For a local installation, the account needs to be a member of the local group Administrators group.

In both cases, the user account must be authorized to do the following:

- Act as part of the operating system
- Adjust memory quotas for a process
- Replace a process level token

If the user account does not have these rights assigned, the installer assigns them and automatically logs the account off to activate them. To avoid the installer logging the account off, you can set these rights manually before you start the installation.

Procedure

You perform the following steps to assign these rights to the user account used for the installation.

⚠️ Caution

Be aware that domain policies override locally defined policies. This means that if you want to grant domain administrator rights to a user who belongs to the local Administrators group, make sure that you have also defined domain administrator rights for this user on domain level.

1. Windows Server 2012 (R2) and higher: Press `Ctrl` + `Esc` and choose `Administrative Tools` > `Local Security Policy`.
3. In the `Local Security Settings` window, choose `Local Policies` > `User Rights Assignment`.
4. Double-click the required right under `Policy` and choose `Add User or Group`.
5. In the `Select Users and Groups` window, choose the required user and choose `Add`.
6. The selected user appears in the box below.
7. Confirm your entry and then repeat the steps for each remaining policy that the user requires for the installation.
8. Log off and log on again to apply the changes.

More Information

Required User Authorization for Running the Installer [page 54]
5.7.3 Interrupted Processing of the Installer

Here you find information about how to restart the installer if its processing has been interrupted.

Context

The processing of the installer might be interrupted for one of the following reasons:

- An error occurred during the Define Parameters or Execute phase:
  The installer does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description of the choices listed in the table below as well as a path to a log file that contains detailed information about the error.

- You interrupted the installation by choosing
  ○ Cancel in the SL Common GUI
  ○ Exit Process in the SAPinst menu in the Java SDT GUI

**Caution**

If you stop an option in the Execute phase, any system or component installed by this option is incomplete and not ready to be used. Any system or component uninstalled by this option is not completely uninstalled.

The following table describes the options in the dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry</td>
<td>The installer retries the installation from the point of failure without repeating any of the previous steps. This is possible because the installer records the installation progress in the keydb.xml file. We recommend that you view the entries in the log files, try to solve the problem, and then choose Retry. If the same or a different error occurs, the installer displays the same dialog box again.</td>
</tr>
<tr>
<td>Stop</td>
<td>The installer stops the installation, closing the dialog box, the installer GUI, and the GUI server. The installer records the installation progress in the keydb.xml file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below.</td>
</tr>
<tr>
<td>Continue</td>
<td>The installer continues the installation from the current point.</td>
</tr>
<tr>
<td>View Log</td>
<td>Access installation log files.</td>
</tr>
</tbody>
</table>
The following procedure describes the steps to restart an installation, which you stopped by choosing Stop, or to continue an interrupted installation after an error situation.

**Procedure**

1. Log on to the installation host as a user with the required permissions as described in Running the Installer [page 85].
2. Make sure that the installation media are still available.
   For more information, see Preparing the Installation Media [page 57].

   ➤ Recommendation
   Make the installation media available locally. For example, if you use remote file shares on other Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from media mounted with NFS might fail.

3. Restart the installer by double-clicking sapinst.exe from the directory to which you unpacked the Software Provisioning Manager archive.
   By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the sapinst executable with command line option SAPINST_BROWSER=<Path to Browser Executable>, for example SAPINST_BROWSER=firefox.exe.
4. The installer is restarting.
   Depending on the type of the installer GUI you want to use, do one of the following:
   ○ If you use the SL Common GUI, the installer now starts and waits for the connection with the SL Common GUI. If you have a supported web browser (see Prerequisites for Running the Installer [page 83]) installed on the host where you run the installer, the SL Common GUI starts automatically by displaying the Welcome screen.
   If the SL Common GUI does not open automatically, you can find the URL you require to access the SL Common GUI at the bottom of the Program Starter window of the installer. You find the icon of the Program Starter window in the taskbar of your Windows host. Open a supported web browser and run the URL from there.

   ➤ Sample Code
   ```
   ... ***************************************************************************
   Open your browser and paste the following URL address to access the GUI
   https://[<hostname>]:4237/sapinst/docs/index.html
   Logon users: [<users>]
   ***************************************************************************
   ...
   ```

   The SL Common GUI opens in the browser by displaying the Welcome screen.
Note

Before you reach the *Welcome* screen, your browser might warn you that the certificate of the *sapinst* process on this computer could not be verified. Accept this warning to inform your browser that it can trust this site, even if the certificate could not be verified.

- If you use the Java SDT GUI - that is you started the *sapinst* executable with command line option `SAPINST_SLP_MODE=false`, the Java SDT GUI starts automatically by displaying the *Welcome* screen.

5. From the tree structure on the *Welcome* screen, select the installation option that you want to continue and choose *Next*.

The *What do you want to do?* screen appears.

6. On the *What do you want to do?* screen, decide between the following alternatives and continue with *Next*:

<table>
<thead>
<tr>
<th>Alternative</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Perform a new run</strong></td>
<td>The installer does not continue the interrupted installation option. Instead, it moves the content of the old installer directory and all installer-specific files to a backup directory. Afterwards, you can no longer continue the old option. The following naming convention is used for the backup directory: log_&lt;Day&gt;_&lt;<em>Month&gt;</em>&lt;<em>Year&gt;</em>&lt;<em>Hours&gt;</em>&lt;<em>Minutes&gt;</em>&lt;_Seconds&gt;</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>log_01_Oct_2016_13_47_56</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>All actions taken by the installation before you stopped it (such as creating directories or users) are not revoked.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>The installer moves all the files and folders to a new log directory, even if these files and folders are owned by other users. If there are any processes currently running on these files and folders, they might no longer function properly.</td>
</tr>
<tr>
<td><strong>Continue with the existing one</strong></td>
<td>The installer continues the interrupted installation from the point of failure.</td>
</tr>
</tbody>
</table>
5.7.4 Performing a Remote Installation (Java SDT GUI only)

Here you find information about how to install your SAP system on a remote host.

i Note
This section is only valid if you use the Java SDT GUI. That is, you started the sapinst executable with command line option SAPINST_SLP_MODE=false.

Prerequisites

- The remote host meets the prerequisites for starting the installer as described in Prerequisites for Running the Installer [page 83].
- Both computers are in the same network and can ping each other.
  To test this:
  1. Log on to your remote host and enter the command: ping <Local_Host>
  2. Log on to the local host and enter the command: ping <Remote_Host>
- If you need to specify another operating system user with the SAPINST_REMOTE_ACCESS_USER command line parameter, make sure that this user exists on the remote host.

Context

You use this procedure to install your SAP system on a remote host. In this case, the installer runs on the remote host, and the installer GUI runs on the local host. The local host is the host from which you control the installation with the installer GUI. The installer GUI connects using a secure SSL connection to the installer.

If your security policy requires that the person performing the installation by running the installer GUI on the local host is not allowed to know administrator credentials on the remote host, you can specify another operating system user for authentication purposes. You do this using the SAPINST_REMOTE_ACCESS_USER parameter when starting sapinst.exe from the command line. You have to confirm that the user is a trusted one. For more information, see SAP Note 1745524.

Procedure

1. Log on to the remote host.
   Make sure that you log on as a user with the required authorization for running the installer
   For more information, see Required User Authorization for Running the Installer [page 54].
2. Make the installation media available on your remote host.
   For more information, see Preparing the Installation Media [page 57].
Note

Even if you use the complete SAP kernel media, the installer might prompt you during the provisioning process for additional archives (*.SAR files) due to special Patch Level (PL) requirements depending on categories such as the product, operating system, and database platform.

For example: The installer might require a certain PL of `<X>` of the `SAPEXEDB.SAR` (for DBTYPE `<Y>`), but this PL of the `SAPEXEDB.SAR` is not contained in the SAP kernel media. In this case you have to download the required PL from [http://support.sap.com/swdc](http://support.sap.com/swdc) following the instructions given in section Downloading Specific Installation Archives (Archive-Based Installation) in Preparing the Installation Media [page 57].

3. Open a command prompt and change to the directory to which you unpacked the Software Provisioning Manager archive.

4. Check the version of the `sapinst` executable by entering the following command:

   ```
   sapinst.exe -sfxver
   ```

   The version of the `sapinst` executable must be exactly the same as the version of the `sapinstgui` executable on the local host (see also Starting the Installer GUI Separately [page 97]).

5. Start the installer by entering the following command:

   ```
   sapinst.exe
   ```

   Note

   If you need to specify another operating system user for authentication purposes, enter the following command:

   ```
   sapinst.exe SAPINST_REMOTE_ACCESS_USER=<Specified_OS_User>
   ```

   Note

   If you need to assign a virtual host name to the instance to be installed and you do not want to assign it by entering it as a parameter using the installer screens (see SAP System Parameters [page 32]), you can alternatively assign it as follows:

   Note

   1. Open a command prompt or PowerShell window in elevated mode and change to the directory to which you unpacked the Software Provisioning Manager archive.

   2. Start the installer with the following command:

   ```
   \sapinst.exe SAPINST_USE_HOSTNAME=<Virtual_Host_Name> (in a command prompt)
   .\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual_Host_Name> (in PowerShell)
   ```

   For more information, see Using Virtual Host Names [page 55].

The installer now starts and waits for the connection to the installer GUI. You see the following at the command prompt:

```
guiengine: no GUI connected; waiting for a connection on host <Host_Name>, port <Port_Number> to continue with the installation
```
6. Start the installer GUI on your local host as described in Starting the Installer GUI Separately [page 97].

## 5.7.5 Starting the Java SDT GUI Separately

Here you find information about how to start the Java SDT GUI separately.

### Note

This section is only valid if you use the Java SDT GUI. That is, you started the sapinst executable with command line option `SAPINST_SLP_MODE=false`.

### Prerequisites

The host on which you want to start the installer GUI meets the prerequisites for starting the installer as described in Prerequisites for Running the Installer [page 83].

### Note

If you want to run the installer on a UNIX host, make sure that you meet the prerequisites for the installer listed in the relevant UNIX guide.

### Context

You need to start the installer GUI separately in the following cases:

- You closed the installer GUI using `File > Close GUI only` from the installer menu while the installer is still running.
- You want to perform a remote installation, where the installer GUI runs on a different host from the installer. For more information, see Performing a Remote Installation [page 95].

In this procedure, the following variables are used: `<Remote_Host>` is the name of the remote host, and `<Port_Number_Gui_Server_To_Gui_Client>` is the port the GUI server uses to communicate with the GUI client (21212 by default).

### Procedure

- **Starting the Installer GUI on Windows**
  a. Make the installer software available on the host on which you want to start the installer GUI. For more information, see Preparing the Installation Media [page 57].
b. Start the installer GUI by executing `<Drive>:\<Path_To_Unpack_Directory>\sapinstgui.exe` with the appropriate command line parameters:
   ○ If you want to perform a remote installation, proceed as follows:
     1. Check the version of sapinstgui.exe by entering the following command:
        ```
        sapinstgui.exe -sfxver
        ```
        The version of the sapinstgui executable must be exactly the same as the version of the sapinst executable on the remote host (see also Performing a Remote Installation [page 95]).
     2. Start the installer GUI by entering the following command:
        ```
        sapinstgui.exe -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>
        ```
   ○ If you closed the installer GUI using File > Close GUI only and want to reconnect to the installer, proceed as follows:
     ○ If you are performing a local installation with the installer and the installer GUI running on the same host, execute the following command:
        ```
        sapinstgui.exe -port <Port_Number_Gui_Server_To_Gui_Client>
        ```
     ○ If you are performing a remote installation with the installer and the installer GUI running on different hosts, execute the following command:
        ```
        sapinstgui.exe -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>
        ```
   c. The installer GUI starts and connects to the installer.

   • Starting the Installer GUI on UNIX
   a. Make the installer software available on the host on which you want to start the installer GUI.
      For more information, see Preparing the Installation Media [page 57].
   b. Start the sapinstgui executable with the appropriate command line parameters:
      ○ If you want to perform a remote installation, proceed as follows:
        1. Check the version of the sapinstgui executable by entering the following command:
           ```
           <Path_To_Unpack_Directory>/sapinstgui -sfxver
           ```
           The version of the sapinstgui executable must be exactly the same as the version of the sapinst executable on the remote host (see also Performing a Remote Installation [page 95]).
        2. Start the installer GUI by entering the following command:
           ```
           <Path_To_Unpack_Directory>/sapinstgui -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>
           ```
      ○ If you closed the installer GUI using File > Close GUI only and want to reconnect to the installer, proceed as follows:
        ○ If you are performing a local installation with the installer and the installer GUI running on the same host, execute the following command:
           ```
           <Path_To_Unpack_Directory>/sapinstgui -port <Port_Number_Gui_Server_To_Gui_Client>
           ```
        ○ If you are performing a remote installation with the installer and the installer GUI running on different hosts, execute the following command:
           ```
           <Path_To_Unpack_Directory>/sapinstgui -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>
           ```
   c. The installer GUI starts and connects to the installer.
5.7.6 Running the Installer in Accessibility Mode

You can also run the installer in accessibility mode.

**Note**

The information contained in this section is only valid if you use the Java SDT GUI. That is, you started the sapinst executable with command line option **SAPINST_SLP_MODE=false**.

If you use the SL Common GUI, apply the standard accessibility functions of your web browser.

**Context**

The following features are available:

- **Keyboard access:**
  This feature is generally available for all operating systems.

- **High-contrast color:**
  This feature is derived from the Windows display properties. You can use it either for a local installation or for a remote installation.

- **Custom font setting:**
  This feature is derived from the Windows display properties. You can use it either for a local installation or for a remote installation.

**Procedure**

- **Activating and Adjusting Accessibility Settings on Windows**

  You first have to activate and adjust the relevant settings for the font size and color schemes **before** you start the installer or the installer GUI.

  **Note**

  The following procedure applies for Windows Server 2012 and might be different when using another Windows operating system.

  a. Right click on your Windows desktop and choose **Personalize**.

  b. Select **Adjust font size (DPI)** and choose **Larger scale (120 DPI)**.

  c. To define other font size schemes, choose **Custom DPI**.

  d. In the right-hand pane, select **Window Color and Appearance**.

  e. Select a color scheme from the **Color scheme** drop-down box.

  f. To define your own color schemes, choose **Advanced**.

- **Running the Installer in Accessibility Mode**
You can either perform a local installation, where the installer and the installer GUI are running on the same host, or a remote installation, where the installer and the installer GUI are running on different hosts.

- **Local installation:**
  Start the installer as described in Running the Installer [page 85] by executing the following command:
  ```
  <Path_To_Unpack_Directory>\sapinst.exe -accessible
  ```

- **Remote installation:**
  1. Start the installer on the remote host by executing the following command from the command line as described in Performing a Remote Installation (Java SDT GUI only) [page 95]:
     ```
     <Path_To_Unpack_Directory>\sapinst.exe
     ```
  2. Start the installer GUI on the local host by executing the following command from the command line as described in Starting the Java SDT GUI Separately [page 97]:
     ```
     <Path_To_Unpack_Directory>\sapinstgui.exe -accessible -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>
     ```

### 5.7.7 Entries in the Services File Created by the Installer

After the installation has finished successfully, the installer has created the following entries for port names in `\WINDOWS\system32\drivers\etc\services`:

- `sapdp<Instance_Number> = 32<Instance_Number>/tcp`
- `sapdp<Instance_Number>s = 47<Instance_Number>/tcp`
- `sapgw<Instance_Number> = 33<Instance_Number>/tcp`
- `sapgw<Instance_Number>s = 48<Instance_Number>/tcp`

**Note**
- There is a port created for every possible instance number, regardless of which instance number you specified during the installation. For example, for `sapgw<Instance_Number> = 33<Instance_Number>/tcp` the following range of entries is created:
  - `sapgw00 = 3300/tcp`
  - `sapgw01 = 3301/tcp`
  - `sapgw02 = 3302/tcp`
  - `...`
  - `sapgw98 = 3398/tcp`
  - `sapgw99 = 3399/tcp`
- If there is more than one entry for the same port number, this is **not** an error.
5.7.8 Troubleshooting with the Installer

This section tells you how to proceed when errors occur while the installer is running.

Context

If an error occurs, the installer:

- Stops processing
- Displays a dialog informing you about the error

Procedure

1. Check SAP Note 1548438 for known installer issues.

2. If an error occurs during the Define Parameters or the Execute Service phase, do one of the following:
   - Try to solve the problem:
     - To check the installer log files (sapinst.log and sapinst_dev.log) for errors, choose:
       - The LOG FILES tab, if you are using the SL Common GUI.
       - The View Logs menu item, if you are using the Java SDT GUI.
     - To check the log and trace files of the installer GUI for errors:
       - If you use the SL Common GUI, you can find them in the directory `%userprofile%\sapinst\`.
       - If you use the Java SDT GUI, you can find them in the directory `%userprofile%\sdtgui\`.
       - If the GUI server or the installer GUI do not start, check the file `sdtstart.err` in the current `%userprofile%` directory.
       - If the installer GUI aborts without an error message, restart the installer GUI as described in Starting the Installer GUI Separately [page 97].
   - Only valid for "High Availability": HA (Windows)
     - High Availability only: If you experience network connection problems, check IPv4 Host name resolution as described in SAP Note 1365796.
   - Then continue by choosing Retry.
   - If you cannot resolve the problem, abort the installer by choosing one of the following, depending on the type of installer GUI you use:
     - If you use the SL Common GUI, choose Cancel in the tool menu.
     - If you use the Java SDT GUI, choose Stop from the error message or SAPinst Exit Process in the tool menu.
     - For more information, see Interrupted Processing of the Installer [page 92].
   - End of 'High Availability': HA (Windows)

3. If you cannot resolve the problem, report an incident using the appropriate subcomponent of BC-INS*.
   - For more information about using subcomponents of BC-INS*, see SAP Note 1669327.
6  Post-Installation

6.1  Post-Installation Checklist

This section includes the post-installation steps that you have to perform for the following installation options:

- Central, distributed, or high-availability system
- Dialog instance

Detailed information about the steps is available in the relevant chapter.

Central, Distributed, or High-Availability System

**Note**

In a central system, all mandatory instances are installed on one host. Therefore, if you are installing a central system, you can ignore references to other hosts.

You can install optional standalone units **J2EE Adapter Engine, Partner Connectivity Kit, Application Sharing Server** only as a central system.

You have to complete the following post-installation steps, which are described in more detail in the linked chapters:

1. If required, you **perform a full system backup** [page 126] immediately after the installation has finished.
2. You check whether you can **log on to the Application Server Java** [page 103].
3. If you have installed SAP NetWeaver Portal or SAP NetWeaver Portal Core Component, you check whether you can **log on to the SAP NetWeaver Portal** [page 105].
4. If you have installed Development Infrastructure, you check whether you can **log on to the Development Infrastructure** [page 106].
5. You **provide access to the SAP NetWeaver Administrator** [page 107].
6. You **install the SAP license** [page 108].
7. You **configure the remote connection to SAP support** [page 109].
8. Windows Server 2008 (R2) or higher: If required, you **set up symbolic links for application servers** [page 109].
9. For production systems it is highly recommended that you **connect the system to SAP Solution Manager** [page 110].
10. You **apply the latest kernel and Support Package stacks** [page 112].
11. You **configure the user management** [page 113].
12. You **ensure user security** [page 113].
13. To perform basic configuration steps, you **run the Configuration Wizard** [page 119].
14. If you have installed J2EE Adapter Engine as an optional standalone unit, you perform **Post-Installation Steps for the J2EE Adapter Engine (Optional Standalone Unit)** [page 120].
15. If you have installed Partner Connectivity Kit (PCK) as an optional standalone unit, you perform Post-Installation Steps for the PCK (Optional Standalone Unit) [page 123].

16. On the database instance host, you perform the Oracle-specific post-installation steps [page 125].

17. If you have chosen to enable Oracle Database Vault, make sure that you perform the required configuration steps. For more information, see Implementing Oracle Database Vault with the Installer [page 148].

18. You perform a full installation backup [page 126].

19. You check the Master Guide for your SAP Business Suite application or SAP NetWeaver application (chapter Configuration of Systems and Follow-Up Activities) for further implementation and configuration steps, such as language installation, monitoring, work processes, transports, SAP license, printers, system logs, and connectivity to system landscape directory (SLD).

**Dialog Instance**

You have to complete the following post-installation steps, which are described in more detail in the linked chapters:

1. You check whether you can log on to the Application Server Java [page 103].
2. If you have installed SAP NetWeaver Portal or SAP NetWeaver Portal Core Component on the central instance, you check whether you can log on to the portal [page 105] from the dialog instance host.
3. If you have installed Development Infrastructure on the central instance, you check whether you can log on to the Development Infrastructure [page 106] from the dialog instance host.
4. Windows Server 2008 (R2), or higher: If required, you set up symbolic links for application servers [page 109].
5. You ensure user security [page 113].
6. You perform a full installation backup [page 126].

### 6.2 Logging On to the Application Server Java

You need to check that you can log on to the Application Server Java with the appropriate administrator user, given in the table below.

**Prerequisites**

The SAP system is up and running.
Context

**i Note**
In a distributed or high-availability system, you check whether you can log on to every instance of the SAP system that you installed.

Depending on your SAP system installation, the administrator user can either reside in the database of your Java system or in an external ABAP system.

Table 22:

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>The user name that you specified during the installation. The default name is Administrator.</td>
<td>The user that you created manually in the external ABAP system. The recommended name is J2EE_ADM_&lt;SAPSID_Java_System&gt;</td>
</tr>
</tbody>
</table>

You access AS Java with a URL using a web browser from your client machines. To log on to the application server Java, proceed as follows:

**Procedure**

1. Start a web browser and enter the following URL:
   
   http://<Hostname_of_AS_Java_Server>:5<Instance_Number>00

   **i Note**
   You must always enter a two-digit number for `<Instance_Number>`. For example, do not enter 1 but instead enter 01.

   **Example**
   If you installed SAP NetWeaver Application Server for Java on host saphost06 and the instance number of your SAP NetWeaver Application Server for Java is 04, enter the following URL:
   
   http://saphost06:50400

   The start page of the SAP NetWeaver Application Server for Java appears in the web browser.

2. Log on by pressing the link of any of the provided applications, for example *SAP NetWeaver Administrator* or *System Information*. 
6.3 Logging On to SAP NetWeaver Portal

You need to check that you can log on to the application server using the following standard users.

**Prerequisites**

The SAP system is up and running.

**Context**

This procedure applies when you install usage type `NetWeaver Enterprise Portal Core Components (EPC)` only and when you install it together with usage type `SAP NetWeaver Enterprise Portal (EP)`: 

*Note*

In a distributed or high-availability system you check whether you can log on to the portal from every instance of the SAP system that you installed.

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>The user name that you specified during the installation. The default name is Administrator.</td>
<td>The user that you created manually in the external ABAP system. The recommended name is J2EE_ADM_&lt;SAPSID_Java_System&gt;</td>
</tr>
</tbody>
</table>

You access the SAP NetWeaver Portal with a URL using a web browser from your client machines.

The default URL consists of the installation host name and the port on which the portal is listening. You can use the HTTP or HTTPS protocol. HTTPS is relevant if you are using Secure Sockets Layer (SSL) communication.
**Procedure**

1. Start a web browser and enter the following URL: `http://<Hostname_Of_J2EE_Server>:5<Instance_Number>00/irj`

   **Note**
   You must always enter a two digit number for `<Instance_Number>`. For example, do not enter 1 but instead enter 01.

   **Example**
   If you installed the SAP NetWeaver Portal on host `saphost06` and the instance number of your Application Server Java is 04, enter the following URL:
   `http://saphost06:50400/irj`

2. Log on by entering the required user and password.

**6.4 Logging On to the SAP NetWeaver Development Infrastructure (NWDI)**

If you have installed usage type DI, you have to log on to the services of SAP NetWeaver Development Infrastructure (NWDI) to check whether the installation of the usage type DI was successful.

**Procedure**

1. Start a web browser and enter the following URL: `http://<hostname_of_J2EE_Engine_Server>:5<Instance_Number>00/devinf`

   **Note**
   You must always enter a 2-digit number for `<Instance_Number>`. For example, do not enter 1 but instead enter 01.

   **Example**
   If you installed SAP NetWeaver Application Server for Java with DI on host `saphost06` and the instance number of your SAP NetWeaver Application Server for Java is 04, enter the following URL:
   `http://saphost06:50400`

2. Log on with the NWDI_ADM user.

   The start page *SAP NetWeaver Development Infrastructure* appears in the web browser.
The following links appear:

- **Design Time Repository**
- **Component Build Service**
- **Change Management Service**
- **System Landscape Directory**

3. Log on to these services one after another by clicking the appropriate link:
   
a. When you click **Design Time Repository**, the **Design Time Repository** page with the **Repository Browser** overview appears.
   
b. When you click **Component Build Service**, the **Component Build Service** page with the **CBS Buildspace Information** appears.
   
c. When you click **Change Management Service**, the **Change Management Service** page with the **CBS Buildspace Information** appears.
   
d. When you click **System Landscape Directory**, you should see the **System Landscape Directory** start page.

**Note**

The tables displayed on the pages might be empty. They are filled when you configure the development infrastructure either by running the Configuration Wizard or by configuring your system manually.

### 6.5 Providing Access to the SAP NetWeaver Administrator

Due to security restrictions, the SAP NetWeaver Administrator can only be accessed **locally** via `http://<Hostname_Of_J2EE_Engine_Server>:5<Instance_Number>00/nwa` after the installation has finished.

**Procedure**

Allow access to administration requests for the required network segments as described in SAP Note **1451753**.
6.6 Installing the SAP License

You must install a **permanent** SAP license.

**Context**

When you install your SAP system, a **temporary** license is automatically installed.

**Caution**

**Before** the temporary license expires, you must apply for a permanent license key from SAP.

We recommend that you apply for a permanent license key as soon as possible after installing your system.

<table>
<thead>
<tr>
<th>Only valid for 'High Availability': HA (Windows)</th>
</tr>
</thead>
</table>
If you do a failover of the SAP (A)SCS instance from one cluster node to another node, and you do not have a permanent license on this node, the generated temporary license is only valid for 30 minutes. Java application servers automatically shut down after 30 minutes of operation. To avoid this, apply a permanent license key as soon as possible.

**Note**

The license key is bound to the hardware key of the host where the message server is running.

In a high-availability system with Microsoft Failover Clustering, the message server is part of the (A)SCS instance that can run on a different cluster node. Therefore you must install the SAP license on both nodes.

You have to do failover from the first cluster node where the (A)SCS instance is installed to the second cluster node. Use the hardware key of the second cluster node for the installation of the second SAP license.

For more information about SAP license keys and how to obtain them, see [http://support.sap.com/licensekey](http://support.sap.com/licensekey).

**Procedure**

Install the SAP license as described in SAP Library at [http://help.sap.com/nw](http://help.sap.com/nw) » SAP NetWeaver Platform » SAP NetWeaver 7.0 » (Including Enhancement Package) » Application Help » SAP NetWeaver by Key Capability » Solution Life Cycle Management by Key Capability » SAP Licenses » SAP License Key / SAP Licensing Procedure »
6.7 Configuring Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the Early Watch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP.

For more information, see SAP Support Portal at https://support.sap.com/remote-support.html.

6.8 Creating Symbolic Links on Windows Server 2008 (R2) and Higher for Application Servers

Use

As of Windows Server 2008 (R2), you can create symbolic links for dialog instances to simplify their administration.

<table>
<thead>
<tr>
<th>Only valid for 'High Availability': HA (Windows)</th>
</tr>
</thead>
</table>

In a high-availability system, you can additionally create symbolic links for the central instance.

<table>
<thead>
<tr>
<th>End of 'High Availability': HA (Windows)</th>
</tr>
</thead>
</table>

Symbolic links for application servers let you access from your local host the SYS directory that is located on the global host, without having to specify its UNC path. Instead you can browse, for example, in the Windows explorer on your local host to the SYS directory and its subdirectories on the global host.

Procedure

Windows Server 2012 (R2) and higher

To create symbolic links, perform the following steps:

1. Open a PowerShell command in elevated mode, and enter the following PowerShell command in a single line:
   ```
   cmd /c mklink /d <localdisk>\usr\sap\<SAPSID>\SYS \<sapglobalhost>\sapmnt\<SAPSID>\SYS
   
   # Note
   Enter a blank before \<sapglobalhost>\....
   ```

2. If you use a central transport directory, you can also create the following link in PowerShell:
   ```
   cmd /c mklink /d <localdisk>\usr\sap\trans \<trans_dir_host>\sapmnt\trans
   
   # Note
   The transport directory host <trans_dir_host> and the <sapglobalhost> can be identical.
   ```
Caution

The command `mklink` creates the link without checking whether the link target exists or can be accessed. If the link does not work after you created it, make sure that it exists and check that the UNC path can be accessed.

Windows Server 2008 (R2)

To create symbolic links, perform the following steps:

1. In the Start menu, right-click on Command Prompt and choose Run as administrator.
2. Enter the following command in a single line:
   ```
   mklink /d <localdisk>:\usr\sap\<SAPSID>\SYS \\<sapglobalhost>\sapmnt\<SAPSID>\SYS
   ```
   
   **Note**
   
   Enter a blank before `\\<sapglobalhost>\...`

3. If you use a central transport directory, you can also create the following link:
   ```
   mklink /d <localdisk>:\usr\sap\trans \\<trans_dir_host>\sapmnt\trans
   ```
   
   **Note**
   
   The transport directory host `<trans_dir_host>` and the `<sapglobalhost>` can be identical.

Caution

The command `mklink` creates the link without checking whether the link target exists or can be accessed. If the link does not work after you created it, make sure that it exists and check that the UNC path can be accessed.

6.9 Connecting the System to SAP Solution Manager

Here you find information about how to connect your newly installed SAP system to SAP Solution Manager.

Prerequisites

A SAP Solution Manager system must be available in your system landscape. For more information, see http://help.sap.com/solutionmanager.
Context

SAP Solution Manager gives you central access to tools, methods, and preconfigured content that you can use to evaluate and implement your solutions.

When your implementation is running, you can use SAP Solution Manager to manage, monitor, and update systems and business processes in your solution landscape, and also to set up and operate your own solution support.

Procedure

You connect a technical system to SAP Solution Manager by the following steps:

1. On the technical systems of your landscape, **data suppliers** are implemented, for example, with transaction RZ70 for Application Server ABAP and with Visual Administrator for Application Server Java.

   For more information, see the SAP Solution Manager Application Help:
   - If your SAP Solution Manager release is 7.1:
   - If your SAP Solution Manager release is 7.2:

2. The data suppliers send information about the hardware and installed software to a central **System Landscape Directory (SLD)**. Updates are sent to the SLD as well.

   For more information, see the Planning Guide - System Landscape Directory in the SAP Community Network at System Landscape Directory (SLD) - Overview

3. From the SLD, this information is regularly synchronized with **SAP Solution Manager** where it is managed in the Landscape Management Database (LMDB).

   For more information, see the SAP Solution Manager Application Help:
   - If your SAP Solution Manager release is 7.1:
   - If your SAP Solution Manager release is 7.2:

4. In the LMDB, you complete the information from the SLD manually.

   For more information, see the SAP Solution Manager Application Help:
If your SAP Solution Manager release is 7.1:
Solution Manager Operations Managing System Landscape Information

If your SAP Solution Manager release is 7.2:
http://help.sap.com/solutionmanager Version 7.2 SPS Application Help (English)
Technical Infrastructures Landscape Management Database (LMDB) Managing Technical System Information

Next Steps

For more information, see the following pages in the SAP Community Network:
- System Landscape Directory (SLD) - Overview
- Documentation for Landscape Management Database - LMDB

6.10 Applying the Latest Kernel and Support Package Stacks

We strongly recommend that you apply the latest kernel and Support Package stacks from SAP Service Marketplace before you start configuring your SAP system.

Prerequisites

If the central instance host and the dialog instance host run on different operating systems or platforms, all application servers must have the same kernel patch level.

Procedure

- Download and apply the latest Kernel and Support Package stacks using the Software Update Manager (SUM) as described in the documentation Updating SAP Systems Using Software Update Manager 1.0 SP available at http://support.sap.com/sitoolset System Maintenance Software Update Manager (SUM) 1.0 SP Guides for SUM 1.0 SP
- If you want to update the kernel manually, proceed as described below:
  a. Log on as user <sapsid>adm to the hosts of the SAP system instances to be updated.
  b. Download the latest kernel for your operating system and database platform as described in SAP Note 19466.
c. Back up the kernel directory that is specified by the profile parameter `DIR_CT_RUN`.

d. Extract the `.SAR` files of the kernel Support Packages of the target SP level to a temporary directory using the `SAPCAR` tool.

e. Copy or move the extracted programs from the temporary directory to the local kernel directory.

### 6.11 Configuring User Management

During the installation of your SAP system, you specified the database of the AS Java as the initial data source of the User Management Engine (UME) (see [SAP System Parameters](#page 32)).

After the installation of your SAP system has finished, you can still change the data source of the UME to a directory service.

During the installation of your SAP system, you specified one of the following initial data sources of the User Management Engine (UME) (see [SAP System Parameters](#page 32)):

- Database of the AS Java
- External ABAP system

After the installation of your SAP system has finished, you can still change the data source of the UME. The following data source changes are supported:

- From the AS Java database to user management of an external ABAP system
- From the AS Java database to a directory service

For more information about changing the data source after installation and about related restrictions, see the SAP Library at:

http://help.sap.com/nw [SAP NetWeaver Platform] [SAP NetWeaver 7.0 Including Enhancement Package] [Application Help] [SAP NetWeaver by Key Capability] [Security] [Identity Management] [User Management of the Application Server Java] [Configuring User Management] [UME Data Sources]

### 6.12 Ensuring User Security

You need to ensure the security of the users that the installer created during the installation.

The tables below at the end of this section list these users:

- Operating system users
- SAP system users
- Users in the SAP NetWeaver Development Infrastructure (NWDI)

During the installation, the installer by default assigned the master password to all users created during the installation unless you specified other passwords.

If you change user passwords, be aware that SAP system users might exist in multiple SAP system clients (for example, if a user was copied as part of the client copy). Therefore, you need to change the passwords in all the relevant SAP system clients.
**Recommendation**

User ID and password are encoded only when transported across the network. Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections or Secure Network Communications (SNC) for the SAP protocols dialog and RFC.

For more information, see:

http://help.sap.com/nw\SAP NetWeaver Platform \SAP NetWeaver 7.0 \Including Enhancement Package > Application Help > SAP NetWeaver by Key Capability > Security > Network and Transport Layer Security

**Caution**

Make sure that you perform this procedure **before** the newly installed SAP system goes into production. For security reasons, you also need to copy the installation directory to a separate, secure location – such as a separate storage medium – and then delete the installation directory.

For the users listed below, take the precautions described in the relevant SAP security guide.

You can find the security guide in the **Security** section of the product page for your SAP product at http://help.sap.com.

**Example**


---

**Operating System and Database Users**

After the installation, operating system users for SAP system, database, and SAP Host Agent are available as listed in the following table:

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>&lt;sapid&gt;adm</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td></td>
<td>SAPService&lt;SAPSID&gt;</td>
<td>User to run the SAP system</td>
</tr>
<tr>
<td>Oracle database user</td>
<td>SAP&lt;SCHEMA_ID&gt;DB</td>
<td>Oracle database owner (that is, the owner of the database tables)</td>
</tr>
<tr>
<td></td>
<td>SYSTEM</td>
<td>Oracle standard database user</td>
</tr>
<tr>
<td></td>
<td>SYS</td>
<td>Oracle standard database user</td>
</tr>
</tbody>
</table>
### SAP System Users

Depending on the UME (User Management Engine) configuration that you specified during the installation, the following UME users are available after the installation:

- **If you chose option Use Java Database**, UME users are stored in the database (Java UME) – see table Users Stored in the Java Database below. You can manage users and groups with the UME Web admin tool and the Visual Administrator only. If you want to use LDAP, you have to change the user configuration to LDAP. For more information, see Configuring User Management to Use an LDAP Directory [page 113].

- **If you chose option Use ABAP**, UME users are stored in an external ABAP system (ABAP UME) – see table Users Stored in an External ABAP System below. You can manage users with transaction SU01 in the external ABAP system and, depending on the permissions of the communication user, also with the UME Web admin tool and the Visual Administrator. For more information, see Preparing an External ABAP System as Source for User Data [page 143].

### Users Stored in the Java Database

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>OUTLN</td>
<td></td>
<td>Oracle standard database user</td>
</tr>
<tr>
<td>DBSNMP</td>
<td></td>
<td>Oracle standard database user</td>
</tr>
</tbody>
</table>

### Users Stored in an External ABAP System

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You do not need to change the password of this user after the installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This user is for administration purposes only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You are not able to log on as sapadm as this user is locked.</td>
</tr>
</tbody>
</table>

Table 25: SAP Host Agent User

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You do not need to change the password of this user after the installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This user is for administration purposes only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You are not able to log on as sapadm as this user is locked.</td>
</tr>
</tbody>
</table>
The following tables show these users together with recommendations on how you can ensure the security of these users:

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>The name that you gave this user when you created it manually in the external ABAP system</td>
<td>This user has administrative permissions for user management and its password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the J2EE Engine Config Tool. <strong>Recommendation</strong> We recommend that you use strong password and auditing policies for this user.</td>
</tr>
<tr>
<td>Guest</td>
<td>The name that you gave this user when you created it manually in the external ABAP system</td>
<td>This user is used for anonymous access. Lock this user for interactive logon.</td>
</tr>
<tr>
<td>SDM</td>
<td>SDM</td>
<td>This user is used to access the Software Deployment Manager (SDM) in the Java system.</td>
</tr>
<tr>
<td>Communication user for the J2EE Engine</td>
<td>The name that you gave this user when you created it manually in the external ABAP system</td>
<td>This user is used for the communication between the ABAP system and the Java system. Specify this user as a <em>Communications</em> user and not as a dialog user. This user exists in at least the SAP system client that you specified during the installation.</td>
</tr>
<tr>
<td>Users for Adobe Document Services (ADS)</td>
<td>The name of this user is ADSUSER. This user resides in the external ABAP system.</td>
<td>This user exists in at least clients 000 and 001 of the external ABAP system. You must have created this user manually in the external ABAP system before you started the installation.</td>
</tr>
<tr>
<td>ADS_AGENT</td>
<td>This user resides in the external ABAP system.</td>
<td>This user exists in at least clients 000 and 001 of the external ABAP system. You must have created this user manually in the external ABAP system before you started the installation.</td>
</tr>
<tr>
<td>User</td>
<td>User Name Storage: External ABAP System</td>
<td>Comment</td>
</tr>
<tr>
<td>------</td>
<td>----------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Data supplier user for System Landscape Directory (SLD) (optional)</td>
<td>The name that you gave this user when you created it manually in the external ABAP system</td>
<td>This user exists in at least clients 000 and 001 of the external ABAP system</td>
</tr>
<tr>
<td>ABAP API user for System Landscape Directory (SLD) (optional)</td>
<td>The name that you gave this user when you created it manually in the external ABAP system</td>
<td>This user exists in at least clients 000 and 001 of the external ABAP system</td>
</tr>
</tbody>
</table>

Table 27: Users Stored in the Java Database

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>Comment</th>
</tr>
</thead>
</table>
| Administrator | The name that you gave this user during the installation or the default name Administrator | This user has administrative permissions for user management and its password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the J2EE Engine Config Tool.  

**Recommendation**

We recommend that you use strong password and auditing policies for this user. |
| Guest | The name that you gave this user during the installation or the default name Guest | This user is used for anonymous access.  
Lock this user for interactive logon. |
| SDM | SDM | This user is used to access the Software Deployment Manager (SDM) in the Java system. |
| Users for Adobe Document Services (ADS) | ADSUSER | This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the J2EE Engine Config Tool. |
| | ADS_AGENT | This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the J2EE Engine Config Tool. |
### Users in the SAP NetWeaver

To change passwords at the Development Infrastructure (NWDI)

If you chose usage type (software unit) *SAP NetWeaver Development Infrastructure* (DI) during the installation, users in the SAP NetWeaver Development Infrastructure (NWDI) are available after the installation as listed in the following table:

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data supplier user for System Landscape Directory (SLD) (optional)</td>
<td>The name that you gave this user during the installation</td>
<td>Note: The installer created this user automatically if you chose <em>Configure local SLD</em> during the <em>Define Parameters</em> phase. The recommended name is SLDDSUSER.</td>
</tr>
</tbody>
</table>

### More Information

- For more information about managing Java users, see: [http://help.sap.com/nw](http://help.sap.com/nw) > *SAP NetWeaver Platform* > *SAP NetWeaver 7.0* <Including Enhancement_Package> > *Application Help* > *SAP NetWeaver by Key Capability* > *Security* > *Identity Management* > *User Management of the Application Server Java*.
- For more information about Java administration tools for user maintenance, see: [http://help.sap.com/nw](http://help.sap.com/nw) > *SAP NetWeaver Platforms* > *SAP NetWeaver 7.0* <Including Enhancement_Package> > *Application Help* > *SAP NetWeaver by Key Capability* > *Application Platform*. 

---

**Table 28:**

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator of the SAP NetWeaver Development Infrastructure (NWDI) and password</td>
<td>NWDI_ADM</td>
<td>Administrator of the NWDI</td>
</tr>
<tr>
<td>Developer in the SAP NetWeaver Development Infrastructure (NWDI) and password</td>
<td>NWDI_DEV</td>
<td>Developer in the NWDI</td>
</tr>
<tr>
<td>Landscape Directory Service User in the SAP NetWeaver Development Infrastructure (NWDI) and password</td>
<td>NWDI_CMSADM</td>
<td>Administrator of the NWDI Change Management System (CMS)</td>
</tr>
</tbody>
</table>

**Caution**

- This user has extensive authorizations. Make sure that you assign a secure password.
- Do not log on with this user. It is used by the system for internal communication.
6.13 Running the Configuration Wizard

This section provides information about how to run the configuration wizard for the SAP NetWeaver usage types.

⚠️ Caution

You can run the configuration wizard only once and only directly after you installed and patched your SAP system.

You cannot use the configuration wizard after:

- Upgrade
- Installation of additional usage types in an existing SAP system
- System copy

In these cases, you need to manually perform the corresponding configuration steps.

**BI Java only**: This does not apply to configuration tasks for BI Java. For more information about BI Java, see SAP Note 917950. We recommend that you check the configuration of BI Java using SAP Note 937697.

To configure an SAP NetWeaver usage type, proceed as described in the SAP Library at:

Table 29: SAP Release and SAP Library Quick Link

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.0 EHP2</td>
<td>Configuration &gt; Technology Consultant’s Guide &gt; Configuration Wizard</td>
</tr>
<tr>
<td>SAP NetWeaver 7.0 EHP1</td>
<td>Configuration Wizard &gt; Application Help &gt; SAP NetWeaver by Key Capability &gt; Solution Life Cycle Management by Key Capability &gt; SAP NetWeaver Configuration &gt; Configuration Wizard</td>
</tr>
<tr>
<td>SAP NetWeaver 7.0</td>
<td>Application Help &gt; SAP NetWeaver by Key Capability &gt; Solution Life Cycle Management by Key Capability &gt; SAP NetWeaver Configuration &gt; Configuration Wizard</td>
</tr>
</tbody>
</table>

More Information

- If you have SAP Solution Manager 7.1, see the configuration structure of your implementation project in SAP Solution Manager.
- SAP Note 923359: Collective Note: Configuration Wizard – Template Installer
6.14  Post-Installation Steps for the J2EE Adapter Engine
(Optional Standalone Unit)

After the installation has finished successfully, you need to perform the following post-installation steps for the J2EE Adapter Engine.

- **Configuring the SLD Data Supplier Service in the Visual Administrator [page 120]**
  This section describes how you can configure the SLD Data Supplier Service in the Visual Administrator.

- **Configuring the Gateway Service of the Central Integration Server [page 121]**
  On the J2EE Adapter Engine host, you need to enter the gateway service of the central integration server in the `services` file as described in this section.

- **Adding Connection Parameters to Central Exchange Profile [page 122]**
  This section describes how you can add connection parameters to the central exchange profile.

6.14.1  Configuring the SLD Data Supplier Service in the Visual Administrator

This section describes how you can configure the SLD Data Supplier Service in the Visual Administrator.

**Procedure**

2. Choose `Cluster ➤ Server ➤ Services ➤ SLD Data Supplier`.
3. On the `Runtime` tab in the right frame, select the `HTTP Settings` tab.
4. Enter the data required for the HTTP connection from the SLD service to the SLD as follows:
   - **Host**: Enter the name of the host on which the SLD bridge runs.
   - **Port**: Specify the HTTP standard access port of the SLD. This is the HTTP port of the J2EE engine. The following naming convention applies: `5<Java_instance_number>00`.
   - **User**: Specify a Java user that already exists on the host on which the SLD Bridge runs (`PISUPER`, for example).
   - **Password**: Enter the user password.

   If you want to use HTTPS for the connection from the SLD service to the SLD, choose `Use HTTPS`. The `Trust Store` field is now ready for input.
5. Save your entries.

An error message appears if an error occurs. If your entries have been saved successfully, the connection data is saved in encrypted form in the secure store in the database.

6. If you want to test your settings by sending test data to the SLD, click the blue arrow with the quick info text `Trigger data transfer to System Landscape Directory`.

7. To apply the new configuration immediately, restart the SLD service as follows:
   a. On the Cluster tab, choose `SLD Data Supplier` with the secondary mouse button.
   b. Choose `Stop`.
   c. When the service has been stopped, again choose `SLD Data Supplier` with the secondary mouse button and choose `Start`.

   The service starts within a few seconds and the first data transfer to the SLD takes place after several minutes.

6.14.2 Configuring the Gateway Service of the Central Integration Server

On the J2EE Adapter Engine host, you need to enter the gateway service of the central integration server in the `services` file as described in this section.

Procedure

1. Open the `services` file using a text editor.

   You can find the file in the directory
   ```
   <drive>:\WINNT\system32\drivers\etc\ 
   ```

2. Enter the gateway service entry as follows:

   ```
   sapgw<xx> <port>/tcp #SAP System Gateway Port
   ```

   where `<xx>` is the instance number of SAP NetWeaver on which usage type PI is running and `<port>` is the gateway port of SAP NetWeaver.
6.14.3 Adding Connection Parameters to Central Exchange Profile

This section describes how you can add connection parameters to the central exchange profile.

Procedure

1. On the noncentral J2EE Adapter Engine server, enter the following URL in a browser:
   
   http://<AE_server>:<AE_HTTP_Port>/exchangeProfile

2. Choose Connections.

3. Enter the respective values.

   \[ Note \]
   
   If you do not know the values, call the Exchange Profile on the PI server at http://<PI_server>:<HTTP_Port>/exchangeProfile and choose Connections. You can find the values up there.

4. Under Exchange ProfileConnections, check the existence of the parameter com.sap.aii.connect.integrationserver.sld.name. If it exists, make sure that it points to the PI server. If required, adapt it manually as follows:

   is.<PI_server_instance_number>.<PI_server_hostname>

5. Restart the application com.sap.aii.af.cpa.app in the Visual Administrator or reboot the J2EE Engine.

Results

You now find the noncentral J2EE Adapter Engine in the System Landscape Directory (SLD) and under the node Non-central Adapter Engines in the Runtime Workbench of the PI server.
6.15 Post-Installation Steps for the PCK (Optional Standalone Unit)

You must perform the following steps on the central instance host on which you have installed the Partner Connectivity Kit (PCK).

**Note**

You need an SAP NetWeaver AS Java system with release 7.0 EHP 1 or higher and usage type Process Integration (PI) to connect to.

**Configuring the PCK** [page 123]

After the installation you have to configure the PCK by performing the following steps.

**Starting the PCK** [page 124]

This section describes how to start the PCK.

**Changing Passwords for User Management (UME)** [page 124]

After installation you need to log on to the UME and change the passwords for users *pckuser* and *pckreceiver*.

### 6.15.1 Configuring the PCK

After the installation you have to configure the PCK by performing the following steps.

**Procedure**

1. Configure the *aii.properties*.
   
   For more information, see SAP Note 746328.

2. Change the properties of the J2EE Service *SAP NetWeaver XI AF CPA Cache Service*.
   
   For more information, see SAP Note 746328.

3. Assign the required user roles.
   
   For more information, see SAP Note 746328.

4. Change the properties of the J2EE Service *SAP NetWeaver XI AF Core Service*.
   
   For more information, see SAP Note 1156008.
6.15.2 Starting the PCK

This section describes how to start the PCK.

Procedure

1. On your PCK host, enter the following URL in your Web browser:
   
   \[ http://<\text{PCK\_host}>:\<\text{J2EE\_port}>/pck/start \]

   where \(<\text{PCK\_host}>\) is the host name on which you installed the PCK and \(<\text{J2EE\_port}>\) is the HTTP port of the SAP J2EE engine with the following naming convention: \(5<\text{J2EE\_instance\_number}>00\) (for example 50000 if your J2EE instance is 00).

2. Starting the PCK GUI on a Client:

   To start the PCK GUI on a client, the Java™ Web Start 1.4.2 must be installed on that client. For more information on how to install and configure Java™ Web Start 1.4.2, choose Client Installation Guidelines on the PCK start page.

   To start the PCK GUI, choose PCK on the PCK start page.

   If you start the PCK GUI for the first time on the client, the software packages are prepared for download to the client. After a few moments (depending on the hardware of your J2EE host) you may use the same link again to launch the PCK UI.

6.15.3 Changing Passwords for User Management (UME)

After installation you need to log on to the UME and change the passwords for users pckuser and pckreceiver.

Procedure

1. On your PCK host, log on to User Management by entering the following URL in your Internet browser:
   
   \[ http://<\text{host}>:\<\text{HTTP\_port}>/useradmin \]

2. With your first logon, you are prompted to change the passwords for users pckuser and pckreceiver.
6.16 Performing Oracle-Specific Post-Installation Steps

You have to perform the following Oracle-specific post-installation steps:

**Procedure**

- **Checking the Recommended Oracle Database Parameters**
  
  When installing the Oracle database, a standard database parameter set is used. To take into account the size and configuration of your SAP system and to enable new Oracle features, check and apply the parameter settings as described in SAP Note 830576 (Oracle 10g), SAP Note 1431798 (Oracle 11g) or SAP Note 1888485 (Oracle 12c).

  You can find an automated script in SAP Note 1171650 to help you check whether your SAP system complies with the database parameter recommendations at any given point in time.

- **Configuring Database User Profiles**
  
  If the SAP-specific database user profile SAPUPROF is not yet installed in the database, configure it as described in SAP Note 1519872.

- **Updating Oracle Optimizer Statistics**
  
  To update the Oracle optimizer statistics, do the following:

  a. Execute the following commands as the `<dbsid>adm` user:

     ```bash
     brconnect -u / -c -f stats -t system_stats;
     brconnect -u / -c -f stats -t oradict_stats;
     ```

  b. Execute the following commands with SQLPlus:

     ```sql
     SQL> exec dbms_scheduler.disable('GATHER_STATS_JOB');
     SQL> exec dbms_scheduler.disable('ORACLE_OCM.MGMT_CONFIG_JOB');
     SQL> exec dbms_scheduler.disable('ORACLE_OCM.MGMT_STATS_CONFIG_JOB');
     
     For Oracle 11g, also execute the following command:

     ```sql
     SQL> exec DBMS_AUTO_TASK_ADMIN.DISABLE
     ```

     For more information, see SAP Note 974781.

- **Configuring and Operating the Oracle Database**
  
  You have to configure your Oracle database before you start operating it with the SAP system.

  For more information about Oracle database configuration and administration, see:


- **Installing the Latest Version of BR*Tools for Oracle 12c**
Follow the instructions in SAP Note 2087004 to install the most recent version of BR*Tools for Oracle 12c.

### 6.17 Performing a Full System Backup

You must perform a full system backup after the configuration of your SAP system. If required, you can also perform a full system backup after the installation (recommended). In addition, we recommend you to regularly back up your database.

**Prerequisites**

- You are logged on as user `<sapsid>adm`.
- You have shut down the SAP system and database.

**Procedure**

For more information about backing up your SAP system on Windows, see:

<table>
<thead>
<tr>
<th>Release</th>
<th>SAP Library Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.0</td>
<td>–</td>
</tr>
</tbody>
</table>
When backing up your Oracle database, note the following:

- You must configure your third-party backup tool, if used, for the database backup.
- If you use BR*TOOLS for the database backup, see:

7 Additional Information

The following sections provide additional information about optional preparation, installation, and post-installation tasks.

There is also a section describing how to delete an SAP system.

7.1 SAP Directories

This section describes the directories that are available in an SAP system.

Only valid for 'High Availability': HA (Windows)

If you want to install a high-availability system, see also Directories in a Microsoft Failover Environment [page 193].

End of 'High Availability': HA (Windows)

The installer automatically creates the following directories during the installation:

- \usr\sap
  This directory is created on the:
  - Global host and shared with the network share sapmnt.

Only valid for 'High Availability': non-HA

In a non-high-availability-system, you can install the central instance or the (A)SCS instance on the global host or on any other host.

End of 'High Availability': non-HA

Only valid for 'High Availability': HA (Windows)

In a high-availability system, the SCS instance is installed on the global host.

End of 'High Availability': HA (Windows)

On global hosts, the \usr\sap directory contains general SAP software, global, and local (instance-specific) data. For this, The installer creates the global directory \usr\sap\<SAPSID>\SYS, which physically exists only once for each SAP system. It consists of the following subdirectories:

- global – contains globally shared data
- profile – contains the profiles for all instances
- exe – contains the executable replication directory for all instances and platforms

Only valid for 'High Availability': HA (Windows)

In a high availability system, this directory is located on a local disk. You have at least two disk drives with a \usr\sap directory structure.

End of 'High Availability': HA (Windows)

On local hosts, the \usr\sap\<SAPSID>\<Instance_Name> directory contains copies of the SAP software and local (instance-specific) data.
Since SAP traces for the instance are created in `\usr\sap`, make sure that there is sufficient space available in this directory. Changes in SAP profiles can also affect the disk space.

The executables on the local host are replicated from those on the global host every time the local instance is started. The SAP copy program `sapcpe` compares the binaries in the `<Platform>` directory on the global host and the binaries in the `exe` directory on the application server. If the binaries in the `exe` directory are older than those in the `<Platform>` directory, `sapcpe` replaces them with the newer version of the global host.

Other application servers access the global data using the Universal Naming Convention (UNC) path `\<SAPGLOBALHOST>\sapmnt`. The SAP programs access their instance-specific data with the UNC path `\<SAPLOCALHOST>\saploc`. If the UNC path points to a local directory, the local path (and not the UNC path) is used to access the directory.

The parameters `SAPGLOBALHOST` and `SAPLOCALHOST` have the same values on the global host.

Only valid for `High Availability`: HA (Windows)

Windows Server 2008 (R2) and higher:

In a high-availability system, file shares that are pointing to directories on shared disks are only visible or can be accessed with the virtual host name of the cluster group the shared disks belong to.

This lets you have several shares with the same name pointing to different disks (multi-SID).

Directory Structure

The transport directory contains SAP software for the transport of objects between SAP systems. The installer by default creates it on the `SAPGLOBALHOST`.

If you want to have it created on another host or if you want to use an existing transport host from your SAP system landscape, you can specify another host during the installation. In this case, you have to prepare that host for the new SAP system to use it. For more information, see Preparing the SAP System Transport Host [page 56].

There are the following instance names available in an SAP system:

Central services instance: `SCS<Instance_Number>`
Only valid for “High Availability”: HA (Windows)

**High Availability only**: Enqueue Replication Server instance: ERS<Instance_Number>

End of “High Availability”: HA (Windows)

Central instance: JC<Instance_Number>

Dialog instance: J<Instance_Number>.

---

**Note**

Every new installation of an SAP system is Unicode.

---

![Diagram of Directory Structure on the Global Host in a Central Java System](image)

Figure 6: Directory Structure on the Global Host in a Central Java System
7.2 Integration of LDAP Directory Services

This section explains the benefits of using the SAP system with the Lightweight Directory Access Protocol (LDAP) directory and gives an overview of the configuration steps required to use an SAP system with the directory.

LDAP defines a standard protocol for accessing directory services, which is supported by various directory products such as Microsoft Active Directory, and OpenLDAP `slapd`. Using directory services enables important information in a corporate network to be stored centrally on a server. The advantage of storing information centrally for the entire network is that you only have to maintain data once, which avoids redundancy and inconsistency.
If an LDAP directory is available in your corporate network, you can configure the SAP system to use this feature. For example, a correctly configured SAP system can read information from the directory and also store information there.

**Note**

The SAP system can interact with the Active Directory using the LDAP protocol, which defines:

- The communication protocol between the SAP system and the directory
- How data in the directory is structured, accessed, or modified

If a directory other than the Active Directory also supports the LDAP protocol, the SAP system can take advantage of the information stored there. For example, if there is an LDAP directory on a UNIX or Windows server, you can configure the SAP system to use the information available there. In the following text, directories other than the Active Directory that implement the LDAP protocol are called **generic LDAP directories**.

**Prerequisites**

You can only configure the SAP system for Active Directory services or other LDAP directories if these are already available on the network. As of Windows 2000 or higher, the Active Directory is automatically available on all domain controllers. A generic LDAP directory is an additional component that you have to install separately on a UNIX or Windows server.

**Features**

In the SAP environment, you can exploit the information stored in an Active Directory or generic LDAP directory by using:

- SAP Logon
- The SAP Microsoft Management Console (SAP MMC)
  
  For more information about the automatic registration of SAP components in LDAP directories and the benefits of using it in SAP Logon and SAP MMC, see the documentation [SAP System Information in Directory Services](https://archive.sap.com/documents/docs/DOC-14384) at:

- The SAP Management Console (SAP MC)

**SAP Logon**

Instead of using a fixed list of systems and message servers, you can configure the SAP Logon in the `sapmsg.ini` configuration file to find SAP systems and their message servers from the directory. If you configure SAP logon to use the LDAP directory, it queries the directory each time Server or Group selection is chosen to fetch up-to-date information on available SAP systems.

To use LDAP operation mode, check that the `sapmsg.ini` file contains the following:

```ini
[Address]
Mode=LDAPdirectory
```
LDAPserver=
LDAPnode=
LDAPoptions=

Distinguish the following cases:

- If you use an Active Directory, you must set `LDAPoptions="DirType=NT5ADS"`. For more information, see the SAP system profile parameter `ldap/options`.
- You must specify the directory servers (for example, `LDAPserver=pcintel6 p24709`) if one of the following is true:
  - The client is not located in the same domain forest as the Active Directory
  - The operating system does not have a directory service client (Windows NT and Windows 9X without installed `dsclient`).
  
  For more information, see the SAP system profile parameter `ldap/servers`.
- For other directory services, you can use `LDAPnode` to specify the distinguished name of the SAP root node. For more information, see the SAP system profile parameter `ldap/saproot`.

**SAP MMC**

The SAP MMC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. It is automatically set up when you install an SAP system on Windows. If the SAP system has been prepared correctly, the SAP MMC presents and analyzes system information that it gathers from various sources, including the Active Directory.

Integrating the Active Directory as a source of information has advantages for the SAP MMC. It can read system information straight from the directory that automatically registers changes to the system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MMC.

If you need to administer distributed systems, we especially recommend that you use the SAP MMC together with Active Directory services. You can keep track of significant events in all of the systems from a single SAP MMC interface. You do not need to manually register changes in the system configuration. Instead, such changes are automatically updated in the directory and subsequently reflected in the SAP MMC.

If your SAP system is part of a heterogeneous SAP system landscape that comprises systems or instances both on UNIX and Windows operating systems, you can also use the SAP MMC for operating and monitoring the instances running on UNIX.

**SAP MC**

You can also use the SAP Management Console (SAP MC) for administering and monitoring SAP systems from a central location.
For more information about the SAP MC and about how to configure it to access LDAP directories, see the documentation *SAP Management Console* at the following locations:

**Table 31:**

<table>
<thead>
<tr>
<th>Release</th>
<th>Path in SAP Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.0 including enhancement package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.0 including enhancement package 2</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.0 including enhancement package 3</td>
<td><a href="http://help.sap.com/nw703">http://help.sap.com/nw703</a> LCDirectories &gt; Application Help &gt; SAP NetWeaver by Key Capability &gt; Solution Life Cycle Management by Key Capability &gt; SAP Management Console</td>
</tr>
</tbody>
</table>

**Configuration Tasks for LDAP Directories**

This section describes the configuration tasks for the Active Directory or other (generic) LDAP directories.

**Configuration Tasks for Active Directory**

To enable an SAP system to use the features offered by the Active Directory, you have to configure the Active Directory so that it can store SAP system data.

To prepare the directory, you use the installer to automatically:

- Extend the Active Directory schema to include the SAP-specific data types
- Create the domain accounts required to enable the SAP system to access and modify the Active Directory. These are the group `SAP_LDAP` and the user `sapldap`.
- Create the root container where information related to SAP is stored
- Control access to the container for SAP data by giving members of the `SAP_LDAP` group permission to read and write to the directory

You do this by running the installer and choosing `<Product> > Software Life-Cycle Options > LDAP Registration > Active Directory Configuration`.

**Note**

You have to configure the directory server only once. Then all SAP systems that need to register in this directory server can use this setup.

**Configuration Tasks for Generic LDAP Directories**

To configure other LDAP directories, refer to the documentation of your directory vendor. The installer software contains schema extensions for directory servers Netscape/iPlanet (`ldregns4.txt`, `ldregns5.txt`) and OpenLDAP slapd (`ldregslapd.schema`). Both files are located in the directory `<Unpack_Directory>\COMMON\ADS`. After you have applied the schema extension, you need to create a
root container to store the SAP-related information and create a directory user that the SAP application server can use to write information to the directory.

For more information about how to set up a Netscape/iPlanet directory server, see the documentation SAP System Information in Directory Services at:

Enabling the SAP System LDAP Registration

Once you have correctly configured your directory server, you can enable the LDAP registration of the SAP system by setting some profile parameters in the default profile.

To do this, run the installer once for your system and choose Software Life-Cycle Options > LDAP Registration > LDAP Support. If you use a directory server other than Microsoft Active Directory and/or non-Windows application servers, you have to store the directory user and password information by using ldappasswd pf=<Instance_Profile>. The information is encrypted for storage in DIR_GLOBAL and is therefore valid for all application servers. After restarting all application servers and start services, the system is registered in your directory server. The registration protocols of the components are dev_ldap*. The registration is updated every time a component starts.

7.3 Performing a Domain Installation Without Being a Domain Administrator

Use

You normally perform a domain installation of the SAP system with a user who is a member of the domain Admins group, as described in Required User Authorization for Running the Installer [page 54]. If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. In this case, the domain administrator has to prepare the system appropriately for you. The domain administrator can perform the following steps either using the installer or manually:

1. Create the new global group SAP_<SAPSID>_GlobalAdmin.
2. Create the two new SAP system users <sapsid>adm and SAPService<SAPSID>.
3. Add the users <sapsid>adm and SAPService<SAPSID> to the newly created group SAP_<SAPSID>_GlobalAdmin.

i Note

The installer creates the operating system user for the SAP Host Agent by default as a local user that is not a member of the local Administrators group. If you want to create this user manually as a domain user, you must perform the following steps:

1. Create the new global group SAP_SAP_GlobalAdmin.
2. Create the SAP system user sapadm.
3. Add the user sapadm to the newly created group SAP_SAP_GlobalAdmin.

However, for security reasons we strongly recommend you to create this users as a local user.

Prerequisites

- You must be domain administrator to perform the required steps.
- Windows Server 2008 (R2), Windows Server 2012 (R2), and higher:
  You must have installed the feature *Remote Server Administration Tools* as follows:
  - Windows Server 2012 (R2) and higher:
    - Open PowerShell in elevated mode, and enter the following command:
      `add-windowsfeature RSAT-ADDS`
  - Windows Server 2008 (R2):
    1. Choose *Start ➔ Administrative Tools ➔ Server Manager*.
    2. In the *Server Manager* window, select *Features*.

Procedure

Creating the Required Users and Groups Using the Installer

On the host where the SAP system is to be installed, the domain administrator runs the installer [page 85], and chooses *<Product> ➔ Software Life-Cycle Options ➔ Additional Preparation Options ➔ Operating System Users and Groups* to have the group and users created automatically.

Creating the Required Users and Groups Manually

**Note**

To create the users and groups specific to the SAP Host Agent, you must follow the procedure below, and replace the users and groups with those for the SAP Host Agent.

Creating the New Global Group SAP_<SAPSID>_GlobalAdmin

Perform the following steps:

- Windows Server 2012 (R2) and higher:
  - Open PowerShell in elevated mode, and enter the following command:
    `net group SAP_<SAPSID>_GlobalAdmin /add /domain`
- Windows Server 2008 (R2):
  1. Log on as domain administrator.
  2. Start the *Active Directory Users and Computers Console* by choosing:
     - *Start ➔ Control Panel ➔ Administrative Tools ➔ Active Directory Users and Computers*
3. Right-click **Users** in **Tree**, and choose ▶️ **New** ▶️ **Group** ▶️

4. Enter the following:
   - **Group name:** SAP_<SAPSID>_GlobalAdmin

5. Select the following:
   1. **Group scope:** Global
   2. **Group type:** Security

6. Choose **OK**.

**Creating the New SAP System Users <sapsid>adm and SAPService<SAPSID>**

Perform the following steps:

- **Windows Server 2012 (R2) and higher:**
  1. Open PowerShell in elevated mode.
  2. Create the `<sapsid>adm` user with the following command:
     ```
     net user <sapsid>adm <password> /add /domain
     ```
  3. Create the SAPService<SAPSID> user with the following command:
     ```
     net user SAPService<SAPSID> <password> /add /domain
     ```

- **Windows Server 2008 (R2):**
  1. In **Active Directory Users and Computers Console**, right-click **Users** in **Tree** and choose:
     - ▶️ **New** ▶️ **User** ▶️
  2. Enter the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input for &lt;sapsid&gt;adm</th>
<th>Input for SAPService&lt;SAPSID&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name:</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Initials:</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Last name:</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Full name:</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
<tr>
<td>User logon name:</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
<tr>
<td>Full name:</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAPSE&lt;SAPSID&gt;</td>
</tr>
<tr>
<td>User logon name:</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAPSE&lt;SAPSID&gt;</td>
</tr>
</tbody>
</table>

3. Choose **Next** and enter the following:
   - **Password:** <password>
   - **Confirm password:** <password>

   **Note**
   Make sure that the password of the users `<sapsid>adm` and `SAPSE<SAPSID>` are always the same. If these passwords are not equal you might have access issues in the service `SAP<SAPSID>_<Inst_No>` and the Windows instance will not start correctly.

4. Select **Password never expires**.
Note
Make sure that no other options are selected.

5. Choose Next Finish.

Adding the Manually Created Users to Groups

Note
To add the users specific to the SAP Host Agent to the relevant groups, you must follow the procedure below, and replace the users and groups with those for the SAP Host Agent.

Adding the <sapsid>adm User to the SAP_<SAPSID>_GlobalAdmin Group

- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  `net group SAP_<SAPSID>_GlobalAdmin <sapsid>adm /add /domain`

- Windows Server 2008 (R2):
  1. In the Users folder, double-click the newly created user account <sapsid>adm in the list on the right.
  2. Choose Member Add.
  3. Select the new SAP_<SAPSID>_GlobalAdmin group and choose Add to add it to the list.

  Note
  By default, the user is also a member of the Domain Users group.

  4. Choose OK twice.

Adding the SAPService<SAPSID> User to the SAP_<SAPSID>_GlobalAdmin Group

- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  `net group SAP_<SAPSID>_GlobalAdmin SAPService<SAPSID> /add /domain`

- Windows Server 2008 (R2):
  1. In the Users folder, double-click the newly created user account SAPService<SAPSID> in the list on the right.
  2. Choose Member Add.
  3. Select the new SAP_<SAPSID>_GlobalAdmin group.
  4. Choose Add to add it to the list, and then OK.
  5. Choose OK to close SAPService<SAPSID>Properties.
### 7.4 Checking and Changing the Paging File Settings on Windows Server 2012 (R2) and Higher

**Use**

This section describes how to check and change the paging file size on Windows Server 2012 (R2) and higher with PowerShell.

The PowerShell commands also work in previous Windows versions where PowerShell is available.

**Note**

Some paging file operations require a reboot of the server to activate the changes you made. Wmi-commands do not indicate whether a reboot is required or not. Therefore, we recommend rebooting your system every time you change the paging file settings with PowerShell.

**Prerequisites**

Always start the PowerShell in elevated mode (run as administrator).

**Procedure**

**Checking the Size of a Paging File**

2. Check whether the default value *Automatic manage pagefile size for all devices* is activated.

**Note**

We do not support automatically managed page file sizes.

To check this, enter the following command:

```powershell
(Get-WmiObject Win32_Pagefile) -eq $null
```

If *Automatic manage pagefile size for all devices* is enabled, the output value is *True*.

If necessary, disable *Automatic manage pagefile size for all devices* with the following command:

```powershell
$sys = Get-WmiObject Win32_Computersystem -EnableAllPrivileges
$sys.AutomaticManagedPagefile = $false
$sys.put()
```

3. Check the size of the paging files with the following command:

```powershell
Get-WmiObject WIN32_Pagefile | Select-Object Name, InitialSize, MaximumSize, FileSize
```

The output looks like the following:
In this example, in the first line, the **InitialSize** and **MaximumSize** values of a paging file are 0, which means that the paging file size is *system managed* (not recommended).

In the second line, the paging file size has a minimum and a maximum size (recommended).

### Changing the Size of a Single Paging File

Changing the **InitialSize** and **MaximumSize** values of a paging file to a size other than 0, will automatically switch off *system managed size*.

In the following example, we change the size of the paging file on **C:** to the **InitialSize** of 40 GB and to the **MaximumSize** of 80 GB.

Use the following commands in a PowerShell:

```powershell
$Pagefile = Get-WmiObject Win32_PagefileSetting | Where-Object {$_._name -eq "C:\pagefile.sys"}
$Pagefile.InitialSize = 40000
$Pagefile.MaximumSize = 80000
$Pagefile.put()
```

Typically, you choose the same value for **InitialSize** and **MaximumSize**.

### Note

The sum of all paging files **InitialSize** values must be equal to or higher than the value recommended for your SAP system.

### Creating a Second Paging File on Another Disk

You might want to create a second or additional paging files to improve system performance, or if your disk does not have enough space.

To do so, enter the following commands in a PowerShell:

```powershell
$Pagefile = Get-WmiObject Win32_PagefileSetting
$pagefile.Name = “E:\pagefile.sys”
$pagefile.Caption = “E:\pagefile.sys”
$pagefile.Description = “’pagefile.sys’ @ E:\”
$pagefile.SettingID =”pagefile.sys @ E:”
$pagefile.InitialSize = 80000
$pagefile.MaximumSize = 80000
$pagefile.put()
```
Deleting a Paging File on a Specific Device

To delete a paging file, enter the following commands in a PowerShell:

```powershell
$pagefile = Get-WmiObject Win32_PagefileSetting | Where-Object {$_ Name -eq "E:\pagefile.sys"}
$pagefile.delete()
```

7.5 Installation of Multiple Components in One Database

You can install **multiple** SAP systems in a **single** database. This is called Multiple Components in One Database (MCOD).

**Recommendation**

MCOD is generally available and there is no intention to de-support this installation feature. However, SAP recommends that customers should **not** use the MCOD feature when installing new systems.

The major drawbacks are as follows:

- Previous-point-in-time (PPT) recovery of a single system within an MCOD installation becomes a highly complex and time-consuming procedure.
- SAP Landscape Management (LaMa) is generally not supported for MCOD installations. For more information, see SAP Note [1709155](https://support.sap.com).
- There are strong dependencies, for example on the database version used for the MCOD system.
- Downtime - planned or unplanned - always affects all systems sharing the same database.

**Exception:** In case of a dual-stack split you can use the “Keep Database” option thus keeping ABAP and Java stack in one database. There, the PPT recovery problem does not apply because both stacks belong logically together and would always be recovered jointly anyhow. However, keep in mind that even for this specific case the introduction of SAP Landscape Management would require a split into separate database subsystems.

Additional information might be available in SAP Note [2146542](https://support.sap.com).

MCOD is available with all SAP components and all the major databases for the SAP system. No extra effort is required because the MCOD installation is fully integrated into the standard installation procedure. MCOD is not an additional installation option. Instead, it is an option of the database instance installation.

With MCOD we distinguish two scenarios:

- The installation of an SAP system in a new database
  The system then creates new tablespaces and a new database schema.
- The installation of an additional SAP system in an existing database (MCOD)
  The system then automatically creates additional tablespaces in the existing database and a schema user in the existing database.
Prerequisites

- For more information about MCOD and its availability on different platforms, see Multiple Components in One Database (MCOD) at: https://wiki.scn.sap.com/wiki/pages/viewpage.action?pageId=448466580.
- Since SAP does not support mixed solutions with MCOD, your SAP system must contain Unicode SAP instances only.
- Improved sizing required
  
You calculate the CPU usage for an MCOD database by adding up the CPU usage for each individual SAP system. You can do the same for memory resources and disk space.

You can size multiple components in one database by sizing each individual component using the Quick Sizer tool and then adding the requirements together. For more information about the Quick Sizer, see http://sap.com/sizing.

Features

- Reduced administration effort
- Consistent system landscape for backup, system copy, administration, and recovery
- Increased security and reduced database failure for multiple SAP systems due to monitoring and administration of only one database
- Independent upgrade
  
In an MCOD landscape, you can upgrade a single component independently from the other components running in the same database, assuming that the upgraded component runs on the same database version. However, if you need to restore a backup, be aware that all other components are also affected.

Note

Special MCOD considerations and differences from the standard procedure are listed where relevant in the installation documentation.

Constraints

- We strongly recommend that you test MCOD in a test or development system. We recommend that you run MCOD systems in the same context. We do not recommend that you mix test, development, and production systems in the same MCOD.
- In the event of database failure, all SAP systems running on the single database are affected.
- Automated support in an MCOD landscape for the following administrative tasks depends on your operating system and database:
  - Copying a single component from an MCOD landscape to another database at database level.
  - Uninstalling a single component from an MCOD landscape requires some additional steps. You can use a remote connection to SAP support to request help with these tasks. For more information, see http://support.sap.com/remoteconnection.
You cannot install multiple components in one database with Microsoft Failover Clustering. For more information, see High Availability with Microsoft Failover Clustering [page 179].

For the second SAP system, you must use the same <DBSID> as for the first SAP system.

If you install an MCOD system, the SYSTEM tablespace must contain at least 400 MB of free space. If there is not enough space left, increase the size of this tablespace with BRSPACE or BRTOOLS.

If you decide to turn off archive log mode during the database load phase of the installation, you need to plan downtime for all MCOD systems sharing the database.

7.6 Preparing an External ABAP System as Source for User Data

You can use an external ABAP system as the data source for user data for the AS Java of your SAP Java system to be installed. To do this, you configure the User Management Engine (UME) of the J2EE engine for the user management of the external ABAP system.

Prerequisites

The ABAP system is based on at least SAP Web AS ABAP release 6.20 SP25.

Context

If you want to install the J2EE Adapter Engine as an optional standalone unit, you have to configure the User Management Engine (UME) for the ABAP UME of the SAP NetWeaver Process Integration (PI) system.

If you want to connect more than one Java system to the same ABAP system, you need to work out a concept for the communication, administrator, and guest users for each engine.

You can take one of the following approaches:

Table 33:

<table>
<thead>
<tr>
<th>Approach</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each Java system uses different users</td>
<td>No interdependencies between the connected engines</td>
<td>Initially more administration to create the users in the ABAP system</td>
</tr>
<tr>
<td>Approach</td>
<td>Advantages</td>
<td>Disadvantages</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>All Java systems use the same configuration</td>
<td>You create the users only once and enter the same information for every Java system that you install.</td>
<td>Interdependencies between the connected engines:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● If you change the password of any of the users on the ABAP system, this change affects all connected engines.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● If you change the administrator user’s password, you must also change the password in secure storage on all of the connected J2EE Engines</td>
</tr>
</tbody>
</table>

The procedures below assume that you are using the **first** approach.

**Recommendation**

For security reasons, we recommend the first approach.

**More Information**

- For more information about UME, see:
- For more information about creating users and roles in an ABAP system, see:
  - Application Help > SAP NetWeaver by Key Capability > Security > Identity Management > User and Role Administration of Application Server ABAP
- For more information about SLD users and security roles, see the [Post-Installation Guide - SLD of SAP NetWeaver 7.0](https://wiki.scn.sap.com/wiki/display/SL/System+Landscape+Directory+%28SL%29+-+Overview).

**Procedure**

- The following procedures describe the activities you have to perform in the existing ABAP system and for the Java system to be installed.
- Perform the following steps in the existing ABAP system:
  a. Call transaction PFCG to do the following:
    - Check that the roles SAP_BC_JSF_COMMUNICATION and SAP_BC_JSF_COMMUNICATION_RO exist and make sure that their profiles are generated.
    - Check that the roles SAP_J2EE_ADMIN, SAP_J2EE_GUEST, and SAP_BC_FP_ICF exist. Neither role contains any ABAP permissions, so you do not need to generate any profiles.
If you want to use Adobe Document Services (ADS), do the following:

- Check that the role SAP_BC_FPADS_ICF exists.
- Create a role named ADSCallers. You do not need to maintain authorization data or generate any profiles for this role.

If you want to install the system with a local System Landscape Directory, check that the following roles exist and make sure that their profiles are generated:

- SAP_SLD_CONFIGURATOR
- SAP_SLD_ADMINISTRATOR
- SAP_SLD_DEVELOPER
- SAP_SLD_GUEST
- SAP_SLD_ORGANIZER

b. Call transaction SU01 to do the following:

- Create a new communication user and assign it to the role SAP_BC_JSF_COMMUNICATION_RO. We recommend that you do the following:
  - Name this user SAPJSF. You can use any password.
  - Assign this user the role SAP_BC_JSF_COMMUNICATION_RO for read-only (display) access to user data with Java tools. If you intend to maintain user data (that is, to change, create, or delete users) with Java tools, you need to assign the role SAP_BC_JSF_COMMUNICATION instead.
  - Assign this user the type Communications under Logon data to make sure that it can only be used for communication connections between systems and not as a dialog user.
- Create a new administrator user for the J2EE engine and assign it to role SAP_J2EE_ADMIN. We recommend that you name this user J2EE_ADMIN_<SAPSID_Java_System>. You can use any password.
- Create a new guest user for the J2EE engine and assign it to role SAP_J2EE_GUEST. We recommend that you name this user J2EE_GUEST_<SAPSID_Java_System>. You can use any password.
  Since this user is only used for anonymous access to the system, we recommend you to deactivate the password and, if required, lock it after installation to prevent anyone from using it for explicit named logons.
- If you want to use Adobe Document Services (ADS), do the following:
  - Create a user ADSUSER for basic authentication and assign this user the role ADSCallers. You can use any password.
  - Create a user ADS_AGENT and assign this user the role SAP_BC_FPADS_ICF. You can use any password.
- If you want to install the system with a local System Landscape Directory, do the following:
  1. Create an SLD Data supplier user. We recommend that you name this user SLDDSUSER. You can use any password.
  2. Assign this user the following roles:
     - SAP_SLD_CONFIGURATOR
     - SAP_SLD_ADMINISTRATOR
     - SAP_SLD_DEVELOPER
     - SAP_SLD_GUEST
     - SAP_SLD_ORGANIZER
If you want to install Development Infrastructure (DI), create the following users:

- **NWDI_ADM**
  You do not need to assign a role and you can use any password.

- **NWDI_DEV**
  You do not need to assign a role and you can use any password.

- **NWDI_CMSADM**
  You do not need to assign a role and you can use any password.

c. Make sure that you change the initial passwords of these users and take the precautions described in the relevant SAP security guide before you start the installation of the Java system. You can find the security guide in the Security section of the product page for your SAP product at https://help.sap.com/.

- Perform the following steps in the Java System:
  a. **Before** the installation of the Java system, make sure that you have the correct user names and passwords of the users listed above for the separate ABAP system.
  b. **During** the installation of the Java system, make sure that you enter the correct users and passwords in the corresponding installer dialogs.

### 7.7 Dialog Instance Installation for an Upgraded System only: Updating Profiles

You only need to perform these steps if you want to install a dialog instance and you have already performed the steps listed under “Prerequisites” in this section.

#### Prerequisites

1. You upgraded your SAP system from an earlier source release as follows:
   - You upgraded your SAP NetWeaver system from an earlier source release to a target release lower than SAP NetWeaver 7.0 SR3.
   - You upgraded your SAP ERP system from an earlier source release to a target release lower than SAP ERP 6.0 SR3.
   - You upgraded your SAP CRM system from an earlier source release to a target release lower than SAP CRM 5.0 SR3.
   - You upgraded your SAP SCM system from an earlier source release to a target release lower than SAP SCM 5.0 SR3.
   - You upgraded your SAP SRM system from an earlier source release to a target release lower than SAP SRM 5.0 SR3.

2. You installed the current Enhancement Package.
Procedure

1. On the SAP Global host, go to folder \usr\sap\<SAPSID>/profile.

   **Note**

   SAP system profiles are named as follows:
   
   Instance profiles: <SAPSID>_<INSTANCE_ID>_<Host_Name>.pfl
   
   Start profiles: START_<INSTANCE_ID>_<Host_Name>.pfl

2. Make sure that the parameter DIR_CT_RUN, if set, has identical values in the instance profile and the start profile of the central instance:
   - If it is set in the instance profile, it must also be set in the start profile.
   - If it is not set in the instance profile, it must not be set in the start profile either.

3. Change the default profile DEFAULT.PFL by setting rdisp/msserv_internal to a free port number.

   **Example**

   DEFAULT.PFL

   **Before the change:**

   ...
   
   rdisp/msserv = sapms<SAPSID>
   
   ...
   
   **After the change:**

   ...
   
   rdisp/msserv = sapms<SAPSID>
   
   rdisp/msserv_internal = <Free_Port_Number>
   
   ...

4. Change the instance profile of the central services instance for Java (SCS instance) as follows:
   a. Set rdisp/msserv to 0.
   b. Set rdisp/msserv_internal to the port number assigned to rdisp/msserv.

   **Example**

   Instance profile of the SCS instance:

   **Before the change:**

   ...
   
   rdisp/msserv = 4711
   
   ...
   
   **After the change:**
5. Restart all SAP services and instances of your SAP system.

7.8 Implementing Oracle Database Vault with the Installer

The installer supports Oracle Database Vault. This section provides information about implementing Oracle Database Vault (DV) with the installer.

**Caution**
Although Oracle Database Vault is already available in the installer and documented in this guide, it is not yet released to customers until further notice. For more information, see the *Current Restrictions* section in SAP Note 1680045.

**Prerequisites**

- Your Oracle database version must be 12.1 or higher.
- Check the prerequisites, restrictions, and patch requirements as listed in SAP Note 2218115.

**Context**

For a new system installation, the installer prompts whether DV is to be installed.

DV requires the following additional users:

- `secadmin`
- `secacctmgr`

These users are created by the installer.

For more information about Oracle Database Vault, see the Oracle Database documentation referred to in SAP Note 2218115.
Procedure

1. Start the installer and choose the installation option for your system variant as described in Running the Installer [page 85].
2. On the Oracle Database screen where you are prompted to enter the required Oracle database parameters, mark the Install Oracle Database Vault checkbox.
3. On the Database Accounts for Oracle Database Vault screen, specify the following:
   ○ Provide the passwords for the Oracle Database Vault user accounts secadmin and secacctmgr which are to be created by the installer.
   ○ If you want to be enabled after the installation has completed, mark the Enable Oracle Database Vault checkbox.

Next Steps

Configure Oracle Database Vault as described in SAP Note 2218115.

7.9 Installation of Additional Usage Types or Software Units in an Existing SAP System

You can install additional usage types or software units in an existing Java system using Software Update Manager (SUM).

The procedure how to do this is described in the documentation Update of SAP Systems Using Software Update Manager 1.0 SP<Current_Number>, which is available at: http://support.sap.com/sitoolset

    System Maintenance ➤ Software Update Manager (SUM) SP<Current_Number> ➤ Guides for SUM 1.0 SP<Current_Number>
7.10 Installing the SAP Host Agent Separately

This procedure tells you how to install an SAP Host Agent separately.

Context

The SAP Host Agent is installed automatically during the installation of new SAP instances with SAP kernel 7.20 or higher (integrated installation). This procedure is only for hosts with no SAP Host Agent running on them, due to the following reasons:

● There is no SAP system or instance on the host.
● The SAP system or instance running on the host has a kernel release lower than SAP kernel 7.20 and the host does not yet have an SAP Host Agent.
● You have upgraded your SAP system to a release with a kernel release lower than SAP kernel 7.20 and the host of the upgraded system or instance does not yet have an SAP Host Agent.

SAP Host Agent has the following executable programs and services:

● The SAPHostExec service
● The sapstartsrv service SAPHostControl
● The operating system collector saposcol

Note

The installed programs are automatically started when the host is booted.

On Microsoft Windows hosts, the services SAPHostControl and SAPHostExec automatically start the installed programs.

The following procedure describes the steps you have to perform on the host where you install the SAP Host Agent separately.

Procedure

1. You check the hardware and software requirements [page 21] on the installation host.
2. You perform basic preparations on Windows [page 52].
3. You check that you have the required user authorization for running the Installer [page 54].
4. Make the unpacked Software Provisioning Manager 1.0 archive available on the installation host as described in Downloading and Extracting the Software Provisioning Manager Archive [page 58].
5. Make the medium for the UC kernel available on the installation host.

Use folder K_<Version>_U_<OS>), where “_U_” means Unicode.

You can either use the physical kernel medium from the installation package of your SAP system, or download the kernel medium from https://launchpad.support.sap.com/#/softwarecenter (see Downloading Installation Media [page 61]).
6. You run the installer [page 85] to install the SAP Host Agent.
   On the Welcome screen, choose [Product] Software Life-Cycle Options > Additional Preparation Options > Host Agent.

7. Check whether the installed services are available as follows:
   a. Log on as user sapadm.
   b. Check whether the following services are available:
      ○ The control program saphostexec
      ○ The operating system collector saposcol.
      ○ The SAP NetWeaver Management agent SAPHostControl (sapstartsrv in host mode)

   **Note**
   The installed programs are automatically started when the host is booted.
   This is done by the services SAPHostControl and SAPHostExec.

### Next Steps

For more information about the SAP Host Agent, see the SAP Library at:

<table>
<thead>
<tr>
<th>Release</th>
<th>SAP Library Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>● SAP NetWeaver 7.0</td>
<td><a href="http://help.sap.com/nw70">http://help.sap.com/nw70</a> SAP NetWeaver 7.0</td>
</tr>
<tr>
<td>● SAP NetWeaver 7.0 including enhancement package 1</td>
<td><a href="http://help.sap.com/nw70">http://help.sap.com/nw70</a> SAP NetWeaver by Key Capability Solution Life Cycle Management by Key Capability SAP Host Agent</td>
</tr>
<tr>
<td>● SAP NetWeaver 7.0 including enhancement package 3</td>
<td><a href="http://help.sap.com/nw70">http://help.sap.com/nw70</a> SAP NetWeaver by Key Capability Solution Life Cycle Management by Key Capability SAP Host Agent</td>
</tr>
</tbody>
</table>

### 7.11 Starting and Stopping the SAP System

**Use**

You use this procedure to start and stop the SAP system or single instances after the installation with the SAP Microsoft Management Console (SAP MMC) or SAPControl.
Caution

Note the following restrictions about starting and stopping the database instance with the SAP MMC or SAPControl:

Only valid for ‘High Availability’: non-HA

You can use the SAP MMC or SAPControl to start the database instance. To stop the database instance, however, you must use the relevant database administration tools.

End of ‘High Availability’: non-HA

Only valid for ‘High Availability’: HA (Windows)

In a HA system, you can neither start nor stop the database instance with the SAP MMC or SAPControl. For more information, see Starting and Stopping the SAP System in an HA Configuration [page 221].

End of ‘High Availability’: HA (Windows)

Prerequisites

The user who wants to start and stop the SAP system or instances with the SAP MMC, must be a member of the local administrators group.

Procedure

Starting and Stopping the SAP System with the SAP MMC

With the SAP MMC, you can start or stop installed SAP instances – except the database instance – locally on the host that you are logged on to. If the SAP MMC is configured for central system administration, you can start or stop the entire system from a single host.

Note

● You can also start and stop a UNIX system with the SAP MMC.
● The SAP MMC is not available on Server Core for Windows Server 2012 (R2) and higher.

For more information about the SAP MMC, see the following documentation:

Table 35:

<table>
<thead>
<tr>
<th>Release</th>
<th>SAP Library Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>● SAP NetWeaver 7.0 SR3</td>
<td><a href="http://help.sap.com/nw">http://help.sap.com/nw</a></td>
</tr>
<tr>
<td>● SAP NetWeaver 7.0 incl. EHP1</td>
<td>SAP NetWeaver 7.0 &lt;Including Enhancement Package&gt;</td>
</tr>
<tr>
<td>● SAP NetWeaver 7.0 incl. EHP2</td>
<td>Application Help › Function-Oriented View: English › Solution Life Cycle Management by Key Capability › Solution Monitoring › Monitoring in the CCMS › SAP Microsoft Management Console: Windows</td>
</tr>
</tbody>
</table>
To start or stop the SAP system with the SAP MMC, perform the following steps:

1. Start the SAP MMC on the SAP system host.
2. Right-click the SAP system node and choose **Start** or **Stop**.
   All SAP instances listed under the system node start or stop in the correct order.
3. If the SAP system is installed on multiple hosts (distributed or high-availability system), you have the following options to start or stop your system:
   - You start or stop the SAP instances using the SAP MMC on each host.
   - You add the remote instances to the SAP MMC configuration to start or stop all instances from a single SAP MMC.
   To do so, do one of the following:
     - You configure the SAP MMC manually. For more information, see *Changing the Configuration of the SAP MMC* in the SAP MMC documentation.
     - You use the automatic LDAP registration. For more information, see *Configuring SAP MMC for Active Directory Services* in the SAP MMC documentation.

### Starting and Stopping the SAP System with SAPControl

To start or stop the SAP system with SAPControl (sapcontrol.exe), perform the following steps:

- To start or stop the complete SAP system – except the database instance – with SAPControl, open a PowerShell in elevated mode, and enter the following command:
  
  ```
  sapcontrol -prot PIPE -nr <Instance_Number> -function StartSystem
  sapcontrol -prot PIPE -nr <Instance_Number> -function StopSystem
  ```

- To start or stop a single instance with SAPControl, open a PowerShell in elevated mode, and enter the following command:
  
  ```
  sapcontrol -prot PIPE -nr <Instance_Number> -function Start
  sapcontrol -prot PIPE -nr <Instance_Number> -function Stop
  ```

### 7.12 Configuring the Windows Server Firewall on Windows Server 2008 (R2) and Higher

#### Use

As of Windows Server 2008 (R2), the firewall is configured to allow only a small set of Windows-specific inbound IP connections.
Therefore, we recommend that you do **not** turn on the Windows firewall after you have installed your SAP system. Instead, we recommend that you secure network access to your SAP system with the physical firewall or a router Access Control List (ACL) within your datacenter.

If, for some reason, you want to use the Windows Server firewall, you have to configure the Windows firewall and define a set of **Inbound Rules** for the TCP/IP port numbers that are used by your system. Otherwise, your SAP system might not operate.

For more information about the port numbers used, see the documentation [TCP/IP Ports Used by SAP Applications](http://service.sap.com/security) at:

Port numbers listed with the default value **Not active** in this document are not configured.

---

**Caution**

In a high-availability system, you have to configure the firewall on all cluster nodes.

---

**Prerequisites**

You turn on the disabled firewall [page 51] as follows:

- Windows Server 2012 (R2) and higher:
  
  Open Windows PowerShell in elevated mode, and enter the following command:
  
  ```
  Set-NetFirewallProfile "public","domain","private" -enabled true
  ```

- Windows Server 2008 (R2):
  
  1. Choose [Start] ➤ **Administrative Tools** ➤ **Windows Firewall with Advanced Security** ➤
  
  2. Right-click **Windows Firewall with Advanced Security** and choose **Properties**.
  
  3. Set the **Firewall state** to **On**.

---

**Procedure**

This procedure provides an example how to set **Inbound Rules** for the ports of an ABAP server that was installed with the following settings:

<table>
<thead>
<tr>
<th>Table 36:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance number</td>
</tr>
<tr>
<td>Port type</td>
</tr>
<tr>
<td>Ports</td>
</tr>
</tbody>
</table>

---
- Windows Server 2012 (R2) and higher:
  Open Windows PowerShell in elevated mode, and enter the following command:
  
  ```powershell
  New-NetFirewallRule -DisplayName "SAP ABAP Server 00" -Direction Inbound -Protocol TCP -LocalPort 3200,3300,4800,8000,3600,50013,1433,1434 -Action Allow
  ```

- Windows Server 2008 (R2):
  1. Choose **Start** ➤ **Administrative Tools** ➤ **Windows Firewall with Advanced Security**.
  2. Right-click **Inbound Rules** and choose **New Rule**. The **New Inbound Rule Wizard** starts.
  3. For **Rule Type**, select **Port** and choose **Next**.
  4. For **Protocol and Ports**, select port type **TCP** or **UDP** depending on the port type used.
     Select **Specific local ports**, and enter the port numbers for which you want to apply the new rule, for example:
     ```
     3200,3300,4800,8000,3600,50013,1527
     ```
     Note that the final two digits of the port number correspond to the instance number.
  5. Choose **Next**.
  6. For **Action**, select **Allow the connection**, and choose **Next**.
  7. For **Profile**, keep **Domain**, **Private** and **Public** selected, and choose **Next**.
     For more information, see the link **Learn more about profiles** on this screen.
  8. Enter the **Name**, for example **SAP ABAP Server 00**, and **Description** for the new rule.
  9. Choose **Next**.
  10. Choose **Finish** to save the rule.

  The new inbound rule appears in the **Inbound Rules** list. To modify the settings, right-click on the rule and choose **Properties**.

  **Note**
  If you want to use, for example, a different IP scope for port 50013, which is used by the connection SAP Start Service – SAP Management Console, you can restrict the IP access to a small number of SAP administrators. Then delete this port from the SAP ABAP Server 00 rule and create a new rule for port 50013 with a more restrictive scope.

---

**7.13  Usage Type-Specific Initial Technical Configuration Done by the Installer**

The installer automatically performs initial technical configuration steps for the usage types shown below during the installation. However, you might have to perform these steps manually if you want to change existing parameters or you want to set additional parameters.

For more information, see the following usage type-specific sections.

**Related Information**

*Initial Technical Configuration for SAP NetWeaver Application Server for Java (AS Java)* [page 156]
7.13.1 Initial Technical Configuration for SAP NetWeaver Application Server for Java (AS Java)

The installer automatically performs initial technical configuration steps for some components of SAP NetWeaver Application Server for Java (AS Java). However, you might have to perform some of these steps manually after the installer has finished, depending on your installation scenario.

These are the following components.

Related Information

Initial Technical Configuration for Adobe Document Services [page 156]
Initial Technical Configuration for Composite Application Framework Core (CAF) [page 157]
Initial Technical Configuration for the System Landscape Directory (SLD) [page 158]

7.13.1.1 Initial Technical Configuration for Adobe Document Services

The installer automatically performs some initial technical configuration steps for Adobe Document Services (ADS) during the installation. However, you might have to perform these steps manually if you want to change existing parameters or if you want to set additional parameters.

The installer performs the following steps:

- The installer creates user ADSUser in AS Java for basic authentication and assigns it to group ADSCallers.
  For more information about this user, see Ensuring User Security [page 113].
- The installer sets up basic authentication in the Java environment.
More Information

For more information about how to perform these steps manually, see the SAP Library at the following locations:

Table 37:

<table>
<thead>
<tr>
<th>Release</th>
<th>SAP Library Path</th>
</tr>
</thead>
</table>
| ● SAP NetWeaver 7.0  
● SAP NetWeaver 7.0 including enhancement package 1  

7.13.1.2 Initial Technical Configuration for Composite Application Framework Core (CAF)

The installer automatically performs some initial technical configuration steps for Composite Application Framework Core (CAF) during the installation. However, you might have to perform these steps manually if you want to change existing parameters or if you want to set additional parameters.

The installer performs the following steps:

- The installer creates the following roles with the required User Management Engine (UME) actions:
  - CAFAdmin
  - CAFUIAdmin

For more information about how to perform this step manually, see the SAP Library at:

The installer configures CAF runtime properties for SAP NetWeaver Business Warehouse (BW) integration. For more information about how to perform this step manually, see the SAP Library at:


The installer configures CAF runtime properties for knowledge management integration. For more information about how to perform this step manually, see the SAP Library at:


The installer creates data sources to extract custom enumeration types. For more information about how to perform this step manually, see the SAP Library at:

http://help.sap.com/nw > SAP NetWeaver 7.0 <Including Enhancement Package> > Development > SAP NetWeaver Developer's Guide > Fundamentals > Creating Composite Applications > Developing Composite Applications with CAF Core > Integration > CAF Core and SAP Business Information Warehouse Integration > DataSource Use in CAF and SAP BW Integration > DataSources to Extract Custom Enumeration Types

7.13.1.3 Initial Technical Configuration for the System Landscape Directory (SLD)

The installer automatically performs some initial technical configuration steps for the System Landscape Directory (SLD) during the installation. However, you might have to perform these steps manually if you want to change existing parameters or if you want to set additional parameters.

- If you choose option Register in existing central SLD, the installer automatically configures the connection of the system being installed to an existing central SLD. For more information about how to perform these steps manually, see:


- If you choose option Configure a local SLD, the installer automatically sets up and configures a local SLD during the installation. For more information about how to perform these steps manually, see the documentation Post Installation Guide – System Landscape Directory of SAP NetWeaver 7.0 which you can find on the System Landscape Directory (SLD) - Overview page at https://wiki.scn.sap.com/wiki/display/SL/System+Landscape+Directory+%28SLD%29+-+Overview.
7.13.2 Initial Technical Configuration for Development Infrastructure (DI)

The installer automatically performs some initial technical configuration steps for usage type Development Infrastructure (DI) during the installation. However, you might have to perform these steps manually if you want to change existing parameters or you want to set additional parameters.

The installer performs the following steps:

- The installer creates the following NWID users:
  - NWID_ADM
  - NWID_DEV
  - NWID_CMSADM
  
  For more information about these NWID users, see the table in *Users in the SAP NetWeaver Development Infrastructure (NWDI)* of *Ensuring User Security* [page 113].

- The installer creates the following roles:
  - NWID.Administrator
  - NWID.Developer

- The installer adds the following actions to the role NWID.Administrator:
  - CBS.Administrator
  - sap.com_com.sap.lcr.LcrInstanceWriterAll

- The installer adds the following actions to the role NWID.DEVELOPER:
  - CBS.Developer
  - CMS.Display
  - CMS.ExportOwn
  - sap.com_com.sap.lcr.LcrInstanceWriterNR

- The installer creates the following groups:
  - NWID.Administrators
  - NWID.Developers

- The installer assigns the security role LcrInstanceWriterAll of the component sap.com/com.sap.lcr'slid to the group NWID.Administrators.

- The installer assigns the security role LcrInstanceWriterNR of the component sap.com/com.sap.lcr'slid to the group NWID.Developers.

- The installer assigns the role NWID.Administrator to the group NWID.Administrators.

- The installer assigns the role NWID.Developer to the group NWID.Developers.

- The installer assigns the group NWID.Administrators to the user NWID_ADM.

- The installer assigns the group NWID.Developers to the user NWID_DEV.

- The installer assigns the group NWID.Administrators to the user NWID_CMSADM.
7.13.3 Initial Technical Configuration for the Portal (Usage Types EPC and EP)

This section applies when you install usage type EPC only and when you install it together with usage type EP. The installer automatically performs some initial technical configuration steps for the usage types EPC and EP during the installation. However, you might have to perform these steps manually if you want to change existing parameters or you want to set additional parameters.

Context

The installer performs the following steps:

- The installer copies the CMS_MAPPING Properties file.
- The installer renames the InitialPermissions.xml.template file to InitialPermissions.xml.
- The installer renames the InitialPermissionsKMC.xml.template file to InitialPermissionsKMC.xml.

Procedure

- Copying CMS_MAPPING properties
  a. Change to the following source directory:
     
```bash
<drive>\usr\sap\<sapsid>\<Instance_Name>\j2ee\cluster\server<x>\apps\sap.com\irj\servlet_jsp\irj\root\WEB-INF\portal\system\pcd\Migration\mapping\`
```
  b. Copy file cms_mapping.properties from the source directory to the following target directory:
     
```bash
<drive>\usr\sap\<sapsid>\SYS\global\pcd\Migration\mapping\`
```
i Note

If the target directory does not exist, you also have to create it.

- **Renaming InitialPermissions.xml.template**
  a.  
  b. Go to the following directory:

  `<drive:\usr\sap\<sapsid>\<Instance_Name>\j2ee\cluster\server<x>\apps\sap.com\irj\servlet.jsp\irj\root\WEB-INF\portal\system\xml\acl`
  c. Rename file `initialPermissions.xml.template` to `initialPermissions.xml`.

- **Renaming initialPermissionsKMC.xml.template**
  a. Go to the following directory:

  `<drive:\usr\sap\<sapsid>\<Instance_Name>\j2ee\cluster\server<x>\apps\sap.com\irj\servlet.jsp\irj\root\WEB-INF\portal\system\xml\acl`
  b. Rename file `initialPermissionsKMC.xml.template` to `initialPermissionsKMC.xml`.

### 7.13.4 Initial Technical Configuration for BI Java

The installer automatically performs BI Java-specific initial technical configuration steps during the installation.

However, you might have to perform these steps manually if you want to change existing parameters or you want to set additional parameters.

The following steps might be affected.

### Related Information

- Configuring BI Java Information Broadcasting [page 162]
- Process Chains: Transporting Texts for the Alert Category [page 163]
- Renaming initialPermissionsBI.xml.template [page 163]
7.13.4.1 Configuring BI Java Information Broadcasting

The installer automatically configures BI Java information broadcasting. However, you might have to perform some of these steps manually if you upgraded your SAP system to the current release. The following steps might be required.

**Context**

For the configuration of the BI Information Broadcasting you need to perform the following steps in your ABAP system:

**Procedure**

1. Call transaction SPRO and perform the following steps:
   a. **Settings for Information Broadcasting:**
      Go to [SAP NetWeaver > Business Intelligence > Reporting-relevant Settings > Settings for Information Broadcasting](#).
   b. **Destinations for Web Dynpro ALV:**
      Go to [SAP NetWeaver > Application Server > Web Dynpro for ABAP > Set-Up Printing for Web Dynpro ABAP ALV](#).
      - Create the RFC destination in the SAP NetWeaver Portal
      - Create the RFC destination to the SAP NetWeaver Portal
      - Set up the Web Service destination for the Adobe Document Services

2. **Installation of BI Content:**
   
   Call transaction RSTCO_ADMIN to check whether the installation has been performed successfully. If the installation status is red, restart the installation by calling transaction RSTCO_ADMIN again. If you need further assistance or information, check the installation log.

   For more information, see SAP Note [834280](#).

   **Note**

   For the installation of SAP NetWeaver 7.0 BI Content Add-On 2 or higher on the AS ABAP system, see SAP Note [847019](#).
7.13.4.2 Process Chains: Transporting Texts for the Alert Category

Alert categories need to be defined.

**Context**

Alerts can be triggered and sent for BI process chains that contain errors. For this purpose, you need to define alert categories. Alert category BWAC_PROCESS_CHAIN_FRAMEWORK is returned for errors in background processing of process chains. This category has set texts that are not transported when the alert category is transported.

**Procedure**

To manually transport the texts, proceed as described in SAP Note [601619](#).

7.13.4.3 Renaming initialPermissionsBI.xml.template

If the installer does not automatically rename the initialPermissionsBI.xml.template file, you need to rename it yourself.

**Procedure**

1. Go to the following directory:
   
   `<drive>:\usr\sap\<sapsid>\JCxx\j2ee\cluster\server<\>\apps\sap.com\irj\servlet_jsp\irj\root\WEB-INF\portal\system\xml\acl`

2. Rename file `initialPermissionsBI.xml.template` to `initialPermissionsBI.xml`.

7.14 SAP System Security on Windows

In a standard SAP system installation, the installer automatically performs all steps relevant for security. Although the installer makes sure that the system is protected against unauthorized access, you must still check that no security breaches can occur.
For central and straightforward administration of the SAP system, you have to install distributed SAP systems with multiple application servers in a Windows domain. This section describes the user accounts and groups that the installer creates during a domain installation and shows how these are related to the SAP directories.

User Accounts

The installer creates the following accounts for SAP system administration:

**Table 38:**

<table>
<thead>
<tr>
<th>User account</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;sapsid&gt;adm</code></td>
<td>This is the SAP system administrator account that enables interactive administration of the system.</td>
</tr>
</tbody>
</table>
| SAPService<`SAPSID>` | This is the user account that is required to start the SAP system. It has the local user right to log on as a service.  
The advantage of the additional SAPService<`SAPSID>` account is that it does not allow interactive logon, which prevents abuse of the account. Therefore, you do not need to set an expiration date for the password and you do not have to set the option *user must change password at next logon*. |
| sapadm            | This is the user for the SAP Host Agent. By default it is a local user and not a member of the local Administrators group. You can change this user into a domain user on the Parameter Summary screen. For security reasons, however, SAP strongly recommends to create this user as a local user.  
The SAP Host Agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator. |

Domain and Local Groups

The only function of a domain group is to group users at the domain level so that they can be placed in the appropriate local groups.

Only local groups are created and maintained on each local host. A local group can only be given permissions and rights to the system where it is located. The system is part of a particular domain, and the local group can contain users and domain (global) groups from this domain.

During a domain installation, the installer creates the following domain and local groups:

**Table 39:**

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_&lt;`SAPSID&gt;_GlobalAdmin</td>
<td>This domain (global) group is a domain-level SAP administration group for organizing SAP system administrators.</td>
</tr>
<tr>
<td>SAP_SAP_GlobalAdmin</td>
<td>This domain group for the SAP Host Agent is only created if you create the SAP Host Agent user <code>sapadm</code> as a domain user.</td>
</tr>
<tr>
<td>SAP_&lt;`SAPSID&gt;_LocalAdmin</td>
<td>This local group is created on each host.</td>
</tr>
</tbody>
</table>
Group | Description
---|---
SAP_SAP_LocalAdmin | If you create the SAP Host Agent user as domain user, the group SAP_SAP_LocalAdmin is also created.
SAP_LocalAdmin | This local group is created on all hosts, but is particularly important for the transport host. Members of the group have full control over the transport directory (`/usr/sap/trans`) that allows transports to take place between systems.

The SAP_<SAPSID>_GlobalAdmin groups of all the SAP systems that are part of the transport infrastructure are added to the SAP_LocalAdmin group. Therefore, the users `<sapsid>adm` and `SAPService<SAPSID>` of all systems in the transport infrastructure are members of the SAP_LocalAdmin group and have the required authorizations necessary to initiate and execute transports.

**SAP Directories**

The installer protects the SAP directories under `\usr\sap\<SAPSID>` by only granting the group SAP_<SAPSID>_LocalAdmin full control over these directories.

The following graphic illustrates the users and groups that are created by the installer for the `<sapsid>adm` and `SAPService<SAPSID>` users in a system infrastructure consisting of two SAP systems.

![Figure 9: User Groups and Accounts](image)

**Note**

An access control list (ACL) controls access to SAP system objects. For maximum security in the SAP system, only the following are members of **all** SAP system object ACLs:

- Local group SAP_<SAPSID>_LocalAdmin
- Group Administrators
- User SYSTEM
More Information

Automatic Creation of Accounts and Groups [page 166]

7.15 Automatic Creation of Accounts and Groups

The installer automatically creates the accounts and groups required for the secure operation of the SAP system with Windows during the installation, as described in SAP System Security on Windows [page 163].

Features

The following figures show the steps that the installer performs to create the users and groups and assign the required rights to SAP directories.

The first figure shows the users that are created during a domain installation, with the SAP Host Agent operating system users being local users.

![Figure 10: Creating Users and Groups](Image)

<table>
<thead>
<tr>
<th>Domain users for SAP system</th>
<th>Local user for SAP Host Agent</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>rapsid=abc</code></td>
<td><code>sapadmin</code></td>
<td></td>
</tr>
<tr>
<td><code>SAPService=&lt;RAPSID&gt;</code></td>
<td><code>sapsys</code></td>
<td></td>
</tr>
</tbody>
</table>

Creation of Domain Group

- Creation of domain group `SAP_<RAPSID>_GlobalAdmin`
- Addition of `<RAPSID>, SAPService=<RAPSID>` to `SAP_<RAPSID>_GlobalAdmin`

Creation and Modification of Local Groups and Users on Each Host

- Creation of local groups `SAP_<RAPSID>_LocalAdmin`
- Creation of local group `SAP_LocalAdmin`
- Addition of local user `sapsys` to local group `SAP_LocalAdmin` on the transport host

Figure 10: Creating Users and Groups
7.16 Verifying and Adjusting the instanceID of an AS Java Instance

Using option Adjust instanceID of an AS Java Instance in Software Provisioning Manager (the “installer” for short), you can verify the correctness of the instanceID and box number parameters of an existing AS Java instance, and adjust them if required.

Prerequisites

- The AS Java instance can be started.
- **Caution**: The installer performs changes in the database which are related to J2EE Engine configuration. Therefore it is recommended that you back up the J2EE Engine configuration using the ConfigTool. You can do this by exporting configurations cluster_data, HttpHosts, apps.jms_provider, and WebContainer using OfflineConfigEditor and configuration of <SAPSID>/Server <xxx>/Services/Key Storage using the Visual Administrator.

Context

When to Use Option Adjust instanceID of an AS Java Instance

- Software Update Manager (SUM) fails due to incorrect parameter instanceID.

**Example**

An error like the following occurs during the upgrade of a Java system based on SAP NetWeaver 7.0x:

The detected instance ID IDXXXXX and the one calculated from the box number IDXXXXX do not match. A possible reason for this could be that you have changed the box number in the central instance instance.properties file.
The installer (70SWPM*.SAR) fails due to incorrect parameter instanceID.

Example

An error like the following occurs during system copy, dual-stack split, or system rename of a Java system based on SAP NetWeaver 7.0x with Software Provisioning Manager:

The source or target cluster ID is not present on the system! The current (source) cluster ID is XXXXX and the new (target) cluster ID is XXXXX

You are in doubt about consistency or correctness of the instanceID parameter of an AS Java instance.

Background Information About How Adjust instanceID of an AS Java Instance Works

Software logistics tools (Software Provisioning Manager (the" installer"), Software Update Manager) verify if the instanceID parameter corresponds to the box number of an SAP system based on SAP NetWeaver AS for Java. If the instanceID parameter is not consistent, Software Provisioning Manager fails.

The Box number has the format <SAPSID><instance_name><host_name> and is used as a parameter for the instanceID generation. instanceID is a unique identifier generated for each instance and is stored in the SAP system database schema when creating a new Java system.

An inconsistency between instanceID and box number is caused by applying an unsupported procedure to create or maintain the system. Using Software Provisioning Manager for system copy or system rename (changing the <SAPSID>, host name, or instance name) guarantees consistency.

Adjust instanceID of an AS Java Instance changes the box number and instanceID in the database and synchronizes the instance.properties file.

More Information

For more information, such as troubleshooting and FAQ, see SAP Note 2259748.

Procedure

1. Stop the AS Java instance or dual-stack instance and make sure that the database is running.
2. Start the installer and choose option Adjust instanceID of an AS Java Instance from the following path in the Welcome screen:

   Caution

   If the AS Java instance uses a virtual host name, start the installer with the installer property SAPINST_USE_HOSTNAME as follows:

   ./sapinst SAPINST_USE_HOSTNAME=<Virtual_Host_Name>

3. Follow the instructions given on the screens.
Next Steps

Perform the following activities after applying the correction:

1. Calculate the box number using the SAPLOCALHOST profile parameter in lower case.
2. Calculate the correct instanceID using the tool attached to SAP Note 1987497.
3. Adapt the /usr/sap/<SAPSID>/<instance_name>/j2ee/cluster/bootstrap/bootstrap.properties file: Assign the instance.prefix property to the correct instanceID.
4. Examine the instance profile - if j2ee/instance_id exists, change it to the new instanceID.
5. Open the OfflineConfigEditor and expand cluster_data. If the performerID property exists, change it to the new instanceID.
6. If you have EP: Knowledge Management and Collaboration installed on your system, you have to do the following adjustments for the Scheduler Service:
   Assign scheduler tasks to the new system IDs of the target system. This is required because after applying the correction, tasks are still assigned to the IDs of the source system.
   For more information, see the SAP Library for your release at:

<table>
<thead>
<tr>
<th>URL</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ SAP NetWeaver 7.0:</td>
<td><a href="http://help.sap.com/nw">http://help.sap.com/nw</a> Application Help SAP NetWeaver by Key Capability Information Integration: Key Areas Knowledge Management Administration Guide Minimal Configuration for Knowledge Management Cluster Only: Assigning Tasks to Nodes</td>
</tr>
<tr>
<td>○ SAP NetWeaver 7.0 including EHP1:</td>
<td></td>
</tr>
<tr>
<td>○ SAP NetWeaver 7.0 including EHP2:</td>
<td></td>
</tr>
<tr>
<td>○ SAP NetWeaver 7.0 including EHP3:</td>
<td></td>
</tr>
</tbody>
</table>

7.17 Troubleshooting for Portal Installation

This section applies both when you install usage type EPC only and when you install it together with usage type EP.

Context

If the iViews are not displayed correctly, or if the portal does not launch, the reason might be that the portal was not deployed completely.
To check the deployment of the portal, proceed as follows:

**Procedure**

1. Open a new console with the user `<sapsid>adm`.
2. Go to the directories `deployment`, `pcd`, and `pcdContent`, in the following paths:
   - `/usr/sap/<SAPSID>/JC<Instance_Number>/j2ee/cluster/server0/apps/sap.com/irj/servlet_jsp/irj/root/WEB-INF/deployment`
   - `/usr/sap/<SAPSID>/JC<Instance_Number>/j2ee/cluster/server0/apps/sap.com/irj/servlet_jsp/irj/root/WEB-INF/deployment/pcd`
   - `/usr/sap/<SAPSID>/JC<Instance_Number>/j2ee/cluster/server0/apps/sap.com/irj/servlet_jsp/irj/root/WEB-INF/deployment/pcdContent`
   - `/usr/sap/<SAPSID>/JC<Instance_Number>/j2ee/cluster/server0/apps/sap.com/irj/servlet_jsp/irj/root/WEB-INF/deployment/pcdContent/no_overwrite`
   - `/usr/sap/<SAPSID>/DVEBMGS<Instance_Number>/j2ee/cluster/server0/apps/sap.com/irj/servlet_jsp/irj/root/WEB-INF/deployment`
   - `/usr/sap/<SAPSID>/DVEBMGS<Instance_Number>/j2ee/cluster/server0/apps/sap.com/irj/servlet_jsp/irj/root/WEB-INF/deployment/pcd`
   - `/usr/sap/<SAPSID>/DVEBMGS<Instance_Number>/j2ee/cluster/server0/apps/sap.com/irj/servlet_jsp/irj/root/WEB-INF/deployment/pcdContent`
   - `/usr/sap/<SAPSID>/DVEBMGS<Instance_Number>/j2ee/cluster/server0/apps/sap.com/irj/servlet_jsp/irj/root/WEB-INF/deployment/pcdContent/no_overwrite`
   - `<Drive>:\usr\sap\<SAPSID>\JC<Instance_Number>\j2ee\cluster\server0\apps\sap\com\irj\servlet_jsp\irj\root\WEB-INF\deployment`
   - `<Drive>:\usr\sap\<SAPSID>\JC<Instance_Number>\j2ee\cluster\server0\apps\sap\com\irj\servlet_jsp\irj\root\WEB-INF\deployment\pcd`
   - `<Drive>:\usr\sap\<SAPSID>\JC<Instance_Number>\j2ee\cluster\server0\apps\sap\com\irj\servlet_jsp\irj\root\WEB-INF\deployment\pcdContent`
   - `<Drive>:\usr\sap\<SAPSID>\JC<Instance_Number>\j2ee\cluster\server0\apps\sap\com\irj\servlet_jsp\irj\root\WEB-INF\deployment\pcdContent\no_overwrite`
   - `<Drive>:\usr\sap\<SAPSID>\DVEBMGS<Instance_Number>\j2ee\cluster\server0\apps\sap\com\irj\servlet_jsp\irj\root\WEB-INF\deployment`
   - `<Drive>:\usr\sap\<SAPSID>\DVEBMGS<Instance_Number>\j2ee\cluster\server0\apps\sap\com\irj\servlet_jsp\irj\root\WEB-INF\deployment\pcd`
   - `<Drive>:\usr\sap\<SAPSID>\DVEBMGS<Instance_Number>\j2ee\cluster\server0\apps\sap\com\irj\servlet_jsp\irj\root\WEB-INF\deployment\pcdContent`
   - `<Drive>:\usr\sap\<SAPSID>\DVEBMGS<Instance_Number>\j2ee\cluster\server0\apps\sap\com\irj\servlet_jsp\irj\root\WEB-INF\deployment\pcdContent\no_overwrite`
3. Look for files with the extension `*.err`.
4. Do one of the following:
If error and log files do not appear, the portal installation has been completed successfully and you can continue.

Rename the *.err files:
1. Remove the err extension; so the extensions of the files become *.ept or *.par.
2. Restart the Java Engine, using the commands stopsap and startsap, to change the files to *.bak.

### 7.18 Deleting an SAP System or Single Instances

This section describes how to delete a complete SAP system or single SAP instances with the Uninstall option of the installer.

#### Prerequisites

- You have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on with a user account that has the required authorization to run the installer tool and the SAP system. For more information, see Required User Authorization for Running the Installer [page 54].

**Caution**

Do not use the `<sapsid>adm` user to delete the SAP system.

- Make sure that the SAP system, or single instance, or standalone engine, or optional standalone unit to be deleted is down and that you are not logged on as one of the SAP system users. If there is a lock on one of the SAP system objects, the uninstall fails. Make also sure that all SAP-related processes are stopped.

**Note**

You do not have to stop the SAP Host Agent. The SAP Host Agent is stopped automatically during the uninstall process.

- Make sure that there are no open sessions by one of the SAP system users when starting the uninstall.

#### Context

**Note**

With this installer option you do **not** delete the database software.

Note the following when deleting an SAP system:

- You cannot delete an SAP system remotely.
The installer deletes the database instance but not the database software. You have to delete the database software manually.

If you delete network-wide users, groups, or service entries in an environment with Network Information System (NIS), other SAP installations might also be affected. Make sure that the users, groups, and service entries to be deleted are no longer required.

During the uninstall process, all file systems and subdirectories of the selected SAP system or single instance are deleted. Before you start uninstalling, check that you have saved a copy of all files and directories that you want to keep in a secure location.

The uninstall process is designed to remove as much as possible of the SAP system to be deleted. If an item cannot be removed, a message informs you that you have to remove this item manually. You can do this either at once or after the uninstall process has finished. As soon as you confirm the message, the uninstall process continues.

If you uninstall an SAP instance and you plan to install another SAP instance with the same System ID, first reboot the Windows host to clear all user cached information. For more information, see 2296310.

**Procedure**

1. Start the installer as described in [Running the Installer](page 85).
3. Follow the instructions in the installer input dialogs to delete a complete SAP system or single instances.

**Note**

To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field:

- If you use the SL Common GUI, choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.
- If you use the Java SDT GUI, choose F1. Then a dialog opens with the available help text.

The following table provides information about deleting a complete system or single instances with the installer.

<table>
<thead>
<tr>
<th>Deletion of</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central system</td>
<td>You can delete a central system (where all instances reside on the same host), in one installer run.</td>
</tr>
<tr>
<td>Deletion of</td>
<td>Remarks</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Distributed or high-availability system</td>
<td>If you want to delete a distributed or high-availability system, you have to run the installer to delete the required instances <strong>locally</strong> on each of the hosts belonging to the SAP system in the following sequence:</td>
</tr>
<tr>
<td></td>
<td>1. Dialog instances, if there are any</td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong></td>
</tr>
<tr>
<td></td>
<td>Do <strong>not</strong> select checkbox <em>Uninstall all instances of the SAP system from this host</em> if you do <strong>not</strong> want to uninstall the complete SAP system or standalone engine. For example, do <strong>not</strong> select this checkbox if you only want to uninstall a dialog instance of an existing SAP system distributed over several hosts. Otherwise the contents of mounted global directories under <code>/&lt;sapmnt&gt;/</code> <code>&lt;SAPSID&gt;/</code>, such as instance profiles and kernel executables, are also deleted.</td>
</tr>
<tr>
<td></td>
<td>2. Central instance</td>
</tr>
<tr>
<td></td>
<td>If the installer stops responding while trying to delete the central instance, do the following:</td>
</tr>
<tr>
<td></td>
<td>1. Close the installer with <em>Cancel</em> and <em>Exit</em>.</td>
</tr>
<tr>
<td></td>
<td>2. Log off and log on again.</td>
</tr>
<tr>
<td></td>
<td>3. To finish uninstalling the central instance, restart the installer.</td>
</tr>
<tr>
<td></td>
<td>3. Database instance</td>
</tr>
<tr>
<td></td>
<td>Choose whether you want to drop the entire database instance or only one or more database schemas.</td>
</tr>
<tr>
<td></td>
<td>Since the installer only stops local instances automatically, make sure that before deleting the database instance of a distributed system, you stop all remaining instances. You must stop the instance with the message server only after having entered all installer parameters for the deletion of the database instance. Before deleting any database schema, make sure that:</td>
</tr>
<tr>
<td></td>
<td>○ You have performed a recent offline database backup.</td>
</tr>
<tr>
<td></td>
<td>○ You have stopped or deleted all SAP instances belonging to this database schema.</td>
</tr>
<tr>
<td></td>
<td>○ You only delete the tablespaces that belong to the selected schema.</td>
</tr>
<tr>
<td></td>
<td>The database tablespace <code>PSAP&lt;SCHEMA_ID&gt;DB</code> belongs by default to the Java schema <code>SAP&lt;SCHEMA_ID&gt;DB</code>. All other SAP tablespaces belong to the ABAP schema <code>SAP&lt;SCHEMA_ID&gt;</code> (or <code>SAPR3</code> for older SAP systems).</td>
</tr>
<tr>
<td></td>
<td>4. Only valid for 'High Availability': HA (Windows)</td>
</tr>
<tr>
<td></td>
<td>Enqueue Replication Server</td>
</tr>
<tr>
<td></td>
<td>End of 'High Availability': HA (Windows)</td>
</tr>
<tr>
<td></td>
<td>5. Central services instance (SCS)</td>
</tr>
<tr>
<td></td>
<td>If you want to delete dialog instances of an existing SAP system, you have to run the installer to delete them <strong>locally</strong> on each dialog instance host.</td>
</tr>
</tbody>
</table>
4. When you have finished, delete the relevant directory structure on the global host.
5. Delete the Oracle database software with the Oracle Universal Installer (OUI).
   For more information, see Deleting the Oracle Database Software [page 174].
6. Delete the local user group SAP_<SAPSID>_LocalAdmin manually as follows:
   ○ Windows Server 2012 (R2) and higher:
     Open a PowerShell in elevated mode and enter the following command:
     `net localgroup SAP_<SAPSID>_LocalAdmin /delete`
   ○ Windows Server 2008 (R2):
     2. Right-click the local group SAP_<SAPSID>_LocalAdmin and choose Delete.
7. If required, you can delete the directory \usr\sap\trans and its contents manually.
   The installer does not delete \usr\sap\trans because it might be shared.

### 7.19 Deleting the Oracle Database Software

You use the Oracle Universal Installer to delete the Oracle database software.

<table>
<thead>
<tr>
<th>Deletion of</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standalone SAP Host Agent</td>
<td>The SAP Host Agent is automatically uninstalled from a host together with the last remaining SAP system instance. If you want to uninstall a standalone SAP Host Agent, deselect Profiles Available and select Uninstall Standalone SAP Host Agent on the General SAP System Parameters screen.</td>
</tr>
</tbody>
</table>
7.19.1 Deleting the Oracle Database Software on Windows Server 2012 (R2)

This section describes how to delete the Oracle database software on Windows Server 2012 (R2).

Prerequisites

Before you delete the database software, make sure that you delete the groups ORA_<DBSID>_DBA and ORA_<DBSID>_OPER as follows:

To delete local groups, open a PowerShell in elevated mode, and enter the following command:

```
net localgroup ORA_<DBSID>_DBA /delete
net localgroup ORA_<DBSID>_OPER /delete
```

To delete domain groups, open a PowerShell in elevated mode, and enter the following command:

```
net group ORA_<DBSID>_DBA /delete /domain
net group ORA_<DBSID>_OPER /delete /domain
```

Context

The Oracle software is installed on all hosts where an SAP instance is running, for example, on a primary application server instance host, database host, or additional application server instance host. Do not delete the Oracle database software, if another SAP instance is running on the same host.

⚠️ Caution

**High Availability only:**
- Deinstall the Oracle Fail Safe (OFS) software with Oracle Universal Installer before deleting the Oracle database software on both nodes.
- Delete the Oracle database software on both nodes.

Procedure

1. Stop all Oracle services and the Microsoft Distributed Transaction Coordinator (MSDTC) service.
   
   To do so, open a PowerShell in elevated mode, and enter the following command:

   ```
   stop-service <Service Name>
   ```

2. Delete the Oracle database software with the Oracle Universal Installer as follows:
   
   a. Start the Oracle Universal Installer by pressing Ctrl + Esc and then Ctrl + Tab
b. Choose *Installed Products* or *Deinstall Products*.
c. Select the database product (<Oracle_Home_name>) you want to uninstall.
d. Choose *Remove*.
e. Confirm with *Yes* and choose *EXIT*.

3. Delete the Oracle home directory and all its subdirectories under <DRIVE>:\ORACLE_HOME.

4. Delete the key for the corresponding Oracle_Home at HKEY_LOCAL_MACHINE >> SOFTWARE >> ORACLE >> KEY_<Oracle_Home>.

To do so use the following PowerShell command:

```powershell
remove-item -path:"HKLM:\SOFTWARE\ORACLE\KEY_<Oracle_Home>"
```

5. Delete all Oracle references for the respective Oracle Home at HKEY_LOCAL_MACHINE >> SYSTEM >> CURRENTCONTROLSET >> SERVICES.

○ To display all Oracle keys, use the following PowerShell command:

```powershell
get-childitem -path:"HKLM:\SYSTEM\CURRENTCONTROLSET\SERVICES\Oracle*
```

○ To delete all Oracle keys, use the following PowerShell command:

```powershell
remove-item -path:"HKLM:\SYSTEM\CURRENTCONTROLSET\SERVICES\<Oracle Key>"
```

6. Delete all corresponding Oracle references from the Windows user and system environment: For example, delete the variables:

TNS_ADMIN, NLS_LANG, ORACLE_HOME, ORACLE_<DBSID>.

To do so, use the following PowerShell command:

```powershell
remove-itemproperty -path:HKCU:\Environment -name <variable>
```

7. Delete Oracle from the PATH variable.

8. Delete Oracle from the registry key:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Environment\Path

9. Select and delete the folders and shortcuts for Oracle in:

C:\ProgramData\Microsoft\Windows\Start Menu\Programs

### 7.19.2 Deleting the Oracle Database Software on Windows Server 2008 (R2)

This section describes how to delete the Oracle database software on Windows Server 2008 (R2).

**Prerequisites**

Before you delete the database software, make sure that you delete the groups ORA_<DBSID>_DBA and ORA_<DBSID>_OPER as follows:

1. Choose Start >> Control Panel >> Administrative Tools >> Computer Management

2. Choose Local Users and Groups >> Groups.
3. Select and delete the local groups **ORA_<DBSID>_DBA** and **ORA_<DBSID>_OPER** with Action - Delete.

**Context**

The Oracle software is installed on all hosts where an SAP instance is running, for example, on a primary application server instance host, database host, or additional application server instance host. Do **not** delete the Oracle database software, if another SAP instance is running on the same host.

⚠️ **Caution**

**High Availability only:**

- Deinstall the Oracle Fail Safe (OFS) software with Oracle Universal Installer before deleting the Oracle database software on both nodes.
- Delete the Oracle database software on both nodes.

**Procedure**

1. Stop all Oracle Services and the Microsoft *Distributed Transaction Coordinator* (MSDTC) service.
   
   To access the services, choose **Start > Control Panel > Administrative Tools > Services**.

   Select a service and then choose **Action > All Tasks > Stop**.

2. Delete the Oracle database software with the Oracle Universal Installer as follows:
   
   a. Start the Oracle Universal Installer with **Start > All Programs > Oracle-<Oracle_Home_name> > Oracle Installation Products > Universal Installer**.
   b. Choose **Installed Products** or **Deinstall Products**.
   c. Select the database product (**<Oracle_Home_name>**) you want to uninstall.
   d. Choose **Remove**.
   e. Confirm with **Yes** and choose **EXIT**.

3. Delete the relevant Oracle home directory and all its subdirectories under `<DRIVE>`:

4. Edit the Oracle Registry entries as follows:
   
   a. Choose **Start > Run** and enter `REGEDIT`.
   b. Delete the key for the corresponding Oracle_Home at `HKEY_LOCAL_MACHINE > SOFTWARE > ORACLE > KEY_<Oracle_Home>`.
   c. Delete all Oracle references for the respective Oracle Home at `HKEY_LOCAL_MACHINE > SYSTEM > CURRENTCONTROLSET > SERVICES`.

5. Delete all Oracle references from the Windows user and system environment:
   
   a. Choose **Start > Control Panel > System**.
   b. Choose **Advanced system settings** and select **Environment Variables**.
   c. For example, delete the variables:
TNS_ADMIN, NLS_LANG, ORACLE_HOME, ORACLE_<DBSID>.

d. Delete Oracle from the PATH variable.

6. Delete the corresponding Oracle entries from the Start menu:
   a. Choose Start ➤ Settings ➤ Taskbar & Start Menu ➤ Advanced.
   b. On the Advanced tab, click Advanced.
   c. On the Start Menu screen, look at All Users\Start Menu\Programs.
      Select and delete the folders for Oracle with File ➤ Delete.
   d. Delete the Oracle shortcut from the desktop.
8 High Availability with Microsoft Failover Clustering

You can install a high-availability SAP system with Microsoft Failover Clustering. The Failover Clustering software improves the availability of the system and protects it against failure and unplanned downtime, enabling 24-hour operation, 365 days a year.

With high availability you enable critical system components, known as “Single Points of Failure (SPOFs)”, to be automatically switched from one machine to the other, if hardware or software problems arise on one machine. With the help of this switchover – or failover – the system can continue functioning.

Apart from enabling failover when hardware problems occur, you can also use Failover Clustering to avoid downtime when you perform essential system maintenance. If you need to maintain one host (failover cluster node), you can deliberately switch the cluster resources to the other host (failover cluster node) and temporarily operate it there while maintenance is in progress. When maintenance work is finished you can easily move the resources back to their original node and continue operating them there.

When you are setting up the SAP system with Microsoft Failover Clustering, you combine standard installation steps, described earlier in this documentation, with cluster-specific steps, described here.

You have the following options to install a high-availability SAP system with Microsoft Failover Clustering:

- You install one SAP system in one Microsoft failover cluster.
- You install one SAP system in two Microsoft failover clusters.
- You install several SAP systems in one or more Microsoft failover clusters with two and more Microsoft failover cluster nodes.

You have the following options to install the database instance with a high-availability SAP system:

- You install the database instance in the same failover cluster as the SAP system.
- You install the database instance on a different host or cluster on either the same or a different operating system.
- You use third-party high-availability solutions to improve the availability of your database instance.

Important Information

To install a new SAP system with Microsoft Failover Clustering, you have to perform a number of extra steps specially required for the cluster and configure the SAP system so that it can take advantage of the cluster functionality:

- Since the correct configuration of network addresses is absolutely essential for the cluster to function properly, you have to perform a number of additional steps that are necessary to set up and check address resolution.
- Since the cluster hardware has at least two nodes that have access to all local and shared storage devices, you have to install some components on all nodes and pay attention to special rules for distributing components to local or shared disks.
- You have to install and configure the SCS instance to run on two cluster nodes in one Microsoft failover cluster.
Note

If you have an existing SAP system and plan to migrate to a failover cluster with new hardware, you install the SAP system using a system copy.

For more information about the system copy, see the System Copy Guide for your SAP system at:

http://support.sap.com/sltoolset > System Provisioning > System Copy Option

The system copy guide does not include the cluster-specific information, which is described here.

Terminology

- In this documentation the hosts in a Microsoft failover cluster are referred to as first cluster node and additional cluster node(s):
  - The first cluster node is the cluster node where you perform the general installation of an SAP system, for example where the database or (A)SCS instance is to be installed.
  - The additional cluster node is the node where you configure the already installed SAP instances to run in Microsoft Failover Clustering.
- As of Windows Server 2008 there are the following terminology changes for a cluster configuration:
  - The cluster feature is called Failover Clustering. You might still find the previous terminology Microsoft Cluster Service and abbreviation MSCS in some sections of this guide.
  - Cluster groups are called services and applications (Windows Server 2008 (R2)), or roles (Windows Server 2012 (R2) and higher).
    In some sections we are continuing to use the old term. In this case, “cluster group” also means “service and application”, or “role”.
  - The Cluster Administrator is called Failover Cluster Manager.

8.1 Checklist for a High-Availability System

This section includes the steps that you have to perform for your SAP system using Microsoft Failover Clustering. Detailed information about the steps is available in the relevant section.

Planning

1. You check that you have completed the same planning activities [page 20] as for a non-HA system, including the hardware and software requirements [page 21].
2. You decide how to set up your SAP system components in a Microsoft failover cluster [page 182].
3. You decide how to distribute SAP system components to disks for a high-availability system [page 189].
4. You read Directories in a Microsoft Failover cluster Configuration [page 193].
5. You read IP Addresses in a Microsoft Failover Cluster Configuration [page 194].
6. You obtain IP addresses for a high-availability system [page 197].

Preparation

1. You check that you have completed the same preparations [page 50] as for a non-HA system.
2. To make sure that all preparation steps have been correctly performed, check that you can move the disk resources from one cluster node to another so that they are accessible from a single node at any time.

Installation

1. You make sure that:
   1. You are logged on as domain administrator, unless otherwise specified.
   2. You do not use the user <sapsid>adm unless specified.
   3. If you are prompted during the installation process, log off and log on again.
2. On all cluster nodes of the database instance host, you install the Oracle database software [page 64].
3. If required, you set up multiple Oracle Homes [page 81].
4. On all cluster nodes of the database instance host, you install the Oracle Fail Safe software [page 199].
5. You configure the first cluster node [page 205].
6. You create the Oracle Fail Safe group [page 207] on the database instance host.
7. You install the database instance on the first cluster node [page 209] of the database instance host.
8. You set up a shared database directory in your Oracle Home [page 210] on the database instance host.
9. You add the Oracle database resource to the Fail Safe group [page 212] on the database instance host.
10. You configure the additional cluster node [page 213].
11. You perform additional steps for the Oracle Fail Safe configuration [page 214] on the database instance host.
12. You install the central instance [page 216].
13. You install at least one dialog instance [page 217].

Post-Installation

1. You install the permanent SAP licenses on all cluster nodes.
2. You perform the post-installation checks for the enqueue replication server.
3. You perform the same post-installation steps [page 102] as for a non-HA system.

Additional Information

- Moving Cluster Groups, or Services and Applications, or Roles [page 219]
8.2 Planning

The following sections provide information about how to plan the installation of the SAP system for Microsoft Failover Clustering. For a complete list of all steps, see section Planning in the Installation Checklist for a High-Availability System [page 180].

8.2.1 System Configuration with Microsoft Failover Clustering

The following chapters provide information about the configuration of your SAP system configuration with Microsoft Failover Clustering. It describes the components you have to install for an SAP system running in a Microsoft failover cluster, and how to distribute them on the specific host. For more information, see:

- SAP System Components in a Microsoft Failover Cluster [page 182]
- Multiple SAP Systems in One Microsoft Failover Cluster [page 186]
- Multiple SAP Systems in Multiple Microsoft Failover Clusters [page 187]
- Enqueue Replication Server in a Microsoft Failover Cluster [page 188]

8.2.1.1 SAP System Components in a Microsoft Failover Cluster

In a Microsoft failover cluster configuration you have the following components for your SAP system:

Table 42: SAP System Components in an HA Configuration

<table>
<thead>
<tr>
<th>Component</th>
<th>Number of Components per SAP System</th>
<th>Single Point of Failure (SPOF)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCS instance (message services and enqueue services)</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Database instance (*)</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Application server (central instance, dialog instance)</td>
<td>1-&lt;N&gt;</td>
<td>no</td>
</tr>
</tbody>
</table>

(*) the database instance can also be installed outside the Microsoft failover cluster.

- To protect the SPOFs ((A)SCS instance, database instance) you have to use Microsoft Failover Clustering. If a hardware or software problem occurs on the first cluster node, the clustered (A)SCS instance and the clustered database automatically fail over to another node.
If you need to maintain the cluster node where the (A)SCS instance and database are running you can switch these instances to another node. When maintenance work is finished you move the (A)SCS and database instance back to the original node.

- To protect system components that are non-SPOFs, for example application servers, you have to install them as multiple components. In this case you must install at least two application servers (one central instance and at least one dialog instance) on two different hosts. You have the following options:
  - You install the central instance and the dialog instance on the cluster nodes of a Microsoft failover cluster. You install them on a local disk. Any additional dialog instances are installed on hosts outside of the Microsoft failover cluster.
    If you have to maintain a cluster node, you have to stop the central or dialog instance on that node. When you have finished maintenance, you restart the instances.
  - You install the central instance and all dialog instances on hosts, which are not part of a Microsoft Cluster.

### Note

If you install the central instance and the dialog instance on the cluster nodes, you must perform the hardware sizing for the failover cluster host, as in this case the application server is always running on this host. This increases system load and might impact performance. Note that, as usual in an Microsoft failover cluster setup, the (A)SCS and database instances also switch to run on the failover cluster host in the event of failover, which temporarily also increases system load.

### SAP System Components in One Microsoft Failover Cluster

The following figures show examples for the installation of SPOFs and non-SPOFs of an SAP system in one Microsoft failover cluster with two nodes.

The first figure shows a Microsoft failover cluster configuration where the non-SPOFs components (central instance, dialog instance) are installed locally on the cluster nodes. Any additional dialog instances are installed outside the Microsoft failover cluster on separate hosts.
The following figure shows an HA configuration, where the non-SPOF components (central instance, dialog instance) are installed on separate hosts that are not part of the Microsoft failover cluster.

**Figure 12: Java System with SPOFs, where non-SPOFs are installed locally on the Failover Cluster Nodes**

CI = Central Instance  
DI = Dialog Instance  
DB = Database Instance  
ERS = Enqueue Replication Server Instance  
SCS = Central Services Instance
Besides installing your SAP system within one Microsoft failover cluster, you can also set up two Microsoft Failover clusters and distribute the SPOF system components on these clusters to protect them against system failure.

The following figure shows an example where the database instance for the SAP system is installed in one Microsoft failover cluster, and the (A)SCS instance is installed on the second Microsoft failover cluster. The application servers (central instance, dialog instance) can either be installed on a local disk on the cluster nodes or on separate hosts that are not part of the Microsoft failover cluster.

**SAP System Components in Two Microsoft Failover Clusters**
**8.2.1.2 Multiple SAP Systems In One Microsoft Failover Cluster**

Before SAP NetWeaver 7.0, SAP only supported the installation of one clustered SAP system in one Microsoft failover cluster with two cluster nodes. The reason was that the cluster share `sapmnt` resource could only be assigned to one cluster group and could only point to one shared drive.

The solution was to rename the cluster share `sapmnt` resource into `sapmnt<SAPSID>`, and use junctions, which pointed to the local disk. This is no longer required.

⚠️ **Caution**

All additional local instances such as an enqueue replication server, central instance, or dialog instance are installed on the local disk where the `saploc` share is pointing to. Make sure that you have enough space on this local disk.

Every SAP system is placed in a separate cluster group with the unique name `SAP<SAPSID>`. Each SAP cluster group has its own shared disk, IP address, network name, `sapmnt` share, as well as a SAP service resource (or generic service resource), and the SAP instance resource.

If you have a Microsoft failover cluster configuration with three or more cluster nodes, the following restrictions apply:

- The (A)SCS instance must be configured to run on two cluster nodes in one Microsoft failover cluster. For more information, see SAP Note 1634991.
If the database supports the installation on several cluster nodes, the database instance can be installed on more than two cluster nodes in one Microsoft failover cluster.

The following figure shows the installation of multiple SAP systems in one Microsoft failover cluster. For each SAP system you have to install one central and at least one dialog instance.

![Diagram of Multiple SAP Systems Installation](image)

**Figure 15: Multiple SAP Systems in One Microsoft Failover Cluster**

8.2.1.3 Multiple SAP Systems In Multiple Microsoft Failover Clusters

Besides installing multiple SAP systems in one Microsoft failover cluster, you can also install multiple SAP systems in several Microsoft failover clusters with two or more cluster nodes.

**Note**

As of Windows Server 2012, the Microsoft Failover Clustering software supports up to 64 cluster nodes.

For this failover cluster configuration the following restrictions apply:

- The (A)SCS instance must be configured to run on two cluster nodes in one Microsoft failover cluster. For more information, see SAP Note 1634991.
- If the database supports the installation on several cluster nodes, the database instance can be installed on more than two cluster nodes in one Microsoft failover cluster.
The following figure shows the installation of multiple SAP systems in two Microsoft failover clusters with three cluster nodes, called Node A, B, and C. In this example, the SCS and ASCS instances are installed in the first Microsoft failover cluster, and the database instances for the two SAP systems are installed on the second Microsoft failover cluster. The application servers can be either installed on a local disk on the cluster nodes or outside the Microsoft failover cluster on separate hosts.

**Note**

If you use an enqueue replication server, you must configure the enqueue replication server, and the (A)SCS instance on **two** nodes.

For more information, see SAP Note [1634991](https://example.com).

---

**8.2.1.4 Enqueue Replication Server in a Microsoft Failover Cluster**

The enqueue replication server contains a replica of the lock table (replication table) and is an essential component in a high-availability setup. It is installed on the two cluster nodes where the (A)SCS instance is installed and configured to run, even if you have more than two cluster nodes.

In normal operation the enqueue replication server is always active on the host where the (A)SCS instance is not running.
If an enqueue server in a Microsoft failover cluster with two nodes fails on the first cluster node, the enqueue server on the additional cluster node is started. It retrieves the data from the replication table on that node and writes it in its lock table. The enqueue replication server on the second cluster node then becomes inactive. If the first cluster node is available again, the enqueue replication server on the second cluster node becomes active again.

The following figure shows the enqueue replication server mechanism in an Microsoft failover cluster configuration with two nodes:

![Figure 17: Enqueue Replication Server Mechanism on One Microsoft Failover Cluster with Two Nodes](image)

### 8.2.2 Distribution of SAP System Components to Disks for a Microsoft Failover Cluster

When planning the high-availability installation, keep in mind that the cluster hardware has two different sets of disks:

- Local disks that are connected directly to the cluster nodes
- Shared disks that can be accessed by all cluster nodes via a shared interconnect

**Note**

Shared disk is a synonym for the cluster resource of **Resource type** Physical disk.

You need to install the SAP system components in both the following ways:

- Separately on all cluster nodes to use the local storage on each node
  You install the Oracle database server software and the Oracle Fail Safe software on local disks.
- On the shared storage used in common by all cluster nodes
  You install the following on different shared disks:
    - Database instance files, if the database instance is installed in a Microsoft failover cluster.
    - (A)SCS instance
    - SAP system executables
    - Single quorum device, if used
Caution

You must not install any SAP or database components on the quorum disk.

The following figure shows a cluster configuration, where the (A)SCS and DB instance are installed in the same cluster. It illustrates how to distribute the database data files, the SAP system executables, and the quorum resource (if used) to different disks. Only with this distribution of files to distinct disks is it possible to move the SAP system and database as separate entities in a failover situation.

Note

The Oracle server software in the Oracle HOME directory must have the same drive letter and path on all cluster nodes.

Quorum Configurations on Windows

On Windows there are several quorum configurations available. The configuration to use mainly depends on the cluster setup, such as the number of cluster nodes, the storage type (single or distributed), and the number of data centers. For more information, see the Windows documentation.

The default quorum configuration used on Windows Server 2008 (R2) and higher is called Node and Disk Majority for clusters with more than two nodes.

With this quorum configuration, each node and the witness disk maintain its own copy of the cluster configuration data. This ensures that the cluster configuration is kept running even if the witness disk fails or is offline.
Note

The disk layout of the Node and Disk Majority and the Single Quorum Device Cluster is identical.

Caution

If you do not use the default quorum configuration for your operating system, contact your hardware partner, who can help you to analyze your needs and set up your cluster model. SAP supports these configurations if they are part of a cluster solution offered by your Original Equipment Manufacturer (OEM), or Independent Hardware Vendor (IHV).

Geographically Dispersed Cluster (Geospan)

The standard Windows failover clustering configuration consists of two cluster nodes and a shared disk storage with all technical components located in the same data center. In a geographically dispersed cluster, also known as a geospan cluster, the cluster nodes are distributed across at least two data centers to avoid the full outage of a data center in the event of disaster.

A geospan configuration requires a more sophisticated disk storage architecture since a shared disk storage can only be located in one data center and might therefore be a single point of failure (SPOF). To prevent the disk storage becoming a SPOF, you have to configure the storage system in each data center and to replicate its content to the storage system of the other data center.

Replication can either be synchronous or asynchronous, depending on the:

- Functionality of the disk storage subsystem
- Acceptable amount of data loss during a failover
- Physical layout of the disk storage area network
  - This includes the distance between the storage systems, signal latency, capacity, and speed of the network connection.
- Customer budget
- Functionality supported by the database vendor

The database components in geospan configurations are often no longer part of the Microsoft failover cluster and the database is replicated by pure database techniques, such as shadow database, log shipping, and mirrored database.

Caution

The numerous variants with geospan cluster configurations and the complex technical requirements are the reasons why the installation and configuration of such high-availability (HA) systems are not directly supported by SAP. Instead, the hardware vendors of this cluster configuration are responsible for the installation, configuration, and operation of the HA components running in geospan clusters. SAP only supports the standard operation and function of the SAP components running in such HA configurations.

All functionality to set up geospan clusters is available since Windows Server 2008 (R2).
Distribution of Database Files in a RAID Configuration

**Caution**
Microsoft does **not** support host-based RAID configurations (Dynamic Disks) on shared disks.

The following figures show a secure method to distribute the database files to different RAID volumes. You must always locate the database data and redo logs on **separate** RAID volumes.

**Figure 19:** Distribution of Database Files to Different RAID Volumes for Test or Development Systems

**Figure 20:** Distribution of Database Files to Different RAID Volumes for Production Systems

For high-performance production systems, we recommend that you locate the database files on different RAID volumes.
Note that the BR*Tools directories `\sapreorg`, `\saptrace`, `\sapbackup`, and `\sapcheck` are not shown in the figures above. You can locate these directories on any of the database volumes as they do not require special security measures.

### 8.2.3 Directories in a Microsoft Failover Cluster Configuration

The following tables show the directories where the main software components for a high-availability system are stored:

#### Table 43: Directories on Local Disks on Cluster Nodes

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>A supported operating system [page 23]</td>
<td><code>%windir%</code></td>
</tr>
<tr>
<td>Microsoft Failover Clustering software</td>
<td><code>%windir%\Cluster</code></td>
</tr>
<tr>
<td>Application server (if installed locally)</td>
<td><code>&lt;Local_Drive&gt;\usr\sap\&lt;SAPSID&gt;\&lt;Instance&gt;</code></td>
</tr>
<tr>
<td>Enqueue replication server</td>
<td><code>&lt;Local_Drive&gt;\usr\sap\&lt;SAPSID&gt;\ERS\&lt;Instance_Number&gt;</code></td>
</tr>
<tr>
<td>Diagnostics Agent (optional)</td>
<td><code>&lt;Local_Drive&gt;\usr\sap\&lt;DASID&gt;\SMDA\&lt;Instance_Number&gt;</code></td>
</tr>
<tr>
<td>SAP Host Agent</td>
<td><code>%ProgramFiles%\SAP\hostctrl</code></td>
</tr>
</tbody>
</table>
| Oracle server software | Oracle 10g: `<Local_Drive>\oracle\<SAPSID>\102`  
Oracle 11g: `<Local_Drive>\oracle\<DBSID>\1120<version>`  
Oracle 12c: `<Local_Drive>\oracle\<Oracle_home_user>\<DBSID>\12102` |
| Oracle Fail Safe software | `<Drive>\oracle\OFS\<version>` |

#### Table 44: Directories on Shared Disks

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster quorum resource (if used)</td>
<td><code>&lt;Drive&gt;:\Cluster</code></td>
</tr>
<tr>
<td>SAP global and instance directories</td>
<td><code>&lt;Drive&gt;:\usr\sap ...</code></td>
</tr>
</tbody>
</table>
### Component Default Directory

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP data files</td>
<td><code>&lt;Drive&gt;:\ORACLE\&lt;SAPSID&gt;\&lt;SAPSID&gt;DATA1&lt;br&gt;...&lt;SAPSID&gt;DATA&lt;N&gt;</code></td>
</tr>
<tr>
<td>Online redo logs, set A</td>
<td><code>&lt;Drive&gt;:\ORACLE\&lt;SAPSID&gt;\origlogA</code></td>
</tr>
<tr>
<td>Online redo logs, set B</td>
<td><code>&lt;Drive&gt;:\ORACLE\&lt;SAPSID&gt;\origlogB</code></td>
</tr>
<tr>
<td>Mirrored online redo logs, set A</td>
<td><code>&lt;Drive&gt;:\ORACLE\&lt;SAPSID&gt;\mirrlogA</code></td>
</tr>
<tr>
<td>Mirrored online redo logs, set B</td>
<td><code>&lt;Drive&gt;:\ORACLE\&lt;SAPSID&gt;\mirrlogB</code></td>
</tr>
<tr>
<td>Archive of online redo logs</td>
<td><code>&lt;Drive&gt;:\ORACLE\&lt;SAPSID&gt;\oraarch</code></td>
</tr>
<tr>
<td>BR*TTools directories</td>
<td><code>...\sapreorg, \saptrace, \sapbackup, \sapcheck, \saparch</code></td>
</tr>
</tbody>
</table>

**i Note**

In a live system with excessive I/O activity, you must reserve at least three times the minimum amount of space specified above for the redo logs and mirrored redo logs.

### 8.2.4 IP Addresses in a Microsoft Failover Cluster Configuration

A part of the installation process that is unique to Microsoft Failover Clustering is the configuration of host names and IP addresses in the network. This is a particularly important task because the addressing plays a key role in the switchover procedure. Addressing must be set up correctly so that the system can take advantage of the cluster functionality and switch between nodes when hardware problems arise.

This section explains the different types of IP addresses and their function in the switchover mechanism of one Microsoft failover cluster with two cluster nodes.

**i Note**

As of Windows Server 2008, besides static IP addresses, you can also have DHCP-based (dynamic) IP addresses.

Currently DHCP-based IP configurations are not supported for high-availability SAP systems. If the virtual IP address of the SAP cluster group changes during a failover, your clients can no longer reach the system due to DNS caching.
Types of IP Addresses

In a properly configured cluster with at least two nodes, there are at least seven IP addresses and corresponding host names for your SAP system. You have two IP addresses for each cluster node, one IP address for the cluster, one for the SAP cluster group, and one for the database cluster group.

Some of the addresses are assigned to the network adapters (network interface card, NIC) whereas others are virtual IP addresses that are assigned to the cluster groups.

Physical IP Addresses Assigned to Network Adapters

A Microsoft failover configuration has two networks:

- A public network that is used for the communication between the central instance, application servers, and the LAN.
- A private network that is used internally for communication between the nodes of the cluster, also called heartbeat.

The following figure shows a Microsoft failover cluster with two nodes and illustrates the adapters required for the public and private networks, and their corresponding physical IP addresses. A physical IP address, in contrast to a virtual one, is stationary and permanently mapped to the same adapter.

![Figure 21: Adapters and IP Addresses Required for Public and Private Networks in an Microsoft Failover Cluster with Two Nodes](image)

Host Names Assigned to Network Adapters

Each of the physical IP addresses of the network adapters must have a corresponding host name. For example, on the left-hand node in the figure above, you might assign the IP addresses of the public and private network adapters as follows:

<table>
<thead>
<tr>
<th>Network Adapter</th>
<th>IP Address</th>
<th>Host Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter 1 (private network)</td>
<td>10.1.1.1</td>
<td>clusA_priv</td>
</tr>
</tbody>
</table>

Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to 7.02 on Windows: Oracle
High Availability with Microsoft Failover Clustering
### Network Adapter Information

<table>
<thead>
<tr>
<th>Network Adapter</th>
<th>IP Address</th>
<th>Host Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter 3 (heartbeat network)</td>
<td>192.168.1.1</td>
<td>clusA</td>
</tr>
</tbody>
</table>

### Caution

- The IP address and host name of the **public** network adapter is also the IP address and name of the machine. In our example, this means that the machine that is the cluster node on the left in the figure has the name **clusA**.
- Do **not** confuse the **host name** with the **computer name**. Each node also has a computer name, which is often the same as the host name.
  The computer name is displayed in the node column of the *Failover Cluster Management*. However, it is **not** required for the TCP/IP communication in the cluster. When you configure IP addresses and corresponding names, keep in mind that it is the **host names** that are important for the cluster, not the computer names.

### Virtual IP Addresses Assigned to Cluster Groups

After you have installed the SAP system and fully configured the cluster, the critical system resources are bound together in three different **groups**. Each of these groups requires a virtual IP address and network name that is permanently mapped to the group and not to a particular node. The advantage of this is that, whenever a group is moved between nodes, its IP address and network name move together with the group.

### Caution

If you have more SAP systems in the same Microsoft failover cluster, you need for each system an extra IP address and network name for the SAP and database cluster group.

A Microsoft failover configuration has the following groups:

- SAP cluster group for each clustered SAP system
- Database cluster group for each clustered SAP system
- Cluster group

The following figure illustrates how the virtual IP addresses of the database group and SAP group can move from one node to the other during a failover.
Obtaining IP Addresses for a Microsoft Failover Cluster Configuration

This chapter describes how to obtain the IP addresses for the network adapters (cards) that are required to install and run your high-availability system.

Context

For a clustered system, you have to configure IP addresses correctly. During the installation procedure you have to assign at least seven IP addresses and host names. You normally obtain these names and addresses from the system administrator.

Procedure

Ask the system administrator to give you the addresses and host names listed in the tables below, which show an example for a configuration with one Microsoft failover cluster with two nodes. You need to enter the addresses and host names later during the installation process.

The column Defined During indicates at which stage of the installation of the operating system and the SAP system the addresses are defined in the system.

Caution

Use the names exactly as specified by the system administrator.
Note: In the following tables we are still using the terminology **cluster group**, and not the Windows Server 2008 (R2) terminology **services and applications** or the Windows Server 2012 (R2) terminology **Roles**.

### Table 46: Physical IP Addresses

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Physical IP Address</th>
<th>Example for Physical Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>First cluster node: adapter for heartbeat network</td>
<td>10.1.1.1</td>
<td>clusA_priv</td>
<td>Address for internode communication on the heartbeat network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>First cluster node: adapter for public network</td>
<td>129.20.5.1</td>
<td>clusA</td>
<td>Address of the first cluster node for communication with application servers and LAN (this is the same as the address of the first cluster node)</td>
<td>Windows installation</td>
</tr>
<tr>
<td>Additional cluster node: adapter for heartbeat network</td>
<td>10.1.1.2</td>
<td>clusB_priv</td>
<td>Address for internode communication on the heartbeat network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>Additional cluster node: adapter for public network</td>
<td>129.20.5.2</td>
<td>clusB</td>
<td>Address of the additional cluster node for communication with application servers and LAN (this is the same as the address of the additional cluster node)</td>
<td>Windows installation</td>
</tr>
</tbody>
</table>

### Table 47: Virtual IP Addresses

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Virtual IP Address</th>
<th>Example for Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster group</td>
<td>129.20.5.3</td>
<td>clusgrp</td>
<td>Virtual address and name of the cluster group. It identifies the cluster and is used for administration purposes.</td>
<td>Failover cluster software installation</td>
</tr>
</tbody>
</table>
### 8.3 Preparation

This section provides information about how to prepare the installation of the SAP system for Microsoft Failover Clustering. For a complete list of all steps, see section *Preparation* in the *Installation Checklist for a High-Availability System* [page 180].

1. You check that you have completed the same preparations [page 50] as for a non-HA system.
2. To make sure that all preparation steps have been correctly performed, check that you can move the disk resources from one cluster node to another so that they are accessible from a single node at any time.

### 8.4 Installation

The following sections provide information about how to install the SAP system in a high-availability environment. For a complete list of all steps, see section *Installation* in the *Installation Checklist for a High-Availability System* [page 180].

Due to a SAP MaxDB technical restriction, the use of passwords longer than nine characters is not possible in an MSCS environment. For more information, see SAP Note [2319006](https://support.sap.com/note?accum_id=2319006).  

### 8.4.1 Installing the Oracle Fail Safe Software

To use the cluster functionality for the Oracle database, you have to install the Oracle Fail Safe (OFS) software.
Continue with the section relevant for the release of the Oracle database:

- Installing the Oracle Fail Safe Software for Oracle 10g [page 200]
- Installing the Oracle Fail Safe Software for Oracle 11g and 12c [page 203] and Installing the Latest OFS Patch [page 205].

To check which OFS version is supported for your database and operating system, see SAP Note 1972760.

### 8.4.1.1 Installing the Oracle Fail Safe Software for Oracle 10g

**Use**

This section describes how to install the Oracle 10g Fail Safe server software.

If you use a 64-bit system you first have to install the 64-bit Fail Safe server software, and then the 32-bit Fail Safe client software.

For more information about the latest OFS version for release 10g, see SAP Note 1972760.

**Prerequisites**

- You have installed the Oracle database software [page 64] locally on all cluster nodes, using the same `<Oracle_home>.
- In the Cluster Administrator (Windows Server 2003) or Failover Cluster Manager (Windows Server 2008 R2) make sure that the:
  - Other cluster node(s) is not set to Pause.
  - SAP group is offline on the node where you are installing.
- Make sure that the Cluster Server service is running on all cluster nodes.
- For a domain user, you must use the syntax `<domain_name>\<user_name>`. The Oracle Fail Safe software is not able to handle the syntax `<user_name>@<domain>`.
- You have to install the Oracle Fail Safe (OFS) software on all cluster nodes. Do not install the Fail Safe software in parallel on all cluster nodes. You must install it on one cluster node at a time.

**Procedure**

1. To install the 64-bit Fail Safe server software, start the Oracle Universal Installer from the Oracle RDBMS media by double-clicking the file `setup.exe` for your 64-bit platform:
2. Enter the required information as shown in the following table:

Table 48:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Choose Next</td>
</tr>
<tr>
<td>File Locations</td>
<td>Source...</td>
</tr>
<tr>
<td></td>
<td>For Path: The path to the Oracle software on the media is displayed. Do not change the path.</td>
</tr>
<tr>
<td></td>
<td>Destination...</td>
</tr>
<tr>
<td></td>
<td>For Name: Enter the name of the &lt;Oracle_home&gt; for the Fail Safe software. The Fail Safe software must be installed in a separate &lt;Oracle_home&gt; directory, for example OFSSRV. Use the same &lt;Oracle_home&gt; for both nodes.</td>
</tr>
<tr>
<td></td>
<td>For Path: Enter the path of the &lt;Oracle_home&gt; directory for the Fail Safe software. It must be on a local disk, for example: F:\Oracle\OFS\SRV</td>
</tr>
<tr>
<td></td>
<td>Choose Next</td>
</tr>
<tr>
<td>Installation Types</td>
<td>Choose Typical.</td>
</tr>
<tr>
<td>Reboot Needed After Installation</td>
<td>Choose Next.</td>
</tr>
<tr>
<td>Summary</td>
<td>View the information and choose Install.</td>
</tr>
<tr>
<td>Install</td>
<td>Wait while the software is installed.</td>
</tr>
<tr>
<td>Configuration Tools</td>
<td>On the dialog box Oracle Fail Safe Account/Password, enter the account and password under which the Fail Safe software is to run. This must be the same account as the one under which the Cluster Server service is running.</td>
</tr>
<tr>
<td></td>
<td>To find out which account must be entered, do the following:</td>
</tr>
<tr>
<td></td>
<td>1. Windows Server 2012 (R2): Press Ctrl + ESC and choose Administrative Tools Services...</td>
</tr>
<tr>
<td></td>
<td>2. Windows Server 2003 and Windows Server 2008 (R2): Choose Start Control Panel Administrative Tools Services...</td>
</tr>
<tr>
<td></td>
<td>3. Select the Cluster Service and choose Startup... The log on account for the service is displayed. Enter this account for Oracle Fail Safe Account/Password...</td>
</tr>
</tbody>
</table>
3. To install the 32-bit Fail Safe client software, start the *Oracle Universal Installer* from the Oracle RDBMS media by double-clicking the file `setup.exe`.

4. Enter the required information as shown in the following table:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Choose <em>Exit</em> to close the Oracle Universal Installer.</td>
</tr>
<tr>
<td>Source...</td>
<td>For <em>Path</em>: The path to the Oracle software on the media is displayed. Do <em>not</em> change the path.</td>
</tr>
<tr>
<td>Destination...</td>
<td>For <em>Name</em>: Enter the name of the <code>&lt;Oracle_home&gt;</code> for the Fail Safe software. The Fail Safe software must be installed in a separate <code>&lt;Oracle_home&gt;</code> directory, for example <code>OFSCLI</code>. Use the same <code>&lt;Oracle_home&gt;</code> for all cluster nodes.</td>
</tr>
<tr>
<td>Path:</td>
<td>For <em>Path</em>: Enter the path of the <code>&lt;Oracle_home&gt;</code> directory for the Fail Safe software. It must be on a local disk, for example: <code>F:\Oracle\OFS\CLI</code></td>
</tr>
<tr>
<td>x64: Select <em>Oracle Fail Safe 3.4</em> and choose <em>Next</em>.</td>
<td></td>
</tr>
<tr>
<td>IA64: Select <em>Oracle Fail Safe 3.3.4.0.0</em> and choose <em>Next</em>.</td>
<td></td>
</tr>
<tr>
<td>Choose <em>Client Only</em>.</td>
<td></td>
</tr>
<tr>
<td>View the information and choose <em>Install</em>.</td>
<td></td>
</tr>
<tr>
<td>Wait while the software is installed.</td>
<td></td>
</tr>
<tr>
<td>Choose <em>Exit</em> to close the Oracle Universal Installer.</td>
<td></td>
</tr>
</tbody>
</table>

5. Reboot and log on again.

**Caution**

- Do not reboot a cluster node, if the installation of the OFS software is in progress on another cluster node.
- When you reboot during the conversion to failover clustering, resources fail over to the other cluster node. Therefore, after each reboot you have to return the system to the state it was in before the reboot.
8.4.1.2 Installing the Oracle Fail Safe Software for Oracle 11g and 12c

Use

This section describes how to install the Oracle Fail Safe software, which you need to use the cluster functionality for the Oracle database.

Prerequisites

- You have installed the Oracle database software [page 64] locally on all cluster nodes, using the same <Oracle_home>.
- In the Failover Cluster Manager make sure that the other cluster node(s) are not set to Pause
- Make sure that the Cluster Server service is started on all cluster nodes.
- For a domain user, you must use the syntax <domain_name><user_name>. The Oracle Fail Safe software is not able to handle the syntax <user_name>@<domain>.
- You have to install the Oracle Fail Safe (OFS) software on all cluster nodes. Do not install the Fail Safe software in parallel on all cluster nodes. You must install it on one cluster node at a time.

Procedure

1. Start the Oracle Universal Installer from the Oracle RDBMS media.
   - If you use the Start menu, double-click the following file:
     <media_drive>:\<OFS_version>\SAP\sapofs.cmd
   - If you use a PowerShell script, enter the following command:
     <media_drive>:\<OFS_version>\SAP\sapofs.ps1
   The installer opens and guides you through the installation process.
2. Enter the required information as shown in the following table:

   ![Note Image]

   If the installer aborts and an error is displayed in an Application Error window with the text The exception unknown software exception ..., check the TMP and TEMP variables. In the user environment of <SAPSID>adm, make sure that these refer to existing files. If not, reset them.

   Table 50:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Choose Next.</td>
</tr>
<tr>
<td>Screen</td>
<td>Entry</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Select Installation Type</strong></td>
<td>Choose Typical, and then Next.</td>
</tr>
<tr>
<td><strong>Specify Home Details</strong></td>
<td>For Name: Enter the name of the Oracle home for the Oracle Fail Safe software. Make sure you use the same Oracle home name on all cluster nodes. The Fail Safe software must be installed in a separate Oracle home directory, for example, <strong>OFS421</strong> For Path: Enter the path of the Oracle Home directory for the Oracle Fail Safe software. It must be on a local disk and should have the same name on all cluster nodes, for example: <strong>C:\Oracle\OFS421</strong></td>
</tr>
<tr>
<td><strong>Reboot Needed After Installation</strong></td>
<td>Choose Next.</td>
</tr>
<tr>
<td><strong>Summary</strong></td>
<td>View the information and choose Install.</td>
</tr>
<tr>
<td><strong>Install</strong></td>
<td>Wait while the software is installed.</td>
</tr>
</tbody>
</table>
| **Configuration Tools**                     | In the dialog box *Oracle Fail Safe Account/Password*, enter the account and password under which the Oracle Fail Safe software is to run. The account has to be a member of the local administrators and the *ora_<dbsid>dba* or *ora_dba* groups on both cluster nodes. Although the *<SAPSID>adm* user fulfills these requirements, we do not recommend using this user for the following reason: If you choose to use *<SAPSID>adm*, you have to update the account information for the Oracle Services for MSCS Service after every password change of the *<SAPSID>adm* user. You can change the user and password for Oracle Services for MSCS Service as follows: ○ Windows Server 2012 (R2): To do this, press Ctrl + Esc and then Ctrl + Tab. Choose group *Oracle • <OFS_Home_Name>*. Set Credentials. You can also open a PowerShell in elevated mode, and enter the following command: `<ORACLE_OFS_home>\FailSafe\Server \Oracle.FailSafe.ServerConfig.exe SetCredentials` ○ Windows Server 2008 (R2): To do this, choose Start > All Programs > Oracle OFS for MSCS Security Setup > Oracle Service on all cluster nodes.
3. Reboot and log on again.

**Caution**
- Do not reboot a cluster node, if the installation of the OFS software is in progress on another cluster node.
- When you reboot during the conversion to failover clustering, resources fail over to the other cluster node. Therefore, after each reboot you have to return the system to the state it was in before the reboot.

4. Install the latest OFS Patch [page 205].

### 8.4.1.3 MSCS Only: Installing the Latest Oracle Fail Safe Patch Set

**Use**

For more information on the latest note Oracle Fail Safe patch set, see SAP Note 1972760.

You have to perform the following procedure on all cluster nodes.

**Procedure**

1. Download the OFS patch set from [https://support.sap.com/software/databases.html](https://support.sap.com/software/databases.html) and install the patch set as described in SAP Note 1865953.

### 8.4.2 Configuring the First Cluster Node

**Use**

The following procedure describes how to configure the first cluster node.

When you run the **First Cluster Node** option it:
- Creates the `saploc` share, pointing to a local disk
- Creates the `sapmnt` share, pointing to a local disk
- Installs the central services instance (SCS) and prepares this host as the SAP global host
• Creates the SAP cluster group and adds the SCS instance to the SAP cluster group
• Installs the enqueue replication server instance (ERS instance) for the SCS instance
• Installs the SAP Host Agent

⚠️ Caution

When you reboot during the conversion to failover clustering, resources fail over to the other cluster node. Therefore, after each reboot, you have to return the system to the state it was in before the reboot, and move the resources back to the original node.

Prerequisites

• You are logged on to the first cluster node as domain administrator or as a local user with domain administration rights. For more information, see Performing a Domain Installation without being a Domain Administrator [page 135].
• You must install the SCS instance on a shared disk, and the ERS instance and SAP Host Agent on a local disk.

Procedure

1. Run the installer and choose:
   ![Product] ![System] ![Database] ![High-Availability System] ![First Cluster Node]

   **Note**
   If the installer prompts you to log off from your system, log off, and log on again.

2. Enter the required parameter values.

   **Note**
   ○ For more information about the input parameters, position the cursor on a parameter and press F1 in the installer.
   ○ If you have a Microsoft cluster configuration with more than two nodes in one cluster, apply SAP Note 1634991.

More Information

Moving Cluster Groups or Services and Applications or Roles [page 219]
8.4.3 Creating the Oracle Fail Safe Group

You perform the following steps in the Fail Safe Manager on the first cluster node.

Procedure

Creating the OFS Group with OFS Version 4.1

1. You have installed the PowerShell scripts for Microsoft Failover Clustering. For more information, see SAP Note 1976879. 
2. Open PowerShell in elevated mode change to the following directory:  
   `<Oracle_Home>\sap\ora_mscs`
4. Enter the required parameters.

    **Caution**

    Do **not** use blanks in the Oracle cluster group name.

5. Add the shared database disk to the resource group as follows:
   1. Start the Failover Cluster Manager with  
      ![Start Administrative Tools Failover Cluster Manager](image)
   2. Select group Storage.
   3. Right-click the shared database disk, and choose More Actions  
      ![Move this resource to another service or application](image)

Creating the OFS Group with OFS Version 3.4.2

The following procedure applies for Windows Server 2008 (R2).

    **Note**

    OFS 3.4.2 is not supported on Windows Server 2012 (R2):

1. Start the Oracle Fail Safe Manager on Windows Server 2008 (R2) as follows:
   Choose ![Start Programs Oracle - OFSClient_Home Oracle Fail Safe Manager](image)
   The first time, you add the OFSClient, the window Add Cluster To Tree appears.
   Perform the following steps:
   1. Insert your virtual cluster name.
   2. Right-click the cluster and choose Connect to cluster.
   3. Enter the following and then confirm your entries with OK:

   Table 51:

<table>
<thead>
<tr>
<th><strong>User name</strong></th>
<th><code>&lt;user&gt;</code> (Oracle Fail Safe account – for more information, see Installing the Oracle Fail Safe Software [page 203])</th>
</tr>
</thead>
</table>
4. In the Welcome dialog box, choose Verify Cluster.

**Note**

All cluster nodes must be up and running for this step.

The window Clusterwide Operation: Verifying Fail Safe Cluster shows the steps that are executed to verify the cluster. When you are informed that the operation has completed successfully, close the window.

2. In the Oracle Fail Safe Manager window, create the Fail Safe group Oracle<DBSID>.

Choose Groups > Create.

The window Create Group:... appears.

3. Enter the Group Name ORACLE<DBSID>.

**Caution**

Do not user blanks in the group name.

In answer to the question Do you want to allow the group to failback to preferred node?, select Prevent failback.

The window Finish Creating the Group appears and displays information about the group. Choose OK.

4. In the window Add Virtual Address, select Yes to indicate that you want to add a virtual address to the group.

The Add Resource to Group: - Virtual Address appears.

5. Select Show networks accessible by clients.

Under Network the entry for your public network appears.

Under Virtual Address, for Host Name, enter the <Virtual_Hostname> of the database host.

The IP Address is automatically recognized.

Choose Finish.

The window Add the Virtual Address to the Fail Group appears.

Choose OK.

**Note**

If the Fail Safe Manager cannot create the Fail Safe group, look at the Windows Event Logs on all cluster nodes to find out the reason for the failure.

6. Add the shared database disk to the resource group as follows:


2. Select group Storage.

3. Right-click the shared database disk, and choose More Actions > Move this resource to another service or application.
8.4.4 Installing the Database Instance

Use

This procedure describes how to install the database instance on the first cluster node.

Prerequisites

- The SAP cluster group is Online on the first cluster node.
- The Oracle shared disk is Online on the first cluster node.
- The Oracle cluster group is Online on the first cluster node.

Procedure

Perform the following steps on the first cluster node.

1. Run the installer [page 85] and on the Welcome screen, choose:
   ```
   <Product> <System> <Database> High-Availability System Database Instance
   ```

   **Caution**
   
   The following only applies if you use multiple Oracle Homes:

   - You must have one ORACLE_HOME per database instance on every cluster node on local disks.
   - All ORACLE_HOMES must use the same disks and directories and ORACLE_HOME names on all DB cluster nodes.
   - Since each ORACLE_HOME uses its own Oracle Listener, you must specify unique Oracle TCP/IP port numbers for every database in the DB failover cluster.
     Use 1527 for the first database, 1526 for the second database, 1525 for the third, and so on.

2. Follow the instructions in the installer dialogs and enter the required parameter values.
   1. For the profile UNC path you have to use the UNC path of the virtual (A)SCS host name, for example:
      ```
      \<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
      ```
      In an HA-system, the virtual host name of the (A)SCS instance is the same as the SAP global host name.
   2. When the installer prompts you for the database host, make sure that you enter the virtual database host.

   **Caution**
   
   By default, the installer locates the saparch, sapreorg, sapcheck, and saptrace directories on the last available drive. If this is a local drive, you must specify that these directories reside on a shared disk by using Advanced Database Options, which you can find on the screen Oracle > Database Instance. Continue with Next until you can select Windows Drive Mapping. Check the box and choose Next. Then relocate all folders to a shared disk.
8.4.5 Setting Up a Shared Database Directory in Oracle Home

This section describes how to set up a shared database directory in the Oracle home.

The Oracle database uses an spfile. With an spfile you can set up a central (shared) directory <Oracle_Home>\database for Microsoft failover clustering with a junction.

A central directory <Oracle_Home>\database has the following advantages:

- You can also use sqlplus remotely to make changes to your profile parameters.
- You only have to make the changes in the parameter files once in the shared <Oracle_Home>\database-directory.

**Note**

In the past, you had to apply all changes in the parameter file init<DBSID>.ora in the <Oracle_Home>\database-directories on all cluster nodes.

### Procedure

**Setting Up a Shared Database Directory in Oracle Home for OFS 4.1**

1. Stop the Oracle database using sqlplus.
2. Stop the Oracle Service OracleService<DBSID>.
3. In the sapdata1 directory on the shared disk in the cluster, create the directory database:
   <Shared_Disk>:\ORACLE\<DBSID>\sapdata1\database
4. On the first cluster node, change to the <Oracle_Home>\database directory, and enter the following command in the command prompt:
   move * <Shared_Disk>:\ORACLE\<DBSID>\sapdata1\database
5. Delete the directory <Oracle_Home>\database with the command:
   rd /q /s database

**Note**

You can also use the Windows Explorer to delete the directory.
6. Create the junction with the following command:
   ○ Windows Server 2012 (R2):
     Open PowerShell in elevated mode, and enter the following command:
     ```
     cmd /c mklink /d <Oracle_Home>\database <Shared_Disk>:\ORACLE\<DBSID>\sapdata1\database
     ```
   ○ Windows Server 2008 (R2):
     Create the junction with the following command:
     ```
     mklink /d <Oracle_Home>\database <Shared_Disk>:\ORACLE\<DBSID>\sapdata1\database
     ```
7. Select the resource group Oracle<DBSID> and move it to the additional cluster node.
8. Repeat steps 5 and 6 on the additional cluster node.
9. Create the init<DBSID>_OFS.ora file in the database directory, and enter the following line:
    ```
    spfile = <Path_To_Oracle_Home>\database\SPFILE<DBSID>.ora
    ```

**Setting Up a Shared Database Directory in Oracle Home for OFS 3.4.2**

1. Stop the Oracle database using `sqlplus`.
2. Stop the Oracle Service OracleService<DBSID>.
3. In the sapdata1 directory on the shared disk in the cluster, create the directory database:
   ```
   <Shared_Disk>:\ORACLE\<DBSID>\sapdata1\database
   ```
4. On the first cluster node, change to the <Oracle_Home>\database directory, and enter the following command in the command prompt:
   ```
   move * <Shared_Disk>:\ORACLE\<DBSID>\sapdata1\database
   ```
5. Delete the directory <Oracle_Home>\database with the command:
   ```
   rd /q /s database
   ```
   **Note**
   You can also use the Windows Explorer to delete the directory.

6. Create the junction with the following command:
   ○ Windows Server 2008 (R2) and Windows Server 2012 (R2):
     Create the junction with the following command:
     ```
     mklink /j <Oracle_Home>\database <Shared_Disk>:\ORACLE\<DBSID>\sapdata1\database
     ```
   7. Select the resource group Oracle<DBSID> and move it to the additional cluster node.
   8. Repeat steps 5 and 6 on the additional cluster node.
   9. Create the init<DBSID>_OFS.ora file in the database directory, and enter the following line:
      ```
      spfile = <Path_To_Oracle_Home>\database\SPFILE<DBSID>.ora
      ```
8.4.6 Adding the Oracle Database Resource to the Fail Safe Group

This section describes how to add the Oracle Database Resource to the Fail Safe Group.

Adding the Oracle Database Resource to the Fail Safe Group for OFS 4.1

1. Copy the sqlnet.ora file from the directory <ORACLE_HOME>\network\admin on the first cluster node to the same directory on the additional cluster nodes.
2. Change to the directory <Oracle_Home>\sap\ora_mscs.
3. Right-click the script AddOracleDbToOracleClusterGroup.ps1 and choose Run with PowerShell.
4. Enter the required parameters:
   1. Enter the <DBSID> of your Oracle database.
   2. Enter the path and file name of your Oracle parameter file on the shared cluster disk:  
      <Shared_Disk>\ORACLE\<DBSID>\SAPDATA1\DATABASE\INIT\<DBSID>_OFS.ORA
5. Copy tnsnames.ora from %ORACLE_HOME%\network\admin to <sapglobalhost>\sapmnt\<SAPSID>\SYS\profile\oracle.

Adding the Oracle Database Resource to the Fail Safe Group for OFS 3.4.2

1. Copy the sqlnet.ora file from the directory <ORACLE_HOME>\network\admin on the first cluster node to the same directory on the additional cluster nodes.
2. Start the Oracle Fail Safe Manager on Windows Server 2008 (R2) and Windows Server 2012 (R2) as follows:
   Choose Start ➤ Programs ➤ Oracle - <Fail_Safe_Home_Name> ➤ Oracle Fail Safe Manager
3. If the Welcome dialog box appears, choose Verify Cluster. Otherwise, right-click the cluster and choose Verify Cluster.

   Note
   All cluster nodes must be up and running for this step.

   The window Verifying Cluster shows the steps that are executed to verify the cluster. When you are informed that the operation has completed successfully, close the window.
4. Add the SAP database to the cluster group Oracle<DBSID>:
   1. In the tree on the left, choose Nodes ➤ First Cluster Node ➤ Standalone Resources
   2. Select the database <DBSID>.world
   3. Choose Add to Group.
5. In the dialog box Add Resource to Group – Resources:
   For Resource Type, select Oracle Database.
   For Group name, select Oracle<DBSID>.
   Choose Next.
6. In the dialog box *Add Resource to Group – Database Identity*, enter the following information:

<table>
<thead>
<tr>
<th>Service Name</th>
<th>&lt;DBSID&gt;.world</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Name</td>
<td>&lt;DBSID&gt;</td>
</tr>
<tr>
<td>Database Name</td>
<td>&lt;DBSID&gt;</td>
</tr>
<tr>
<td>Parameter File</td>
<td>&lt;Shared_Drive&gt;:&lt;ORACLE_HOME&gt;\oracle&lt;DBSID&gt;\sapdata1\database\init&lt;DBSID&gt;_OFS.ora</td>
</tr>
</tbody>
</table>

7. When you have made all entries, choose *Next*.

8. In the dialog box *Add Resource to Group – Database Authentication*:
   - Select *Use SYS account*.
   - Enter and confirm the password.

9. Choose *Finish*.

10. In the dialog box *Finish Adding the Database to the Group*, choose *OK* to add the database resource to the group.

11. In the dialog box *Confirm Add database to Group*, choose *Yes*.
    *The Adding resource <DBSID>.world to group window, shows the steps that are executed to add the database to the cluster group.*

12. Copy tnsnames.ora from %ORACLE_HOME%\network\admin to \\<sapglobalhost>\sapmnt\<SAPSID>\SYS\profile\oracle.

### 8.4.7 Configuring the Additional Cluster Node

**Use**

This procedure describes how to configure the additional cluster node.

When you run the *Additional Cluster Node* option it:

- Configures the additional cluster node to run the SAP cluster group
- Creates the *saploc* share, pointing to a local disk
- Installs the enqueue replication server instance (ERS) for the SCS instance
- Installs the SAP Host Agent

**Caution**

- You must install the ERS and SAP Host Agent on a local disk.
- When you reboot during the conversion to failover clustering, resources fail over to the other cluster node. Therefore, after each reboot, you have to return the system to the state it was in before the reboot, and move the resources back to the original node.
Prerequisites

- You are logged on to the additional cluster node as domain administrator or as a domain user who is a local administrator on all cluster nodes. For more information, see Performing a Domain Installation without being a Domain Administrator [page 135].
- You have already performed the First Cluster Node [page 205] option.

Procedure

1. Run the installer and choose:
   `<Product> <System> <Database> High-Availability System Additional Cluster Node`

   **Note**
   If the installer prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.

   **Note**
   - For more information about the input parameters, position the cursor on the parameter and press F1 in the installer.

   When you have made all required entries, the installer begins processing and converts the SAP instances on the other cluster node for operation in Microsoft failover clustering.

More Information

Moving Cluster Groups or Services and Applications or Roles [page 219]

8.4.8 Additional Steps for the Oracle Fail Safe Configuration

Use

To complete the Oracle Fail Safe configuration, you must perform the following steps:

- Adjusting security settings
  Oracle only allows the use of computer local groups to identify database operators and administrators. Therefore, the local groups that were created on the first cluster node are not known on the other cluster node(s). This means that you have to create these groups manually and grant them access to the database directories.
- Additional steps for a standalone clustered database – see Additional Steps for Clustered Database Instance Running Separately in One Cluster at the end of this section
Procedure

1. On the additional cluster node(s), create the local groups `ORA_<dbsid>_DBA` and `ORA_<dbsid>_OPER`, and add `<sapsid>adm`, and `SAPService<sapsid>` to these groups.

```
Example

net localgroup ORA_<DBSID>_DBA /add
net localgroup ORA_<DBSID>_OPER /add
net localgroup ORA_<DBSID>_DBA <sapsid>adm /add
net localgroup ORA_<DBSID>_OPER <sapsid>adm /add
net localgroup ORA_<DBSID>_DBA SAPService<sapsid>/add
net localgroup ORA_<DBSID>_OPER SAPService<sapsid> /add
net localgroup ORA_<DBSID>_DBA <Oracle_home_user>/add
net localgroup ORA_<DBSID>_OPER <Oracle_home_user>/add
```

2. Create additional domain groups (only once per database SID) and add the relevant users to these groups.

```
Example

net group ORA_<DBSID>_DBA /add /domain
net group ORA_<DBSID>_OPER /add /domain
net group ORA_<DBSID>_DBA <SAPSID>adm /add /domain
net group ORA_<DBSID>_DBA SAPService<SAPSID> /add /domain
net group ORA_<DBSID>_OPER <SAPSID>adm /add /domain
net group ORA_<DBSID>_OPER SAPService<SAPSID>/add /domain
net group ORA_<DBSID>_DBA <Oracle_home_user>/add /domain
net group ORA_<DBSID>_OPER <Oracle_home_user>/add /domain
```

3. On all cluster nodes, add the domain groups to the local Oracle groups as follows:

```
net localgroup ora_<DBSID>_DBA <domain>\ORA_<DBSID>_DBA /add
net localgroup ora_<DBSID>_OPER <domain>\ORA_<DBSID>_OPER /add
```

4. On all oracle\<dbsid> directories on the shared disk drives, adjust the security settings as follows:

1. Right-click \oracle\<dbsid> and select Properties.

```
i Note

You can select multiple directories before you right-click to adjust the security settings.
```

2. Select the Security tab, add both domain groups `ORA_<dbsid>_DBA` and `ORA_<dbsid>_OPER` to the Group or Users list and grant these domain groups Full Control.

3. Choose Advanced and check Replace all existing inheritable permissions on all descendants with inheritable permissions from this object (Windows Server 2008), or Replace all child object permissions with inheritable permissions from this object (Windows Server 2008 R2).
Additional Steps for Clustered Database Instance Running Separately in One Cluster

If you have not installed the (A)SCS instance and the database instance together in one cluster, but run the database instance in a separate Microsoft failover cluster, you have to perform the following steps on the database cluster:

1. On each additional cluster node, grant the user rights by adding the `<DBSID>adm` user to the local Administrators group.
2. Copy the user environment of the database user `<DBSID>adm` as follows:
   1. Log on to the first cluster node as the user `<DBSID>adm`.
   2. Run `regedit.exe` and right-click `HKEY_CURRENT_USER\Environment`.
   3. Choose `Export` to export the environment key to a file.
   4. On each additional cluster node, log on as user `<DBSID>adm`.
   5. Import the exported registry key to the registry by executing the `.reg` file.
3. Enable the DB13 support on standalone database servers by setting up a standalone Gateway as described in SAP Note 1764650.
   You have to perform this step on all cluster nodes and for each database instance.

8.4.9 Installing the Central Instance

Use

The following procedure describes how to install the central instance for Microsoft Failover Clustering.

You have the following options to install the central instance:

- You install the central instance on a cluster node.
  In this case, bring the SAP cluster group online on this node, and make sure that the central instance number is different from the (A)SCS instance number.
- You install the central instance on a host outside of the Microsoft failover cluster.

Procedure

1. Run the installer [page 85] and choose:
   ![Product] > [System] > [Database] > [High-Availability System] > [Central Instance]
2. If the installer prompts you to log off, choose OK and log on again.
3. Follow the instructions in the installer dialogs and enter the required parameter values.
4. Check that the central instance is running.

8.4.10 Installing the Dialog Instance

Use

You have to install at least one dialog instance for a high-availability configuration. You have the following options to install the dialog instance:

- You install the dialog instance on a cluster node.
  In this case, bring the SAP cluster group online on this node, and make sure that the dialog instance number is different from the (A)SCS instance number.
- You install the dialog instance on a host outside of the Microsoft failover cluster.

Procedure

1. Run the installer [page 85] and choose:
   \<Product> \System \Database \High-Availability System \Dialog Instance

2. If the installer prompts you to log off, choose OK and log on again.
3. Follow the instructions in the installer dialogs and enter the required parameter values.

Note

- For more information about the input parameters, position the cursor on a parameter and press F1 in the installer.
- If you install the dialog instance on an cluster node, make sure that on the screen SAP System > General Parameters for the:
  - Profile Directory, you use the UNC path of the virtual (A)SCS host name, for example: \\
    \<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
  In a HA-system, the virtual host name of the (A)SCS instance is the same as the SAP global host name.
  - Installation Drive, you choose the local disk where you want to install the central instance.
- Installation Drive, you choose the local disk where you want to install the central instance.

- Dialog instance, you enter the same instance number as for the central instance.
4. When you have finished, change the instance profile of the dialog instance so that the number of its work processes equals the number of work processes of the central instance.

5. If required, install additional dialog instances outside of Microsoft failover cluster.

**Note**

Make sure that on the screen SAP System > General Parameters for the Profile Directory, you use the UNC path of the virtual (A)SCS host name, for example:

\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

In a HA-system, the virtual host name of the (A)SCS instance is the same as the SAP global host name.

### 8.5 Post-Installation

To complete and check the installation of the SAP system for a high-availability configuration, you need to perform the following steps:

1. You perform the post-installation checks for the enqueue replication server.
   For more information, see the SAP Library at:

2. If required, you perform the general post-installation steps [page 102] listed in this guide.

### 8.6 Additional Information

The following sections provide additional information about:

- Moving Cluster Groups, or Services and Applications, or Roles [page 219]
- Starting and Stopping the SAP System in a Microsoft Failover Cluster Configuration [page 221].
8.6.1 Moving Cluster Groups, or Services and Applications, or Roles

Use

When you reboot during the conversion to Microsoft Failover Clustering, cluster resources fail over to the other cluster node. Therefore, you have to return the system to the state it was in before the reboot, and move the resources back to the original node.

To move the database, SAP, or disk cluster groups from one cluster node to the other, you use the following:

- **PowerShell** (Windows Server 2012 (R2) and higher)
- **Failover Cluster Manager** (Windows Server 2008 (R2))

**Note**

With Oracle, you can also use the **Fail Safe Manager**.

**Note**

As of Windows Server 2008 (R2) there are the following terminology changes:

- Cluster groups are called **services and applications** (Windows Server 2008 (R2), or **Roles** (Windows Server 2012 (R2) and higher)
- We do not always use all names in this section.
- The **Cluster Administrator** is now called **Failover Cluster Manager**.

Prerequisites

Windows Server 2008 (R2):

The services or applications you want to move are configured and are visible in the **Failover Cluster Manager**.

Procedure

**Moving Roles, or Services and Applications, or Groups**

To move the roles (Windows Server 2012 (R2) and higher) or services and applications (Windows Server 2008 (R2)), proceed as follows:

- Windows Server 2012 (R2) and higher:
  1. To move a role, open PowerShell in elevated mode, and enter the following command:
     
     ```
     move-clustergroup "<role name>"
     ```
  2. Repeat these steps for each role that you want to move.
Windows Server 2008 (R2):
You use the Failover Cluster Manager to move services and applications that do not belong to the database groups.

2. In the Failover Cluster Manager, right-click the service and application you want to move.
3. Choose Move this service or application to another node > Move to <relevant node>.
4. Repeat the previous step for each service and application that you want to move.

i Note
You can only move disks that are assigned to Services and Applications (Windows Server 2008 (R2)) or Roles (Windows Server 2012 (R2) and higher).

The disks that are added to the cluster are automatically added to a group named Available Storage. Although the groups Available Storage and Cluster Group exist in a failover cluster on Windows Server 2008 (R2) or higher, they are not visible under Services and Applications (Windows Server 2008 (R2)) or Roles (Windows Server 2012 (R2) and higher). Therefore, you cannot move these groups with the Failover Cluster Manager.

- If you use Windows Server 2012 (R2) and higher, proceed as follows:
  - To move Cluster Group, open PowerShell in elevated mode, and enter the following command:
    ```
    move-clustergroup "cluster group"
    ```
  - To move Available Storage, open PowerShell in elevated mode, and enter the following command:
    ```
    move-clustergroup "Available Storage"
    ```
- If you use Windows Server 2008 (R2) proceed as follows:
  - To move Cluster Group, open a command prompt and enter:
    ```
    cluster group "cluster group" /move
    ```
  - To move Available Storage, open a command prompt and enter:
    ```
    cluster group "Available Storage" /move
    ```

Moving Oracle Groups with the Fail Safe Manager
You use the Fail Safe Manager to move the Oracle resources, for example, the Oracle database group.

1. Start the Fail Safe Manager as follows.
   - Windows Server 2012 (R2) and higher:
     - Press Ctrl + ESC and Ctrl + TAB, choose Oracle Fail Safe Manager.
   - Windows Server 2008 (R2):
     - Start the Fail Safe Manager with Start > All Programs > Oracle <Home_Name_fail safe> > Oracle Fail Safe Manager.
2. On the left-hand pane, right-click the group you want to move, and choose Move to a Different Node on the context menu.
   - The group is now moved to another cluster node.
8.6.2 Starting and Stopping the SAP System in a Microsoft Failover Cluster Configuration

Use

An SAP high-availability system with Microsoft Failover Clustering is typically configured into two cluster groups: one cluster resource group contains the database resources, the other group contains the SAP (A)SCS instance.

Note

When starting a whole SAP system, you first need to start the database instance and then the remaining SAP instances.

When stopping a whole SAP system, you first need first to stop all SAP instances and then the database instance.

With the SAP MMC, or SAPControl you can start and stop the clustered or non-clustered SAP instances – except the clustered database and (A)SCS instance.

With certain HA administration tools (Cluster Administrator, Failover Cluster Manager, or PowerShell), you can only start or stop a clustered SAP instances, such as the (A)SCS instance or the database instance.

Procedure

Starting and Stopping a Complete System or a Single Instance with SAP MMC or SAPControl

With the SAP MMC, or the command line tool SAPControl, you can start or stop the complete SAP system or a single clustered or non-clustered SAP instance, except the database instance.

To start or stop the database instance, you have to use the tools described in “Starting and Stopping the clustered (A)SCS and Database Instance”.

For more information about SAP MMC or SAPControl, see Starting and Stopping the SAP System [page 151].

Note

- To use SAP MMC or SAPControl for starting or stopping a clustered SAP instance, the "SAP <SID> <No> Service" resource of the clustered instance must be online. Therefore, SAP recommends keeping the "SAP <SID> <No> Service" cluster resource always online, and using the SAP MMC or SAPControl to start or stop a clustered instance.
- You can also start SAPControl in the PowerShell.
- The SAP MMC is not available on the Server Core for Windows Server 2012 (R2) and higher.

Starting and Stopping the clustered (A)SCS and Database Instance

With certain HA administration tools, such as PowerShell (Windows Server 2012 (R2) and higher) or Failover Cluster Manager (Windows Server 2008 (R2)), you can only start or stop a clustered SAP instances, such as
the (A)SCS instance or the database instance. For all other non-clustered instances, such as dialog instances or the central instance, you must use the SAP MMC or SAPControl.

**Note**

You first have to start the (A)SCS instance and then the database instance, whereas you first have to stop the database instance and then the (A)SCS instance.

- **Using PowerShell** (Windows Server 2012 (R2) and higher)
  To start or stop the clustered (A)SCS instance or the database instance with PowerShell do the following:
  1. To start the clustered database instance, open PowerShell in elevated mode, and enter the following command:
     ```
     start-clusterresource <Database Resource>
     ```
  2. To start the clustered (A)SCS instance, open PowerShell in elevated mode, and enter the following command:
     ```
     start-clusterresource "SAP <SAPSID> <Instance_Number> Instance"
     ```
  3. To stop the clustered (A)SCS instance, open PowerShell in elevated mode, and enter the following command:
     ```
     stop-clusterresource "SAP <SAPSID> <Instance_Number> Instance"
     ```
  4. To stop the clustered database instance, open PowerShell in elevated mode, and enter the following command:
     ```
     stop-clusterresource <Database Resource>
     ```

- **Using Failover Cluster Manager** (Windows Server 2008 (R2))
  With the Failover Cluster Manager (Windows Server 2008 (R2)), you can only start or stop clustered instances such as the (A)SCS instance. To start the database instance, you use the Oracle Fail Safe Manager.
  For all other non-clustered instances, such as dialog instances or the central instance, you must use the SAP MMC or SAPControl.
  To start or stop the clustered (A)SCS instance with the Failover Cluster Manager do the following:
  2. To start the (A)SCS instance, select the relevant service and application SAP <SAPSID>.
    In the right-hand pane, under Other Resources, right-click the resource SAP <SAPSID> <Instance_Number> Instance, and choose Bring this resource online.
  3. To stop the (A)SCS instance, select the relevant service and application SAP <SAPSID>.
    In the right-hand pane, under Other Resources, right-click the resource SAP <SAPSID> <Instance_Number> Instance, and choose Take this resource offline.

- **Using the Oracle Fail Safe Manager**
  With the Oracle Fail Safe Manager, you can only start or stop the clustered database instance.
  To start or stop the clustered database instance with the Oracle Fail Safe Manager do the following:
  1. Start the Oracle Fail Safe Manager as follows:
     - Windows Server 2012 (R2) and higher:
       Press [Ctrl]+[ESC] and [Ctrl]+[TAB] to choose Oracle Fail Safe Manager.
     - Windows Server 2008 (R2) and Windows Server 2003:
       Choose Start ➤ Programs ➤ Oracle - <FailSafe_Home_Name> ➤ Oracle Fail Safe Manager ➤.
  2. To start the clustered database instance in the Oracle Fail Safe Manager, right-click the database <DBSID>.world in the Fail Safe group ORACLE<DBSID>, and choose Place online.
3. To stop the clustered database instance in the Oracle Fail Safe Manager, right-click the database 
<DBSID>.world in the Fail Safe group ORACLE<DBSID>, and choose Take offline.

Note

○ Before you stop the database instance, make sure that you have stopped the (A)SCS instance 
  with the Failover Cluster Manager (Windows Server 2008 (R2)), or Cluster Administrator 
  (Windows Server 2003)

○ If a dialog box appears, asking you how to take the database offline, choose Immediate.
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).

Open Source Software and Third Party Components

Please refer to https://scn.sap.com/docs/DOC-42044 for information respecting open source software components made available by SAP as part of SAP NetWeaver and any specific conditions that apply to your use of such open source software components. Please refer to https://scn.sap.com/docs/DOC-42045 for information relating to SAP’s use of third party software with or within SAP NetWeaver.